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Preface

This manual describes the SIMATIC 505 PROFIBUS-FMS Communications
Processor module for the Series 505 programmable logic controller system.
This manual also describes the COM5434 Configurator software package,
which you use to create configuration files for the FMS CP module.

The SIMATIC 505–CP5434–FMS Communications Processor module
(referred to throughout this manual as the FMS CP module) provides an
interface between the Series 505 family of programmable logic controllers
and Send-Receive products, S7 products, S5 products, and other Siemens
products (and third-party products), all of which can communicate over a
common hardware network.

The following topics are covered in this manual:

• PROFIBUS network features and physical characteristics

• FMS CP module features

• Hardware installation

• Cabling for a PROFIBUS network

• FMS CP module network communications overview

• Installation and configuration of the COM5434 Configurator software

• Communication examples

• Troubleshooting information

Additional manuals you may need to consult include the following:

• The system manual(s) for your controller(s)

• The SIMATIC 505 TISOFT2 Release 6.3 User Manual,
PPX:TS505–8101–7 or higher. This manual covers programming over
PROFIBUS-FMS networks.

• The SIMATIC 505 SoftShop for Windows Release 2.0 User Manual,
PPX:SS505–8101–3 or higher. This manual covers programming over
PROFIBUS-FMS networks.

• The SIMATIC S5 ET 200 Distributed I/O System Manual,
PPX:505–8206–x, describes the installation and use of the Siemens
family of PROFIBUS-DP compatible ET 200 I/O modules. This manual
includes a description of the COM PROFIBUS software.

About This Manual

Related Manuals
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The following conventions are used in this manual:

• “Click” means to place the mouse cursor on an object and quickly press
and release the mouse button. In most cases, only the left mouse button
is used.

• “Double-click” means to place the mouse cursor on an object and
quickly press and release the left mouse button twice.

Agency approvals for the SIMATIC 505 PROFIBUS-FMS Communications
Processor module are listed in Appendix C.

PROFIBUS user organizations exist in a number of countries to allow
PROFIBUS users to exchange information. The address of the organization
in the U.S.A. is as follows:

PROFIBUS Trade Organization
Michael Bryant
5010 East Shea Boulevard, Suite C-226
Scottsdale, AZ 85254
Telephone: (602) 483-2456
Fax: (602) 483-7202

For technical assistance, contact your Siemens Energy & Automation, Inc.,
distributor or sales office. If you need assistance in contacting your
distributor or sales office, call 800-964-4114 in the U.S.A.

For additional technical assistance, call the Siemens Technical Services
Group in Johnson City, Tennessee at 423-461-2522, or contact them by
e-mail at simatic.hotline@sea.siemens.com. For technical assistance
outside the United States, call 49-911-895-7000.

You can also find information about Siemens automation products at our
website at http://www.aut.sea.siemens.com.

Conventions

Agency Approvals

PROFIBUS User
Organization

Technical
Assistance
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1.1 The SIMATIC 505 PROFIBUS-FMS Communications Processor Module

The SIMATIC 505 PROFIBUS-FMS Communications Processor
module (PPX:505-CP5434-FMS) provides an interface for 505-to-505
communications, and between Series 505 programmable logic controllers
and Send-Receive products (such as S5), S7 products, and third-party and
other Siemens products, all of which can communicate over a common
hardware network.

The FMS CP module conforms to the PROFIBUS standard as described in
EN 50 170, Volume 2, PROFIBUS. PROFIBUS-Fieldbus Message
Specification (FMS) enables object-oriented data exchange between master
stations.

The FMS CP is a single-wide Series 505 module with the following features:

• Can be installed in a local or remote Series 505 base. (The remote base
installation currently can use only the 505 remote I/O channel.)

• Has two ports: an RS-485 PROFIBUS port and an RS-232 port.

• Conforms to PROFIBUS-FMS protocol.

• Operates on a PROFIBUS network (cabling medium).

• Is configured for the network using the included COM5434
Configurator software.

• In SoftShop or TISOFT, the FMS CP is logged in as a 4WX/4WY
Special Function (SF) module.

• The module firmware can be upgraded in the field using flash memory.

• Supports the following PROFIBUS cards for personal computers:

CP 5412 (A2) ISA card, (PC AT, short slot)
CP 5511 PCMCIA card (for notebook PCs)
CP 5611 PCI card 

The FMS CP module supports the following communication services:

• Fieldbus Message Specification (FMS); used for SIMATIC 505, S7, or
any third-party device that supports FMS protocol.

• Send-Receive Interface (data transmission on a Fieldbus Data Link
connection); used for devices such as SIMATIC S5 stations.

• Peerlink II (global broadcast); for 505-to-505 communications only.

• S7 Services (server only)

Features

Communication
Services Supported
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The SIMATIC 505 PROFIBUS-FMS Communications Processor module is
compatible with all SIMATIC 545, 555, 565, and 575 CPUs.

Any compatible programmable logic controllers or field devices equipped
with a PROFIBUS-FMS interface can participate on the network.

Figure 1-1 shows some examples of devices that can be used on your
network.

Repeater

SIMATIC S5

SIMATIC 575

Personal computer with
COM5434 Configurator
software and CP 5412,

CP 5511, or CP 5611 card

SIMATIC S7-300
R
B
C

SIMATIC 545
SIMATIC 555

SIMATIC 560/565

Third-Party
Station

Figure 1-1 Example of Devices on an FMS Network

Compatibility

System Layout
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1.2 Hardware Overview

As shown in Figure 1-2, the bezel of the FMS CP module has four status
LEDs, a recessed RUN/STOP switch, a recessed RESET button, an RS-232
port, and an RS-485 PROFIBUS-FMS port.

RUN

STOP

FAULT

RUN

STOP

RESET

RS232

505-CP5434
-FMS

MOD GOOD

PROFIBUS
FMS COMM

PROCESSOR

PROFIBUS
FMS

Figure 1-2 The 505-CP5434-FMS Module

The bezel has the following status LEDs:

• MOD GOOD

• RUN

• STOP

• FAULT

The functions of the LEDs are described in Section 2.6.

Bezel Features

Status LED
Indicators
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Below the LEDs is a recessed RUN/STOP toggle switch. The switch can be
moved from one position to another using a small tool, such as a
screwdriver. The switch is recessed to prevent accidental switching of the
module from one state to another.

The RESET button is recessed to prevent accidental reset of the module.
When the RESET button is pushed, the module resets as if power were
turned off and then turned on. Therefore, if the RUN/STOP switch is in the
RUN position and the module is functioning properly, the module begins to
transmit and receive communications after going through a normal
power-on start-up sequence.

! WARNING
The RESET button is for the unusual circumstance in which there is a module
function error that cannot be fixed with the COM5434 Configurator software.
When the RESET button is pushed, the module enters the state of global reset,
which is the same as a power-up. The hardware is reset, all communication is
terminated on all ports, and the LEDs turn off.

Because all communication that is controlled by the module is terminated,
essential messages to other nodes that control I/O functions can be disrupted.
Disrupting communication during plant operation could result in damage to
equipment and/or injury or death to personnel.

To avoid possible damage to equipment and/or injury or death to personnel, do
not reset the module without first understanding all possible results based on
the setup of your network.

The RS-232 port is a 9-pin male D-shell connector. You can set the RS-232
port to 9600 baud, 19200 baud, or 38400 baud using a jumper on the board.
The baud rate of the port must be set before the FMS CP module is installed
in the base. See Section 2.2 for instructions on how to set the baud rate of
the port.

The RS-485 PROFIBUS-FMS port is a 9-pin female D-shell connector. You
set the baud rate for the PROFIBUS port during network configuration
using the COM5434 Configurator, as decribed in Section 5.4.

RUN/STOP Switch

RESET Button

RS-232 Port

PROFIBUS-FMS Port
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1.3 Network Overview

The Process Field Bus (PROFIBUS) standard (EN 50 170, Volume 2,
PROFIBUS) defines the physical and logical parameters of a bit-serial bus
network. PROFIBUS offers an interface for high-speed communications
with field devices, as well as exchange of complex data between master
stations. One objective of the standard is to create an open system that
enables networking of programmable logic controllers and field devices from
different vendors. This allows you to include in your system any device from
another vendor as long as the device conforms to the standard.

While PROFIBUS includes FMS and DP protocols, there is a universal set
of standard physical parameters for PROFIBUS networks, as listed in
Table 1-1.

Table 1-1 PROFIBUS Physical Parameters

Features Parameters

Access mode Token passing with underlying master/slave

Transmission rate 9.6 Kbaud to 12 Mbaud

Transmission medium
Electrical network: shielded two-wire cable

Optical network: fiber-optic cable (glass or plastic)

Maximum number of devices
per segment 32 (including repeater)

Maximum number of station
addresses per network 126 (not including repeaters)

Maximum cable length per
network

10 km for copper cable; more for fiber-optic cable
(see Siemens SIMATIC NET Industrial
Communications Networks, Catalog IK 10).

Topology Electrical network: line, tree
Optical network: ring, line, star

Protocols PROFIBUS-FMS
PROFIBUS-DP

Data size that can be
transmitted in one message 1 to 244 bytes

The PROFIBUS
Standard
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The Open Systems Interconnection (OSI) 7 Layer Model defines levels of
communication from the physical layer to the logical layer. While the model
gives functions to the protocols, it does not define the protocols themselves.
PROFIBUS-FMS uses layer 1, layer 2, and layer 7. The OSI 7 Layer Model
is shown in Figure 1-3.

7b

7a

6

5

4

3

2

1

FMS (Fieldbus Message Specification)

LLI (Lower Layer Interface)

Empty

FDL (Fieldbus Data Link)

RS-485

Application layer

Presentation layer

Session layer

Transport layer

Network layer

Data link layer

Physical layer

The Layers PROFIBUS-FMS

Figure 1-3 The OSI 7 Layer Model

Devices on a PROFIBUS network are defined as either masters or slaves.
Masters are able to issue network commands without remote request when
they have the right to access the network. This right is based on the token,
which is discussed below. Slaves are devices on the network that do not
receive the token, and therefore have no right to issue network commands.
Slaves may only acknowledge received messages, or transmit messages in
response to a master’s request.

OSI 7 Layer Model

Masters and Slaves
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Network Overview (continued)

PROFIBUS allows for multiple masters on a single network, where each
master can control the transmission of commands by holding a token. The
token is a special telegram that transfers the right of transmission from one
master to another. It is circulated among all active masters on a network in
a token ring.

When a network is powered up, each master enters a listening mode, checks
network traffic and builds a list of active stations on the network. This
establishes the token ring for the network. When the first master (lowest
station number) finishes its listening mode, it passes itself the token, and
gains control of the network. Possession of the token indicates the ability to
initiate data transfer. Before each subsequent token pass, the master
performs a gap update, polling a single sequential station address to see if
another master is waiting to enter the network.

When a second master enters the network, the first master passes it the
token, thereby passing control of the network. In this way, control of the
network and therefore the ability to issue network commands rotates from
master to master.

Figure 1-4 shows an example of token passing among masters on a
PROFIBUS network.

�
��	 ��	�

Master
Master

Master

1
2

3

45

6

Stations 4, 5, and 6 are not part of the token ring
and cannot initiate jobs on the network.

���

��

Slave

Slave Slave

Figure 1-4 Token Passing on a PROFIBUS Network

Token Passing on a
PROFIBUS Network
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Communication on the PROFIBUS network can be described from both the
physical and the logical point of view.

The physical view, as shown in Figure 1-5, describes a number of stations
connected to a central bus line. This view emphasizes the actual physical
layout of the network cables and devices that enable the stations to
communicate with each other.

Figure 1-5 Simplified Physical View of a Network

The logical view describes how communication on a PROFIBUS network
takes place through logical connections between station pairs. A logical
connection relationship consists of four parts:

Local station address
Remote station address
Local LSAP (Link Service Access Point)
Remote LSAP

For each station in the connection, the local values must be equal to the
remote values of the other station, as shown in Figure 1-6. On any station, a
local LSAP can be used for only one connection (except for FMS slaves).

Station  5

Local Address = 5

Remote Address = 4

Local LSAP = 8

Remote LSAP = 7

Station 4

Local Address = 4

Remote Address = 5

Local LSAP = 7

Remote LSAP = 8

Figure 1-6 Example Connection between Stations

Network
Communication
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Network Overview (continued)

Figure 1-7 shows how three stations on a network are configured to
communicate. The arrows represent logical connections between the
stations on the network. 

505-CP5434 FMS CP
Address 4

Connection 1 Remote Addr = 5
LSAPs Local = 7, Remote = 8

Connection 2 Remote Addr = 5
LSAPs Local = 9, Remote = 9

Connection 3 Remote Addr = 6
LSAPs Local = 10, Remote = 10

S7 CP443-5
Address 5

Connection 1 Remote Addr = 4
LSAPs Local = 9, Remote = 9

Connection 2 Remote Addr = 4
LSAPs Local = 8, Remote = 7

Connection 3 Remote Addr = 6
LSAPs Local = 11, Remote = 12

S5 CP5431
Address 6

Connection 2 Remote Addr = 5
LSAPs Local = 12, Remote = 11

Connection 1 Remote Addr = 4
LSAPs Local = 10, Remote = 10

Example of logical connection relationships
between SIMATIC 505, S7, and S5 stations

Figure 1-7 Logical View of a Network
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2.1 Overview of Installation

Follow the flow of tasks shown in Figure 2-1 when installing the FMS CP
module.

Turn off power to the base.

Cable your programming device to the FMS CP module using the RS-232 port.

 Power up the base. Check the status of the LEDs.

 Check the baud rate setting of the jumper on header E1.

Cable the FMS CP module to the PROFIBUS network using the
PROFIBUS-FMS port.

Configure the I/O address of the FMS CP module using TISOFT
or SoftShop software.

Insert the FMS CP module into any available I/O slot in the base.

Figure 2-1 Installation Flowchart

The following sections describe these installation tasks in detail. After these
tasks are completed, you are ready to install the COM5434 Configurator
software, as described in Section 5.1.

Flow of Tasks



 
Installing the Module 2-3SIMATIC 505 PROFIBUS-FMS CP User Manual

! CAUTION
Electronic equipment is sensitive to, and can be damaged by, electrostatic
discharge.

Ensure that personnel follow the precautions described below to avoid
damaging the FMS CP module by electrostatic discharge.

Integrated circuits are susceptible to damage by the discharge of static
electricity. Take the following precautions to avoid damaging the FMS CP
module by electrostatic discharge while handling:

• Transport the FMS CP module in an anti-static container, such as the
anti-static bag in which the module was originally shipped.

• Ensure that personnel make contact with a static-dissipative pad
and/or wear a grounded wrist strap when handling the module.

If the FMS CP module and/or the configurator software diskettes are visibly
damaged (bent or broken), contact your vendor for replacement.

Handling the
Module

Visual Inspection
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2.2 Setting the Baud Rate for the RS-232 Port

A header labeled E1 is located on the module, as shown in Figure 2-2. The
header determines the baud rate for the RS-232 port, and the jumper must
be set before the module is installed in the base.

Bezel

19,200
38,400

E
1 )–

)–
Jumper set on header E1 pins
at 38,400 baud.

Figure 2-2 Location of Header E1

The RS-232 port can be set at 9600 baud (no jumper), 19,200 baud, or
38,400 baud (as shown in Figure 2-2). The default setting of Header E1, as
shipped, is 38,400 baud. To set the RS-232 port at 9600 baud, the jumper
must not connect two header pins. However, in order not to lose the jumper,
the jumper should be stored on the module by hanging it on one pin only (as
shown in Figure 2-3).

Bezel

Jumper shown unplugged from E1
header pins. For convenient storage,
position the jumper on one E1 pin only.

19,200
38,400

E
1 )–

)–

Figure 2-3 Jumper Storage at 9600 Baud

Header E2 is shipped without a jumper, and is for factory use only. Do not
alter the state of Header E2 unless instructed to do so by a Siemens
Technical Support technician.

Setting the Jumper
on Header E1

Header E2
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2.3 Inserting the FMS CP Module

! WARNING
Electrical  shock hazard is possible if you do not turn off all power to the base
before attempting to insert the module.

Failure to turn off power to the base could result in death or serious injury to
personnel, and/or damage to equipment.

Ensure that power is off in the base before attempting to insert the module.

The FMS CP module is a single-wide module. You can insert it into any I/O
slot in a Series 505 I/O base. Follow these steps to install the module:

1. Turn off all power to the base and the modules.

2. Hold the top and bottom of the bezel and slide the module into the slot,
pushing it all the way into the base. You will feel a slight increase in
resistance as the module connects with the back-plane connector.

3. Use a flat-head screwdriver to tighten the screws at the top and bottom
of the bezel, as shown in Figure 2-4. Note the minimum torque required
in order for the bezel screws to provide electromagnetic shielding.

Minimum torque: 2.6 in-lb (0.3 N-m)

Maximum torque: 5.2 in-lb (0.6 N-m)

Backplane connectors

 

Figure 2-4 Inserting the Module into the Base

Inserting the
FMS CP Module
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2.4 Connecting a Programming Device to the FMS CP Module

The RS-232 port is the interface between your programming device, such as
a personal computer (PC), and the FMS CP module. Using your PC and the
RS-232 port, you can configure the module.

To connect your PC to the FMS CP module, use a standard 9-pin RS-232
cable that conforms to the pinouts shown in Figure 2-5. A standard 505
programming cable that conforms to the serial cable requirements and
pinouts is available through Siemens; specify PPX:2601094–8001.

NOTE:  You can also use the RS-232 port on the FMS CP module to configure
the programmable logic controller through the backplane using applications
such as TISOFT. This feature is particularly useful if access to the RS-232
port on the CPU is limited.

2
3
1
6
4
5
7
8

3
2

6

4
1

5
7
8

Shield

Computer  side Module side

Transmit data
Receive data

Signal ground

Transmit data
Receive data

Signal ground

D-shell

Figure 2-5 RS-232 Port Cable Pinouts

Connect one end of the RS-232 cable to the appropriate 9-pin RS-232/423
serial port on your PC and the other end to the 9-pin RS-232 port on the
FMS CP module, as shown in Figure 2-6. If your computer does not have a
9-pin port, use a 25-to-9-pin converter.

RS232

Personal
computer

with
COM5434

Configurator
software

FMS CP Module
RS-232 Port

Programming Cable
(PPX:2601094–8001)

9-pin
Female

Connector

Figure 2-6 Connecting Your Computer to the FMS CP Module

Connecting to the
RS-232 Port

Connecting the
Serial Cable
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2.5 Connecting the FMS CP Module to the Network

The PROFIBUS-FMS port is the interface between the FMS CP module and
the PROFIBUS network. To connect the FMS CP module to the network,
use a standard 9-pin RS-485 cable that conforms to the pinouts shown in
Figure 2-7.

Figure 2-7 shows the pinouts for the PROFIBUS-FMS port on the FMS CP.

NOTE:  Pins 2 and 7 are “No Connect.” For some PROFIBUS products, these
pins are used to provide 24 VDC for powering a programming or
configuration tool. Such tools are not powered by the FMS CP module. It is
acceptable for an externally-powered PROFIBUS programming or
configuration tool to drive pins 2 and 7 to 24 VDC.

*For Pin 3: Terminal B on Siemens connector.
*For Pin 8: Terminal A on Siemens connector.

BIAS SUPPLY GND (5)

TX/RX+ (3)TX/RX– (8)

6 1

9
5

Pin Signal

1 CHASSIS GND or NC
2 No Connect
3* TX/RX+
4 RTS
5 BIAS SUPPLY GND
6 BIAS SUPPLY +5V
7 No Connect
8* TX/RX–
9 BIAS SUPPLY GND

(D-shell) 
CHASSIS GND

Female 9-pin D-shell connector

Figure 2-7 PROFIBUS-FMS Port Pinouts

! CAUTION
Pin 5 (BIAS SUPPLY +5V) and Pin 6 (BIAS SUPPLY GND) on the PROFIBUS-FMS
connector are designed to support the PROFIBUS-FMS network only . These
pins have a limited output power capability of approximately 0.45 W , which
greatly exceeds the typical PROFIBUS-FMS load; nonetheless, it is possible to
overload these pins, causing internal component damage.

If the pins are overloaded, the PROFIBUS-FMS port can be rendered
non-functional, requiring the unit to be returned to the factory for repair .

Do not overload the pins on the PROFIBUS-FMS connector.

Connect the PROFIBUS cable connector to the PROFIBUS port on the
FMS CP module. See Section 3.3 for information on connecting PROFIBUS
cables and connectors. Standard cable connectors are available from
Siemens. See Section 3.1 for ordering information of PROFIBUS connectors.

PROFIBUS-FMS Port
Pinout

Connecting to the
Network
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2.6 Powering Up the Base

Refer to the system manual for your programmable logic controller for
information on installing and wiring the power supply in the base. Follow
all installation guidelines and safety precautions described in your system
manual before powering up the system.

! WARNING
Electrical  shock hazard is possible if you are not  fully informed about safety
precautions before you wire and/or power up the base.

Failure to follow safety guidelines could result in death or serious injury to
personnel, and/or damage to equipment.

Review and comply with all warnings and proceedures in the system manual for
your base before powering up.

When you power up the base, the FMS CP module executes a diagnostic
check. The diagnostic check takes a maximum of 30 seconds.

After powering up the base, observe the status of the LEDs on the bezel of
the FMS CP module. The status of the LEDs is shown in Table 2-1.

NOTE:  When you power up the module for the first time, the LEDs display
as Stop With Fault.  This is normal because you have not yet configured the
module’s flash memory.

Table 2-1 LED Status Diagnostic Chart

Mode of
Module

LED IndicatorMode of
Module MOD GOOD RUN STOP FAULT

Startup on flashing on off

Run on on off off

Stopping on on flashing off

Stop on off on off

Stop with Fault on off on on

Firmware Fault on off off on

Firmware Load on on on flashing

Fatal Error flashing flashing flashing flashing

Supplying Power to
the Base

LED Status after
Power-up
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The operating modes of the FMS CP module, which are indicated by the
LED status, are defined below:

• Startup: Power-up initialization is in progress.

• Run: Normal operation.

• Stopping: Stopping is a transition state and takes a few seconds. This
mode is selected by means of either the RUN/STOP switch or the
COM5434 Configurator. Communications are interrupted, and all
communication jobs and client/server functions are being terminated.
The module cannot be configured at this point.

• Stop: This mode is selected by means of either the RUN/STOP switch or
the COM5434 Configurator. Communications have been interrupted,
and all communication jobs and client/server functions have been
terminated. The module can be configured at this point.

• Stop with Fault: In this mode, the Run mode is not possible because of
incorrect configuration data. This may be due to conflicting parameters
or duplicate station addresses. Disconnect the cable while reconfiguring
the module to clear the fault condition.

• Firmware Fault: Firmware validation has failed, and a firmware
download to the module is required.

• Firmware Load: A firmware download to the module is in progress.

• Fatal Error: The module failed due to defective hardware or firmware,
and may need to be replaced. First try a Reset. If pressing the Reset
button does not restore normal operation, contact your distributor.

LED Status in
Operating Modes
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2.7 Configuring the I/O Address in the Programmable Logic Controller

After installing the FMS CP module in the base, you need to register the I/O
starting address of the FMS CP module in your programmable logic
controller memory. The module does not automatically register its I/O
address in the programmable logic controller.

NOTE:  Even though the module may appear to be operating correctly, if it is
not configured in the I/O map, it cannot support communication jobs or
Peerlink transfers, and server function requests run slowly.

To configure the I/O map and verify controller-to-module communications,
connect a programming device with base configuration software (for
example, TISOFT) to the programmable logic controller, and follow the steps
below. For detailed instructions about using TISOFT to configure the I/O
slot in the base, see the SIMATIC 505 TISOFT2 Release 6.0 User Manual,
PPX:TS505–8101–6 or higher.

NOTE:  Ensure that the FMS CP module successfully completes power-up
initialization before you attempt to configure the I/O slot in the base.

1. In TISOFT, access the Configure I/O function menu.

2. Select the appropriate channel and base number.

3. Execute the Read Base function.

The module appears as a 4 WX 4 WY Special Function module, as
shown in Figure 2-8. It uses 8 I/O address locations.

4. Assign the starting I/O address and write the completed I/O
configuration to the programmable logic controller memory, using the
Write PLC function.
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NOTE:  Because discretes and words do not share the same image register
addresses, the slot 02 entry in Figure 2-8 could be address 0001.

I/O MODULE DEFINITION FOR CHANNEL . . . 1 BASE . . . 00

SLOT ADDRESS X Y WX WY FUNCTION
I/O NUMBER OF BIT AND WORD I/O SPECIAL

01

02

03

04

. . . . 0001

0017

0000

0025

16

00

00

00

00

00

00

08

04

00

00

04

00

00

No

Yes

No

No

00 00

. . . . 

. . . . 

. . . . 

. . . . . . . . . . . . 

. . . . . . . . . . . . 

. . . . . . . . . . . . 

. . . . . . . . . . . . 

. . . 

. . . 

. . . 

. . . 

. . . 

. . . 

. . . 

. . . 

. . . 

. . . 

. . . 

. . . 

. . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . 

Base Number:
Displays number 
of the current base.

SF Module:
The FMS CP module
is a Special Function
module.

Slot Number:
Install the module into
any slot in the I/O base.

I/O Address:
Assign a starting I/O address

The FMS CP module logs
in as 4 WXs and 4 WYs.

Figure 2-8 Sample I/O Module Definition Chart in TISOFT
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2.8 PROFIBUS Network Card and Software Packages

You must install one of the PROFIBUS card/software packages listed in
Table 2-2 on your PC in order to allow it to communicate with the FMS CP
module on a PROFIBUS network. Consult the documentation provided with
each package for information on installing the hardware and software.

Table 2-2 PROFIBUS Network Card/Software Packages

PROFIBUS Card Software Package

CP 5412 (A2) 6GK1 541-2BA00
(PC-AT card)

S7-5412/Windows 95 6GK1 702-5CH00-3AA0

S7-5412/Windows NT 6GK1 702-5CB00-3AA0

CP 5511 6GK1 551-1AA00
(PCMCIA card) SOFTNET S7/Windows 95/NT for PROFIBUS
CP 5611 6GK1 561-1AA00
(PCI card)

SOFTNET S7/Windows 95/NT for PROFIBUS
6GK1 704-5CW00-3AA0

NOTE:  When editing the S7 configuration on your PC, specify 01 00 for the
remote TSAP of the CP 5434 FMS module.
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3.1 Cables and Connectors

This section describes products available from Siemens that are used to set
up a PROFIBUS-FMS network.

NOTE:  Product availability is subject to change. To ensure that the cables,
connectors, and repeaters you choose are physically compatible with the
other components you select, consult the newest edition of Siemens’
SIMATIC NET Industrial Communications Networks, Catalog IK 10.

If you use PROFIBUS LAN products produced by vendors other than
Siemens, be sure to check that all the products you select are compatible.

As shown in Figure 3-1, PROFIBUS cable is shielded, twisted-pair with
circular cross-section. Due to double-shielding, PROFIBUS cable is
particularly suited for industrial environments. Grounding continuity is
implemented through the outer shield of the cable.  A standard cable that
conforms to the PROFIBUS cable requirements is available through
Siemens; specify 6XV1 830-0AH10.

Figure 3-1 PROFIBUS Twisted-Pair Cable

PROFIBUS Cable
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Standard cable connectors that conform to the PROFIBUS requirements are
shown in Figure 3-2. The following standard cable connectors are available
from Siemens:

• 6ES7 972-0BA10-0XA0 (for vertical connector without PG connector,
9.6 Kbits to 12 Mbits)

• 6ES7 972-0BB10-0XA0 (for vertical connector with PG connector,
9.6 Kbits to 12 Mbits)

Figure 3-2 PROFIBUS Bus Connectors

PROFIBUS Bus
Connectors
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Cables and Connectors (continued)

A PROFIBUS repeater available from Siemens is shown in Figure 3-3. The
repeater connects two RS-485 segments, enabling expanded physical
networking. Nine repeaters may be used in a series. A standard PROFIBUS
repeater is available from Siemens; specify 6ES7 972-0AA00-0XA0
(9.6 Kbits to 12 Mbits).

DC
24V

L1 M PE M5

A2 B2 A2 B2

RS 485–REPEATER

A1 B1 A1 B1

Figure 3-3 PROFIBUS Repeater

PROFIBUS Repeater
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3.2 Cable Routing

Follow these suggestions when planning your cable routing.

• Allow for system growth. Provide for attachment of future bases by
routing cable through all possible areas of plant expansion.

• Take steps to bypass or eliminate noise sources in order to reduce
system data error rates. The following are common sources of electrical
noise:

� Power distribution mains

� Arcing motors and motor starters

� Fluorescent lighting

� Undesired signal transfer between adjacent circuits

� Poor terminations of cable connector

• Do not allow cable to come into contact with any other electrical
conductor.

• If cabling is installed inside a conduit, the conduit should be grounded
according to applicable electrical codes.

The type of routing is usually determined by the type of building in which
the cables are being installed. Any combination of the following may be used
to route the cables: under-floor, in-ceiling, or surface duct.

! WARNING
Electrical  and fire safety must be considered in planning the installation.

Safety codes exist to limit the danger of fire and smoke hazards caused by
cable installations.

To ensure safety compliance, observe local installation code guidelines.

In under-floor routing, the cable can be enclosed in ducts or, with raised
flooring, in the open air.

• Duct systems are better protected against unauthorized taps or
terminal blocks, but expansion is more difficult and expensive than
with open air systems.

• Open air systems provide more freedom of access, and allow maximum
system expansion flexibility.

Guidelines

Cable Routing
Methods

Under-Floor
Routing
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Cable Routing (continued)

For in-ceiling routing, cables are usually supported in troughs or with hooks
and clamps every 10 to 15 feet (3 to 4.5 m).

Some advantages of in-ceiling routing are listed below.

• Flexibility

• Low-cost installation

• Accessibility of cabling

Some disadvantages of in-ceiling routing are listed below.

• Collection of dust and other debris in ceilings

• Hazardous working conditions in ceilings

• Impracticality for buildings without drop ceilings

Surface duct routing is usually installed along baseboards or attached to
walls at desktop height. While surface duct routing protects cables from
both physical and electro-magnetic effects, it usually requires I/O bases to
be positioned near a wall.

NOTE:  Consult your cable vendor for proper cable-pulling techniques so that
no kinks occur in the cable during installation.

In-Ceiling Routing

Surface Duct
Routing
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3.3 Installing PROFIBUS Cables

The PROFIBUS-FMS port provides communication over shielded twisted
pair (RS-485) cable media.

Figure 3-4 shows a sample system layout for the PROFIBUS network.

Repeater

SIMATIC S5

SIMATIC 575

SIMATIC S7-300

R
B
C

Personal computer with
COM5434 Configurator
software and CP 5412,

CP 5511, or CP 5611 card.
SIMATIC 545
SIMATIC 555

SIMATIC 560/565

Figure 3-4 Sample System Layout for PROFIBUS-FMS

Media Options

System Layout
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Installing PROFIBUS Cables (continued)

Table 3-1 lists the PROFIBUS EN 50 170 cable line specifications.

Table 3-1 PROFIBUS Cable Specifications

Feature Specification

Impedance 135 Ohm to 165 Ohm (3 MHz to 20 MHz)

Capacitance 9.1 pF/ft. (<30 nF/km)

Resistance 33.5 �/1000 ft. (<110 Ohm/km)

Attenuation 0.27 dB/100 ft.
(0.9 dB/100 m (f=200kHz))

Conductor Area 20 AWG to 22 AWG (0.3 mm2 to 0.5 mm2)

Cable Diameter 0.315 in. � 0.02 in. (8 mm � 0.5 mm)

Up to 10 bus segments can be connected in series. Line length limits are
determined by baud rate. The distance between the two most widely
separated stations must not exceed the values shown in Table 3-2. Use
repeaters between each cable segment. (For fiber-optic cable line length
limits, consult the newest edition of Siemens’ SIMATIC NET Industrial
Communications Networks, Catalog IK 10.)

Table 3-2 PROFIBUS Line Length Limits

Baud Rate Maximum Segment
Length

Maximum Installation
Length

9.6 to 93.75 KBaud 3,930 ft. (1,200 m) 39,300 ft. (12,000 m)

187.5 KBaud 3,280 ft. (1,000 m) 32,800 ft. (10,000 m)

500 KBaud 1,310 ft. (400 m) 13,100 ft. (4,000 m)

1.5 MBaud 660 ft. (200 m) 6,600 ft. (2,000 m)

3 Mbaud to 12 MBaud 330 ft. (100 m) 3,300 ft. (1,000 m)

PROFIBUS Cable
Specifications

PROFIBUS Line
Length Limits
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The rules for proper PROFIBUS installation follow:

• Create a daisy-chain arrangement, not a star arrangement.

• You can connect up to 32 devices on one cable segment. Each repeater
counts as a device.

• Do not run the cables near power wires.

• The communication cable consists of two color-coded insulated wires
that are twisted together and surrounded by a shield. The cable is
encased in an insulating jacket. When wiring the system, the same
color of wire must be connected to the TX/RX+ pin throughout the
system.

• Do not cross the TX/RX+ signals and the TX/RX– signals. Wire all of
the TX/RX+ pins (terminal B on the Siemens connectors) together. Wire
all of the TX/RX– pins (terminal A on the Siemens connectors) together.
Crossing the wires at any point in the system causes communication
problems.

• Proper termination and bias of PROFIBUS cable is important for
reliable communication. The device at each end of a PROFIBUS cable
segment must be terminated and biased; any devices connected
between the end nodes of a segment must not be terminated or biased.
See the following pages for more information about termination and
bias.

• All PROFIBUS cable connectors must be properly grounded. With a
Siemens PROFIBUS connector, proper grounding is accomplished when
the bare cable shield contacts the metal connector ground.

• Tighten screws on all PROFIBUS connectors throughout your system
to a maximum torque of 8 in-lb (0.9 N-m) in order to ensure a good
ground connection.

Installing
PROFIBUS Cable
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Installing PROFIBUS Cables (continued)

The device at each extreme end of a PROFIBUS cable must be terminated
and biased; any connections made between segment ends must not be
terminated or biased. See Figure 3-5.

N = PROFIBUS-FMS station

Termination and bias required.
Segment end must be
terminated and biased.

N N N N

Controller with
PROFIBUS-FMS
CP module

Figure 3-5 Terminate the Network at the Endpoints

Siemens PROFIBUS connectors have selectable termination and bias built
in. The connectors are designed to handle baud rates from 9600 baud to
12 Mbaud and have an external switch (see Figure 3-6). You set the
selection switch to the On position to enable termination and bias, or Off to
disable termination and bias.

9-pin
D-shell connector

External
termination
switch

ON

OFF

Figure 3-6 Siemens Connector, External Termination Switch

Termination and
Bias

Using a Termination
Selection Switch
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Figure 3-7 shows the schematic for PROFIBUS connectors designed to
handle all baud rates, from 9600 baud to 12 Mbaud.

  Pin 6
(BIAS SUPPLY +5V)

  Pin 5
(BIAS SUPPLY GND)

  Pin 3
(TX/RX+)

  Pin 8
(TX/RX–)

Termination Resistor, 220 ohm, 1/8 W, 5%

Pins 1, 2, 4, 7, and 9 are not connected.

Bias Resistor, 390 ohm, 1/8 W, 5%

Bias Resistor, 390 ohm, 1/8 W, 5%

110 nH

110 nH

110 nH

110 nH

Internal Connection B

Internal Connection B

Internal Connection A

Internal Connection A

Figure 3-7 9600 baud to 12 Mbaud Connector Schematic

NOTE:  Connector schematics and mechanical features are subject to change
without notice. Check with your local Siemens distributor for the latest
version.

PROFIBUS Connector
Schematics
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Installing PROFIBUS Cables (continued)

The following procedure describes how to attach a Siemens PROFIBUS
connector to your cable. Also consult the instructions that come with your
specific Siemens connector.

1. Open the connector housing by loosening both housing screws
(see Figure 3-8).

9-pin
D-shell connector

Housing screws
Cable guide

External
termination
switch

Figure 3-8 Typical PROFIBUS Connector

2. Remove the cover of the housing.

3. Remove 1.25 inches (30 mm) of the cable sheath to expose the shielding
below. See Figure 3-9.

Approx. 1/4 in. (6 mm)
Approx. 1/2 in. (12 mm)

Cable shielding
Approx. 1/2 in. (12 mm)

Approx. 3/4 in. (19 mm)

Cable sheath

Figure 3-9 Stripping the Wires

4. Remove a 0.75-inch (19 mm) portion of the cable shielding to expose the
two signal wires.

To ensure that the connection is properly grounded, you must leave
enough exposed cable shielding (0.5 inches, 12 mm) to make a proper
contact with the metal cable guide on the connector. See Figure 3-9.

Installing a
PROFIBUS
Connector
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5. Remove 0.25 inches (6 mm) of insulation at the wire ends.

6. Insert the signal wires into the cable terminals.

Be sure to connect the same wire color to the TX/RX+ pin for every
device throughout your system. Crossing the wires at any point creates
communications problems.

7. Set the termination switch to the correct position. See Figure 3-10.

Switch position ON
(termination and
bias enabled).

É

É

A B A B

ON

OFF

Switch position OFF
(termination and
bias disabled).

É

É

A B A B

ON

OFF

A. Attaching connector at segment end

B. Attaching connector to midpoint of segment

Figure 3-10 Attaching Connector and Selecting Termination

8. Put the cover back on the connector housing.

Be sure that the bare cable shielding makes contact with the metal
cable guide on the connector, to ensure proper grounding for the
connection.

9. Tighten the connector housing screws to a maximum torque of 8 in-lb
(0.9 N-m) in order to ensure a good connection.
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Chapter 4
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4.1 Overview

The FMS CP module supports the following types of communication
services:

• Fieldbus Message Specification (FMS) services are based on layer 7, the
application layer of the OSI 7 Layer model. FMS services use an
industry-standard, open protocol, which allows for communication
between SIMATIC and third-party FMS devices.

• Send-Receive services are based on layer 2, the data link layer of the
OSI 7 Layer model, a flexible, lower-level protocol (using bytes as
opposed to named variables). Because Send-Receive services use layer
2, transmission is limited to a single network segment. Send-Receive
services are supported by the module to allow for communication
between the FMS CP module and Send-Receive devices, such as S5.

• S7 services are based on layer 7, the application layer of the
OSI 7 Layer model. S7 services use a proprietary protocol for
communication between SIMATIC S7 devices.

• Peerlink II services are based on layer 2, the data link layer of the
OSI 7 Layer model. Because Peerlink II services use layer 2,
transmission is limited to a single network segment. Peerlink II
services are supported by SIMATIC 505 only. Peerlink II offers more
flexibility with greater data handling ability than Peerlink.

These services can all be used concurrently up to the network capacity.

The FMS CP module can act as a client or as a server when you configure
FMS and Send-Receive services; it can initiate, or respond to, requests for
data.  The FMS CP module acts only as a server for S7 services, responding
to remote requests from S7 devices on the network (see Table 4-1).

Table 4-1 Service Modes of the FMS CP Module

Service Client Server

FMS Services YES YES

Send-Receive Services YES YES

S7 Services NO YES

Communication
Services

Functional Modes
of Communication
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Connections are the logical links between stations on the network. You
define connections for the FMS CP module using the COM5434
Configurator. The FMS CP module supports the following connection types:

• FMS connections

• FDL connections

• S7 connections (as server only; connections are not configured in the
FMS CP module, and have no associated jobs)

You must define connections before you can define communication jobs.

A communication job is a pre-defined collection of variables that can be
triggered within the user program to read from or write to another network
station. Communication jobs allow you to use the FMS CP module as a
client to transfer complex data over logical links on the network. You
configure communication jobs using the COM5434 Configurator. The
FMS CP module supports the following job types:

• FMS jobs

• Send-Receive jobs

Peerlink II services allow the global broadcast of data (up to 234 bytes) on
your network to other SIMATIC 505 FMS CP modules. You configure
Peerlink II services using the COM5434 Configurator. The FMS CP
supports the following Peerlink II services:

• Transmission of 1 peer block

• Reception of up to 31 peer blocks

Server functions allow the FMS CP module to respond to requests received
from clients on the network. The FMS CP module supports the following
functions:

• FMS server functions — require you to configure FMS variables using
the COM5434 Configurator.

• S7 server functions — require no job or variable configurations.

Connections

Communication
Jobs

Peerlink II Services

Server Functions
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Overview (continued)

The FMS CP module is registered in the I/O memory map of its controller as
a 4 word input (WX) and 4 word output (WY) Special Function (SF) module.
You must assign the starting I/O address, as described in Section 2.7, in
order for the programmable logic controller to be able to communicate with
the FMS CP module.

NOTE:  The designations WX1, 2, 3, 4 and WY5, 6, 7, 8, shown in the
COM5434 Configurator, are relative to the actual starting address that you
assign in TISOFT or SoftShop for the slot where the FMS CP module is
installed. (See Section 2.7.) For example, if you assign 9 as the starting
address, then the programmable logic controller reads WX1, 2, 3, 4, and
WY5, 6, 7, 8 as WX9, 10, 11, 12 and WY13, 14, 15, 16. Of course, if you
configure the starting address as 1, the actual addresses match the relative
addresses shown in the COM5434 Configurator.

Each bit in the first three words corresponds to a job. For example, if WX1 is
configured as the first word input and WY5 is configured as the first word
output for the module, then bit 1 in WY5 is the Job Start Bit for Job1, while
bit 1 in WX1 is the Job Active Bit for that same Job1 (see Figure 4-1).

WX1
WX2
WX3
WX4

WY5
WY6
WY7
WY8

Each bit in word inputs 1 to 3 and word outputs 5 to 7 is associated with a job.

16-bit words

CP → PLC

PLC → CP
Job Start
(WY5, bit 1)

Job Active
(WX1, bit 1)

1

0

1

0

Start Reset

Job completeAcknowledge

1 2 3 4 5 . . . 16
MSB LSB

1 16

Figure 4-1 Communication between the PLC and the FMS CP Module

Communication
between the PLC
and the FMS CP
Module
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These bits are used to synchronize (handshake) communication between the
user program and the FMS CP module during communication jobs.

• The Job Start Bit is a user-selected bit in one of the available output
words (WY) assigned to the FMS CP module. The Job Start bit is used
in the user program to trigger a data transfer job. The FMS CP module
must see a 0 to 1 transition on the Job Start Bit to begin a data
transfer job.

• The Job Active Bit is a corresponding bit in the input word (WX) set by
the FMS CP module. The Job Active bit signals that a requested data
transfer job is in progress. When this bit goes back to 0, the controller
knows that the job has been completed and can then initiate another
job by setting the corresponding WY bit to 1.

• The bits in the first three output words assigned to the FMS CP module
are available as the Job Start Bits. In this example, any of the 48 bits
in WY5, WY6, and WY7 can be used as the Job Start Bit for a job as
needed. The corresponding bit in WX1, WX2, or WX3 (the Job Active
Bit) signals a job in progress.

The handshaking, or synchronizing, of a job such as the one shown in
Figure 4-1 can be summarized as follows:

1. With the WY bit set to 0, the programmable logic controller must wait
for the corresponding WX bit to become 0 before a job can be initiated.

2. The controller sets the WY bit from 0 to 1 to trigger the job.

3. The FMS CP module registers the rising edge on the WY bit, sets the
corresponding WX bit to 1, and starts the job.

NOTE:  For a job to execute, the FMS CP module must see the transition of
the WY job start bit. Either a reset of the FMS CP module, or a power cycle
of the entire programmable logic controller base, may result in the ladder
logic program setting a WY job start bit prior to the FMS CP module
recovery. When this condition occurs, the FMS CP module does not execute
the job.

A timer instruction (TMR or TMRF) may be implemented in the controller.
The timer is enabled when the WY job start bit is set. The timer is reset in
response to the WX job active bit. If the WX job active bit never responds to
a WY job start bit, the timer is allowed to time out and clears the current
WY job active bit. The next execution of the ladder logic starts the WY job
start bit under normal operating conditions. To allow ample FMS CP
module startup time, set the timer preset value to 30 seconds.
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Overview (continued)

4. The programmable logic controller recognizes the WX bit transition to
1, and then resets the WY bit to 0.

5. The FMS CP module completes the job, stores the job status in
programmable logic controller V-memory, and, when it sees WY bit
reset to 0, resets the WX bit to 0.

6. The programmable logic controller sees WX return to 0, indicating that
the job is complete. It can check the status word for errors: if none, the
programmable logic controller knows that the data was sent/received
successfully.

7. The programmable logic controller can start the job again, whenever it
is ready, by repeating the sequence from Step 2.
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4.2 Addressing on Your Network

PROFIBUS networks use a system of multiplexed addressing (multi-tiered)
for connections, as shown in Figure 4-2. The most basic address of a device
is the PROFIBUS network station address. The next level of addressing is a
Link Service Access Point (LSAP). Each station address is associated with
multiple LSAPs.

32 4 5 32 4 5 32 4 5
x x 61 62 x x 61 62 x x 61 62

2 3 10

Network

LSAPs

Station
Address

Station
Address

Station
Address

Figure 4-2 Multiplexed Addressing

When you set up your network, you assign each device a station address,
and then use this address when you configure the FMS CP module.

As shown in Figure 4-2, each device has a number of LSAPs that you use for
addressing FMS and FDL connections. Each LSAP can be used for one
connection only (except for FMS slaves). Some LSAPs are unavailable
because they are dedicated to other functions. If you select an LSAP that
has been previously dedicated, you receive a message to select a different
LSAP for your connection. Refer to Table A-10 for LSAP assignment
restrictions.

For example, an FMS connection could be set up between LSAP 3 on Station
Address 2, and LSAP 5 on Station Address 10 (as shown on the example
network in Figure 4-3). However, LSAP 3 on Station Address 2 and LSAP 5
on Station Address 10 are then occupied and may not be reused.

32 4 5 32 4 5 32 4 5
x x 61 62 x x 61 62 x x 61 62

2 3 10

Network

LSAPs

Station
Address

Station
Address

Station
Address

Figure 4-3 Network Addressing Example

Multiplexed
Addressing

Station Address

LSAPs
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4.3 FMS Services

Before you configure an FMS communication job, you must first define an
FMS connection using the COM5434 Configurator. To establish a successful
connection, the services of the communication partners must be matched. As
requester, you specify the services that you expect from the partner device.
As responder, you specify the services you provide for the partner device.

NOTE:  The software generates an “Object Dictionary” that contains the
names and index numbers of the FMS variables you configure. To enable
partners to access variables by name, enable the Get Object Dictionary
service when configuring an FMS connection. (Refer to Figure 5-15.)

To define an FMS connection using the COM5434 Configurator, follow the
steps described in Section 5.6.

The FMS CP module acts as a client (initiator) for the following FMS jobs:

• Read – reads data from a data area of the communication partner
specified by a name or index.

• Write – transfers data from a specified local data area to a data area of
the communication partner.

• Information Report – allows unconfirmed transmission of variables by
an FMS server.

• Status – the partner device sends logical and physical status
information that may include the following items: whether
communication is possible, for example, CPU is in RUN; physical
status of CPU, for example, maintenance is required. (Refer to
Section A.3 for more information about Status request responses.)

• Identify – the partner device sends three ASCII strings that provide
the following information: name of the device vendor, name of the
device model, and revision or version of the device. (Refer to Section A.3
for more information about Identify request responses.)

The FMS job types are described and illustrated in Figure 4-4.

These coordinated client jobs must be configured in the client module. To
configure an FMS job, follow the steps described in Section 5.9.

The server station must also be configured to coordinate with the client
station. You must configure coordinating FMS connections for all FMS job
types, and FMS variables for Read and Write jobs in the server station.

FMS Connections

FMS
Communication
Job Types

FMS Server
Functions
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Figure 4-4 shows the data flow of each FMS communication job. Each FMS
communication job is configured in the shaded module.

Read (name or index)

Read response (data)
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P
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P
C
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U

C
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U

Client

Data to memory

Remote Station Y
Server

Data from memory

Read Job

Data stored in a remote
source is read by the client
FMS CP module, and stored
in a specified local memory
address. The remote source
must be specified by a
variable name or an index.

READ

Write (data)
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U
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U
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Data from memory

Remote Station Y
Server

Data to memory

Write  Job

Data stored in the local
station is written to a
specified variable name or
index in a remote station by
the client FMS CP module.
The local address source of
the data must be specified.

WRITE

Information Report (data)
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Data to memory
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Server

Data from memory

Information Report Job

Data is transferred from a
variable name or index in
the server station to a
variable of the same name
or index in the client. (This is
an unacknowledged job.)

INFORMATION REPORT

Status Request

Status Information
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Identity Information
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IDENTIFY

Acknowledge

Data Flow

Job

Job

Job

Job

JobJob

Figure 4-4 FMS Communication Jobs

FMS Jobs



Communication Services4-10 SIMATIC 505 PROFIBUS-FMS CP User Manual

FMS Services (continued)

When you define an FMS connection, you must specify access rights to the
variables you have configured (which are listed in the Object Dictionary).
Access rights are determined in two ways: passwords and group numbers.
(Refer to Figure 4-5.)

Password Access to a variable is only possible with the identical password
setting on the partner.

• 0: The FMS client must specify the password “0” for authorization
when the connection is established. Access is possible for all FMS
clients that specify the password.

• >0: The FMS client must specify this password for authorization
during connection establishment.

Group Numbers Access to a variable is only possible when at least one
group number is selected to match the setting on the partner. Selecting
group numbers is a further method for selectively restricting access rights.
You assign Groups 0 to 7 for each connection and for each variable.

Password = 2

Station 1 Station 2
Job on Station 1 can access

variable on Station 2.
(password match)

Job on Station 2 can access
variable on Station 1.
(password match)

Password = 1

Variable PW = 1 Variable PW = 2

Password = 1

Station 1 Station 2
Job on Station 1 cannot access

variable on Station 2.
(password mismatch)

Job on Station 2 can access
variable on Station 1.
(password match)

Password = 1

Variable PW = 1 Variable PW = 2

Groups 1, 2

Station 1 Station 2
Job on Station 1 can access

variable on Station 2.
(group number match)

Job on Station 2 can access
variable on Station 1.
(group number match)

Groups 3, 4

Variable Group 3 Var. Groups 1, 5

Groups 2, 3

Station 1 Station 2
Job on Station 1 cannot access

variable on Station 2.
(group number mismatch)

Job on Station 2 can access
variable on Station 1.
(group number match)

Groups 3, 4

Variable Group 3 Var. Groups 1, 5

Password  Access

Group Number Access

Figure 4-5 Access to Variables via Passwords and Group Numbers

Specifying Access
Rights to Variables
in FMS Connections
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4.4 Send-Receive Services

Before you configure a Send-Receive job, you must first define an FDL
connection using the COM5434 Configurator. To define an FDL connection,
follow the steps described in Section 5.7.

The FMS CP module supports Send and Receive job types with FDL
connections. To configure a Send or Receive job, follow the steps described in
Section 5.10.

Figure 4-6 shows the data flow of each Send-Receive communication job.
Each job must be configured in both the module executing the Send job and
the module executing the Receive job.
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Data is received from a
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Data Flow

Data from memory Data to memory

Send Job
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Data Flow
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Send
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RECEIVE

Figure 4-6 Send-Receive Communication Jobs

NOTE:  In general, it is best not to configure more than one Send or Receive
job for each FDL connection.

! CAUTION
The FMS CP module fails if you try to execute two Receive jobs at the same
time on a single FDL connection. Module failure could cause unexpected
results in your control application, which could result in personal injury , and/or
damage to property .

To avoid this problem, do not program more than one Send or Receive job to
execute simultaneously on a single connection.

FDL Connections

Send-Receive Jobs
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4.5 Peerlink II Services

Peerlink II is an unacknowledged broadcast service that allows the FMS CP
module to transmit one peer block to other stations and receive up to 31
peer blocks from other FMS CP modules on a scan-by-scan (cyclic) basis, as
shown in Figure 4-7.

Transmit

Note:  Transmit is an unacknowledged broadcast.

SIMATIC 505
F

M
S

 C
P

C
P

U
505 Network

Data from memory

Transmit

One block of data stored in
a specified memory address
in the local station is
transmitted to the network.
The block is configured by a
name, a descriptor ID, and
an address.

Data Flow
TRANSMIT

Receive

Note:  Data is received when it becomes available on the network.

SIMATIC 505

F
M

S
 C

P
C

P
U

505 Network

Receive

Up to 31 blocks of data can
be received from the network
by the local station and are
stored in a specified memory
address. The local station
picks these blocks from the
network based on their
descriptor ID.

Data Flow
RECEIVE

Figure 4-7 Peerlink II Services Data Flow

You configure the interval between transmissions of the data as a number of
programmable logic controller scans (see Section 5.5). If the FMS CP module
is unable to transmit at the rate selected, it transmits as often as possible.
Received data is stored by the FMS CP module. If the FMS CP module is
unable to process received data at the rate at which it is received, it stores
the most recently processed data.

NOTE:  No status information is stored by Peerlink II services. If the
FMS CP module is unable to process data at the requested transmission
interval rate, the FMS CP module does not generate an error message in
the status report. (Refer to Chapter 7 for information on viewing actual peer
transmit intervals in the Peer Block Status diagnostics dialog.)

Transmitting and
Receiving
Peer Blocks

Transmission
Intervals
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4.6 S7 Services

S7 services allow S7 devices to read and write data in the 505 CPU memory.
The FMS CP module also responds to Status requests from an S7 station.
S7 services supported by the FMS CP module are shown in Figure 4-8.
Refer to Section A.2 for details of S7-to-505 memory addressing.

Read or Status request

Read/Status response

Data Flow
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Data from memory

S7 Station
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Data to memory

Read or Status Request

The client S7 station issues
a Read or Status request for
data stored at a specified
address in the server 505
FMS CP. The server sends
the requested data.

READ/STATUS

Write (data)

Data Flow

505 FMS CP
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P
C
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U

Server

Data to memory
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Client

Data from memory

Write  Request

Data stored in the client
S7 station is written to a
specified address in the
server FMS CP station.
The server returns an
acknowledgement.

WRITE

Acknowledge

Job

Job

Figure 4-8 S7 Services Supported as a Server

NOTE:  The 505 FMS CP module requires no configuration of connections or
variables to support S7 read, write, or status request services.

S7 Services
Supported
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5.1 Installing the Software for the FMS CP Module

The COM5434 Configurator software package for the FMS CP module is
contained on two 3.5-inch disks.

To run the COM5434 Configurator software, the operating system and
hardware of your PC must meet the following requirements:

• Windows 95 or Windows NT

• 486 or greater, with at least 8 Mb of RAM

For Windows 95, you can use the procedure shown in Figure 5-1 to install
the COM5434 Configurator software.

Installing COM5434 Configurator Software for
Windows 95 in your Personal Computer

For Windows 95, follow these steps:

1. Insert Disk 1 in your computer.

2. Click the Start  button to open the
Windows 95 menu.

3. Click on the Run...  menu item.

4. In the Run dialog, type: A:\SETUP

5. Click on “OK” or press ENTER to start the
setup procedure.

6. Follow the on-screen prompts to complete
the installation.

7. Double click on Configurator icon to start.

Disk 1

Figure 5-1 Installing the COM5434 Configurator Software

For Windows NT or Windows 95, you can use the following procedure to
install the COM5434 Configurator software:

1. Insert Disk 1 in  your computer’s disk drive.

2. Use the Windows Explorer to access your disk drive and display the
contents of Disk 1.

3. Select the file named SETUP. EXE.

4. Double click on SETUP. EXE or press ENTER to start the setup
procedure.

5. Follow the on-screen setup prompts to complete the installation.

Software Package

Operating System
Requirements

Installing the
COM5434
Configurator
Software
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If you have successfully installed the COM5434 Configurator software, you
can start it in one of the following ways:

• Double-click on the icon that appears on your Windows desktop.

• Click the Start button to open the Windows 95 menu, select Programs,
then locate and click on the COM5434 program in the sub-menu.

Refer to Section 2.4 for information on connecting the programming cable
from your PC to the FMS CP module. Once the programming cable is
installed properly, you need to configure the communication setup.

1. Select the menu command Transfer → Communications Setup... as
shown in Figure 5-2. The first dialog allows you to select which port
you want to configure. Select the PC Serial Port.

2. Click on the “Configure Port” button to access the PC-to-Module Serial
Port Dialog.

✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

Allows the selection and configuration of PC to CP5434-FMS communications

Module Local Configuration

FMS Connections
FDL Connections

Communication Jobs

FMS Jobs
Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

Description:

File Name:

Directory:

UNTITLED

<no description>

Select this menu
command.

Modified?: NO

Transfer

Communications Setup...

Upload from the CP5434

Download to the CP5434

Validate Configuration Now

Ctrl+D

Ctrl+U

Ctrl+BPC Communication Port Setup

Configure PortExit

Select PC Port Media:

PC Serial Port (RS232)

PROFIBUS Card

Click here to select
port number and
baud rate.

Figure 5-2 Configuring the Communications Setup

Starting the
COM5434
Configurator
Software

Configuring
PC-to-FMS CP
Module
Communications



Using the COM5434 Configurator5-4 SIMATIC 505 PROFIBUS-FMS CP User Manual

Installing the Software for the FMS CP Module (continued)

3. Select the port number that corresponds to the port on your PC, and
select the communications baud rate that matches the jumper setting
on the module (see Section 2.2), as shown in Figure 5-3.

4. Click on the “Test” button to verify the communication setup.

5. Click on OK when the “Communication Successful” message appears.
(If a “Comm Failed” message appears, check your port number or baud
rate, make adjustments as needed, and try again.)

6. Click on “Exit” to exit each of the communication setup dialogs.

PC-to-Module Serial Port (RS232)

TestExit

Port Number:

COM1:

COM2:

COM2:

COM2:

Baud Rate:

38.4k

19.2k

9.6k
Click here to test port
communications.

Figure 5-3 PC-to-Module Serial Port Setup Dialog

To allow your PC to communicate with the FMS CP module on a PROFIBUS
network, you must install one of the PROFIBUS card/software packages
listed in Table 2-2 on your PC.

NOTE:  You must configure the local module parameters using the RS-232
port before you can use a PROFIBUS card. The Local Module Configuration
parameters are not downloaded when using a PROFIBUS card because this
would change the PROFIBUS communications and possibly cause an
interruption during download. To change these parameters, reconnect the
RS-232 cable.

Configuring
PROFIBUS Card
Communications
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Use the following procedure to configure your PC to communicate on a
PROFIBUS network:

1. Select the menu command Transfer → Communications Setup... as
shown in Figure 5-2. The first dialog allows you to select which port
you want to configure. Select the PROFIBUS Card option button.

2. Click on the “Configure Port” button to access the Select PROFIBUS
Connection Dialog, shown in Figure 5-4.

3. Select Device. The device represents a PROFIBUS card and driver.

4. Select VFD. The Virtual Field Device is a group of connections
configured for a given device.

5. Select Connection. The connections represent actual connections on the
PROFIBUS network.

6. Click on the “Test” button to verify the communication setup.

Exit

1) Select Device:

Test

Select Profibus Connection

DPONLINE
CP_L2_1

S7ONLINE

2) Select VFD:

VFD1

3) Select Connection:

505 CP5434FMS Addr 5
505 CP5434FMS Addr 4

Figure 5-4 PROFIBUS Connection Dialog
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5.2 Features and Functions of the COM5434 Configurator Software

To use all of the commands and features described in this chapter, you must
have installed the COM5434 Configurator software and connected your PC
to the FMS CP module. From your Windows screen, double-click on the
configurator icon to start the COM5434 Configurator.

To access commands in the COM5434 Configurator, point to an item in the
menu bar with the mouse and click to open the drop-down menu.

• Windows menu items may also be selected by pressing the Alt  key
and the underlined letter of the menu item. For example, to select File,
either click on the word File, or press Alt  F . This opens the
drop-down menu.

• Pressing the Esc  key (escape) is the same as selecting the Cancel
button in a window.

Figure 5-5 shows the main screen of the COM5434 Configurator.

✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

Configuration
Tree

Minimize

Maximize/Restore Close

Toolbar

Status Bar

Menu Bar

Title Bar

Current configuration file specification

Module Local Configuration

FMS Connections
FDL Connections

Communication Jobs

FMS Jobs
Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

<no description> Description:

File Name:

Directory:

UNTITLED

Edit page indicator

Modified?: NO

Resizable
splitter bar

Input Pane

Last Saved File:

Last Saved Directory:

Figure 5-5 COM5434 Configurator Screen

Getting Started
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The main features of the COM5434 Configurator screen (shown in
Figure 5-5) are described below.

Title Bar The title bar contains the title of the current configuration file and
Windows-based buttons that allow you to change the size of the configurator
screen: a minimize button, a maximize/restore button, and a close button.

Menu Bar The menu bar contains drop-down menu commands. The menu
commands allow you to perform the functions of the configurator software.
The menu commands are described in the following pages.

Toolbar The toolbar contains buttons which you can use as shortcuts to
perform frequently used menu commands. The toolbar buttons are
described in the following pages.

Configuration Tree The configuration tree displays the structure of the
current configuration. Branches of the tree can be expanded and collapsed.
For example, if you have configured five FMS connections, and you do not
want the connections to display, double-click on the FMS Connections
branch, and the connection names are hidden. Double-click again and the
tree expands, displaying the connection names.

Status Bar The status bar contains a description of an item currently in
focus or an item that corresponds to the current location of the cursor.

Input Pane The input pane is the right pane of the configurator screen
where you enter configuration parameters into named fields.

Splitter Bar The splitter bar allows you to resize the width of the input pane
if needed to prevent the field descriptions from wrapping.

Edit Page Indicator Indicates that you are in edit mode in the current
configuration input pane.

Main Screen
Features
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Features and Functions of the COM5434 Configurator Software (continued)

Table 5-1 describes the functions of each of the menu commands of the
COM5434 Configurator software main screen.

Table 5-1 Menu Commands

Menu Commands Description

File

New

Open

Save

Save As...

Print...

Print Preview

1_NEWFILE.fms

Exit

Ctrl+N

Ctrl+O

Ctrl+S

Ctrl+P

Print Setup...

New creates a new configuration.

Open  opens an existing configuration file.

Save saves the work in the current file.

Save As  saves the current configuration with
a new file name.

Print  sends the configuration to a printer.

Print Preview  allows you to see what the
output will look like before you print it.

Print Setup  allows you to configure printer
settings.

Recent File  opens an existing configuration
file; the menu displays the names of the most
recent saved files (for example, 1_newfile.fms)

Exit  exits from the COM5434 Configurator.

Undo Page

Cut

Copy

Paste

Paste Special

Ctrl+Z

Ctrl+X

Ctrl+V

Ctrl+C

New Item INS

Edit

Ctrl+T

Undo Page  reverses all changes made to the
current input pane of the configuration.

New Item  creates a new item (connection, job,
etc.) in the configuration.

Cut  cuts highlighted text from the
configuration to the clipboard.

Copy  copies highlighted text from the
configuration to the clipboard.

Paste  pastes copied or cut material from the
clipboard to the cursor location in the
configuration.

Paste Special  reverses local and remote
information as it inserts clipboard contents.

Transfer

Communications Setup...

Upload from the CP5434

Download to the CP5434

Validate Configuration Now

Communications Setup  allows you to select
and configure your communication port.

Download to the CP5434  downloads a
configuration to the FMS CP module.

Upload from the CP5434  uploads a
configuration from the FMS CP module.

Validate Configuration Now  forces an
immediate validation check of the current
configuration.

Menu Commands
of the COM5434
Configurator
Software
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Table 5-1 Menu Commands (continued)

Menu Commands Description

Options

✔  Validate Page After Edits

✔ Automatically Generate Names

Automatically Generate Names automatically
generates unique names for each new item
name field.

Validate Page After Edits  automatically
checks your work each time that you switch
input panes in the configuration.

Diagnostics

Active Stations

Profibus Statistics

FMS Connection Status

FDL Connection Status

CP Status

Job Status

Peer Block Status

CP Status allows you to examine the status of
the FMS CP module on your network.

Active Stations  displays a list of all stations
present on the network and the status of each.

Profibus Statistics  displays a list of bus
activity statistics and current status.

FMS Connection Status  displays a list of all
configured FMS connections and their status.

FDL Connection Status  displays a list of all
configured FDL connections and their status.

Job Status  displays a list of all FMS and
Send-Receive jobs and their current status.

Peer Block Status  displays a list of all
configured Peer Blocks and their status.

Help

Contents

About

Index

Contents  accesses the contents directory of
the online help system.

Index  accesses the index of the online help
system.

About  displays version and copyright
information about the COM5434
Configurator.

You can also perform some of the editing functions with “Drag-and-Drop”
mouse actions. For example, if you open another instance of the configurator
and have two windows visible, you can use the drag-and-drop operation to
edit in the following ways:

• Copy and Paste: Select an item from one configuration tree and hold
the mouse button down while you move (drag) the item to a location in
another configuration and then release the button. This makes an exact
copy of a configured item and pastes it into another configuration.

• Copy and Paste Special: You can use the drag-and-drop operation as
described above while pressing the Ctrl  key on your keyboard. This
makes a copy of a configured item with reversed local/remote settings
and pastes it into another configuration.

Drag-and-Drop
Operations
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Features and Functions of the COM5434 Configurator Software (continued)

The toolbar, located below the menu bar, consists of buttons which duplicate
frequently used menu commands. A tool tip displays the name of each
button when you place the mouse cursor over it for a few seconds. The
toolbar buttons are described in Table 5-2.

Table 5-2 Toolbar Buttons

Button Menu Equivalent Description

File → New Creates a new configuration.

File → Open Opens an existing configuration file.

File → Save Saves the work that you have done in the
current file.

Edit → Undo Page Reverses all changes to the current input pane.

✂ Edit → Cut Cuts highlighted item from the configuration
and sends it to the clipboard.

Edit → New Item Creates a new item in the configuration.

Edit → Copy Copies highlighted item from the configuration
to the clipboard.

Edit → Paste Pastes copied or cut material from the clipboard
to the cursor location in the configuration.

Edit → Paste
Special

Pastes clipboard contents while automatically
reversing local and remote information.

Transfer → Down-
load to the CP5434

Downloads a configuration to the FMS CP
module.

Transfer → Upload
from the CP5434

Uploads a configuration from the FMS CP
module to the COM5434 Configurator.

Options → Validate
Page After Edits

Validates entries to the current input pane
before you start another configuration page.

Transfer → Validate
Configuration Now

Forces an immediate validation check of the
current configuration.

File → Print Sends the configuration to a printer.

Help → Contents Accesses the contents directory of the online
help system.

Toolbar
Commands
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When your mouse cursor is on an item in the configuration tree, you can
click the right mouse button to call up a pop-up menu. This menu duplicates
most of the commands on the Edit menu. With the mouse cursor in a data
entry field, the right mouse button calls up a different pop-up menu that
offers edit commands for selected or nonselected data (see Figure 5-6).

✂
File Edit Transfer Options Diagnostics Help

Untitled – COM5434

Configured cyclic data blocks sent/received to/from other 505-CP5434-FMS modules

Click the right
mouse button.

Module  Local Configuration

FMS Connections
FDL Connections

Communication Jobs

FMS Jobs
Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

Peer Block Name:<no description>

P–P peer_block_1

Cut

Copy

Paste

Paste Special

Ctrl+X

New Item INS

Descriptor ID:

Peer Block Type:

Local Address:

Receive

peer_block_1

Ctrl+V

Ctrl+C

Undo

Cut

Copy

Paste

Delete

Select All

5

Pop-up
Edit Menus

Figure 5-6 Right Mouse Button Editor

New Item Allows you to create a new item (connection, job, etc.) in the
configuration.

Cut Allows you to cut a highlighted field or item from the configuration.
The cut material is sent to the clipboard.

Copy Allows you to copy a highlighted field or item from the configuration
to the clipboard.

Paste Allows you to paste a copied or cut item from the clipboard to the
cursor location in the configuration.

Paste Special Allows you to paste a copy of a connection or job to another
configuration and automatically complement the connection settings.

Right Mouse Button
Editor
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5.3 Describing the Configuration File

✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

Current configuration file specification

Module Local Configuration

FMS Connections
FDL Connections

Communication Jobs

FMS Jobs
Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

Description:

File Name:

Directory:

UNTITLED

<no description>Click here.

Modified?: NO

Last Saved File:

Last Saved Directory:

The “Last Saved...”
fields help identify any
configuration that you
upload from a module.

Figure 5-7 Naming the File

The input pane shown in Figure 5-7 allows you to provide a descriptive title
for your configuration file. Click in the Description field in the input pane,
and enter a descriptive title, up to 32 characters, for your configuration.

The remaining fields in this input pane display the following information:

File Name A read-only field that displays the name of the current
configuration file after you have saved and named the file.

Directory A read-only field that displays the directory location of the
current configuration file after you have saved and named the file.

Modified? A read-only field that indicates whether or not the
configuration file has been modified since the last time it was saved.

Last Saved File A read-only field that displays the name of the file that
the configuration was last saved in.

Last Saved Directory A read-only field that displays the location of the
directory that the configuration was last saved in.

Entering a Title for
Your Configuration
File
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5.4 Defining the Module Local Configuration

The module local configuration, shown in Figure 5-8, identifies the local
station address where the FMS CP module resides and defines the
communication parameters used by the FMS network. You cannot configure
connections or communication services for an FMS CP module unless you
define the local configuration for that module.

✂
File Edit Transfer Options Diagnostics Help

Untitled – COM5434
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Module Local Configuration
Local Station Address:

Slot Time (Tslot):

Max. Sta. Delay (Max_Tsdr):

300

150

4

Highest Station Address: 126

Bus Parameter Profile: Standard

Baud Rate: 1.5 MBaud

# of Masters (holds token): 2

# of Slaves (no token): 0

Min. Sta. Delay (Min_Tsdr):

Setup Time (Tset):

11

1

Quiet Time (Tqui):

Gap Factor:

0

10

Retry Limit:

Token Rotation (Ttr):

1

9900

Click here.

Figure 5-8 Module Local Configuration

To define the module local configuration, follow the steps below:

1. Click on Module Local Configuration on the configuration tree.

2. Fill in the following fields in the input pane:

Local Station Address Enter the local station address, within a range of
0 to 126, (PROFIBUS network address) where the FMS CP module
resides.

What Is the
Module Local
Configuration?

Defining the
Module Local
Configuration
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Defining the Module Local Configuration (continued)

Highest Station Address Use the drop-down list to select the value that
is equal to or greater than the highest PROFIBUS network station
address in use on your network. This number is used by the COM5434
Configurator to calculate the token rotation time for your network. You
may need to adjust this number when you add or subtract stations from
your network. Valid HSA values are 15, 31, 63, and 126.

NOTE:  If the number configured is higher than the real highest station
address, you may experience a small loss of speed on your network, but the
network will function properly. If the number configured is lower than the
real highest station address on your network, then any stations above the
highest station address will not be added to the token ring. If you try to add
this station to a network ring with a higher station address than the one
you specified as the HSA, an error will occur and your station will not be
allowed to enter the ring.

Bus Parameter Profile Bus parameters must match in all the stations on
the network. For most networks, selecting one of the parameter profiles
provided by the COM5434 Configurator will help simplify the process
of configuring the network. The default profile is Standard, but you can
choose Standard-Mixed, FMS-DP Universal, or Custom. Each profile
provides values for the remaining fields on the input pane except for
Baud Rate, # of Masters, and # of Slaves, which you must supply. If you
want to customize values for any of the other fields, select Custom from
the drop-down list. In general, you can use the following profiles:

• Standard for 505-to-505 communications

• Standard-Mixed for 505-to-S7 communications*

• FMS-DP Universal for 505-to-S5 communications, and if the
network includes DP devices

Baud Rate Use the drop-down list to select the appropriate baud rate
that the module will use for network communications.

# of Masters (holds token) Enter the number of masters on the
network. Masters are the devices on the network that take turns
holding the token.

# of Slaves (no token) Enter the number of slaves on the network.
Slaves are devices that do not hold the token.

*Standard-Mixed matches the current release of STEP 7; earlier releases of STEP 7 may have
different bus parameters, requiring you to select Custom to match parameters.
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NOTE:  If you customize the Bus Parameter Profile by selecting Custom in
the Bus Parameter Profile field and changing values in any of the fields
below, every device on your network must have the same or a compatible
profile. Otherwise, your system cannot function properly.

If you selected Custom in the Bus Parameter Profile field, you can change
the following parameters for your module local configuration:

Slot Time (Tslot) Enter the maximum time, in bit times, that a master
station on your network waits for a response after sending a message.

Max. Sta. Delay (Max_Tsdr) Enter the maximum time, in bit times, that
a responder delays before beginning a response.

Min. Sta. Delay (Min_Tsdr) Enter the minimum time, in bit times, that a
responder delays before beginning a response.

Setup Time (Tset) Enter the time, in bit times, between events and the
necessary reaction.

Quiet Time (Tqui) Enter the minimum time, in bit times, that a
transmitting station must wait between sending a message and
enabling its receiver.

Gap Factor Enter a number that indicates when the master must
perform a gap update. For example, if you choose a gap factor of 10, the
master can hold the token for 9 turns without performing a gap update;
on the 10th turn, the master must begin to poll the gap, checking one
station each time it receives the token.

Retry Limit Enter the number of times a master may retry a
transmission.

Token Rotation (Ttr) Enter the anticipated time, in bit times, for one
token round on your network, including allowances for high and low
priority transactions, errors, and polling the gap.
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5.5 Defining Peerlink II Services

The FMS CP module supports a maximum of 32 Peerlink II services, as
shown in Figure 5-9. The FMS CP module transmits and receives data (in
the form of peer blocks) to and from other SIMATIC 505 FMS CP modules
on your network on a scan-by-scan basis. When you click on Peerlink II
Services on the configuration tree, the COM5434 Configurator displays the
number of Transmit and Receive blocks available.

✂
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Figure 5-9 Peerlink II Services Available

To configure Peerlink II Services, define the desired transmission interval
and priority factor, and then configure the individual peer function blocks.

Peer Transmit Interval Enter a numeric value, from 0 to 65,535 (scan
cycles), to specify how often the Transmit peer block transmission is
attempted.

Peer Priority Factor Enter a numeric value, from 0 to 8, to specify the
priority for writing received peer data blocks to the PLC versus other
communications activities (e.g., FMS jobs). A factor of 8 specifies the
highest priority for received peer data, but still allows other activities if
no peer receives are pending. A factor of 0 is the lowest priority, but
still allows peer receives if no other activities are pending.

Peerlink II Services
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✂
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Descriptor ID:
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Click the
New Item
button.

Figure 5-10 Defining a Peer Block

To define a peer block, follow the steps below:

1. Click on Peerlink II Services on the configuration tree.

2. Click on the New Item button on the toolbar. A new peer block appears
in the configuration tree and the input fields change (see Figure 5-10).

3. Fill in the following fields in the input pane:

Peer Block Name Enter a unique name, up to 32 characters, for the
peer block. (If you have selected Automatically Generate Names from
the Options menu, the COM5434 Configurator enters a name for the
peer block, but you can change it if you want.)

Descriptor ID Enter a unique numeric value for each peer block. The
Descriptor ID is a method of identifying each peer block. The FMS CP
module uses this identifier to search for the peer blocks that the
module is configured to receive, and to encode the peer block that it is
configured to transmit. The valid range for this field is from 0 to 255.

Defining a Peer
Block
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Defining Peerlink II Services (continued)

Peer Block Type Select either Receive or Transmit for each peer block.
(Remember that each FMS CP module supports only one transmit
block and up to 31 receive blocks.)

Local Address Enter the location where the FMS CP module retrieves
data it is transmitting or stores data received during the job. The local
address consists of the programmable controller memory type
(V, K, X, Y, etc.), the starting address, and the number of locations (the
configurator automatically calculates them as a bit, byte, or word,
based on the memory type selection). When you click on the Local
Address field, a button appears. Click on the button, and the PLC
Memory Type Editor dialog box appears. Fill in the fields in the dialog
box to complete the local address. Then select OK.

Figure 5-11 shows an example of the editor after the drum count preset
(DCP) memory type has been selected, which causes the Step # field to
appear.

PLC Memory Type Editor

CancelOK

Select PLC Memory Type, enter address offset, and then enter size of memory
for the specified type.

PLC Memory Types:

PLC Memory Address:

# of Locations:

Enter a memory
type or select from
the drop-down list.

1

1

Step #: 1

(Address Range: 1 to 2034)

(Location Format: WORD)

DCP

Maximum data block size:
234 bytes (117 words)

Figure 5-11 PLC Memory Type Editor Dialog Box
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5.6 Defining FMS Connections

The FMS CP module supports up to 32 FMS connections, as shown in
Figure 5-12.

✂
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Links to other Fieldbus Message Specification (FMS) devices

Module Local Configuration

FDL Connections

Communication Jobs

FMS Jobs
Send-Receive Jobs
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�
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DTs

Peerlink II Services

FMS Variables

<no description>

FMS Connections

Maximum FMS Connections:

FMS Connections Used:

32

0

FMS Connections Available: 32

Click here.

Figure 5-12 FMS Connections Available

Maximum FMS Connections This field displays the total number of FMS
connections supported by the FMS CP module.

FMS Connections Used This field displays the number of FMS connections
that have been defined for the FMS CP module.

FMS Connections Available This field displays the total number of unused
FMS connections.

FMS Connections



Using the COM5434 Configurator5-20 SIMATIC 505 PROFIBUS-FMS CP User Manual

Defining FMS Connections (continued)

✂
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Click the
New Item
button.

Module Local Configuration

FMS Connections

FDL Connections

Communication Jobs

FMS Jobs
Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

<no description>

FMS
fms_connection_1

Name:
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0
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0
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0

241

0

1

Password: 0

Access Groups: 0,1,2,3,4,5,6,7

fms_connection_1

Note: Use the scroll bar
buttons, if necessary, to
view additional fields.

Services Supported: Requester= rw, Responde

Figure 5-13 Defining FMS Connections

To define an FMS connection, follow the steps below:

1. Click on FMS Connections on the configuration tree.

2. Click on the New Item button on the toolbar. An FMS connection
appears in the configuration tree and the input fields change (see
Figure 5-13).

3. Fill in the following fields in the input pane:

Name Enter a unique name, up to 32 characters, for each FMS
connection. (If you have selected Automatically Generate Names from
the Options menu, the COM5434 Configurator enters a name for you,
but you can change it if you want.)

Local LSAP Enter a numeric value for the Link Service Access Point for
the FMS connection on the local FMS CP module. You cannot use the
same LSAP more than once per module. Choose a value between 2 and
62, except for 58 (refer to Table A-10 for LSAP assignment restrictions).

Defining an FMS
Connection
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Remote Station Address Enter the PROFIBUS network address used
by the remote device.

Remote LSAP Enter a numeric value for the Link Service Access Point
for the FMS connection on the remote device. Choose a value between 2
and 62. You cannot use the same LSAP more than once at the same
remote station (refer to Table A-10 for LSAP assignments).

Maximum PDU Size TX High Specify the maximum number of bytes for
Protocol Data Units that can be sent on high priority transmissions.

Maximum PDU Size TX Low Specify the maximum number of bytes for
Protocol Data Units that can be sent on low priority transmissions.

Maximum PDU Size RX High Specify the maximum number of bytes for
Protocol Data Units that can be received on high priority receptions.

Maximum PDU Size RX Low Specify the maximum number of bytes for
Protocol Data Units that can be received on low priority receptions.

Data Transfer Type Select the type of data transfer and relationship
between the remote device and the FMS CP module. (See Table A-8 for
details on transfer types and jobs allowed.)

Maximum Confirmed Services To Specify the maximum number of
confirmed concurrent services that can be sent to the remote station.

Maximum Confirmed Services From Specify the maximum number of
confirmed concurrent services that can be received from the remote
station.

Maximum Unconfirmed Services To Specify the maximum number of
unconfirmed concurrent services that can be sent to the remote station.

Maximum Unconfirmed Services From Specify the maximum number of
unconfirmed concurrent services that can be received from the remote
station.

Control Interval Specify the maximum time allowed between
commands on the bus in 10 ms intervals.

Multiplier Specify how many times this connection is entered into the
poll-list. A higher value gives this connection a higher priority relative
to other connections (used only for some master-slave connections).

Password Enter a numeric value as the password. This password, if
used, must match the password specified for the variable at the remote
partner. 0 = Access is possible for all FMS clients that specify a
password of 0. To specify access restricted by password, the valid range
is 1 to 255. Refer to Section 4.3 for more information.
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Defining FMS Connections (continued)

Access Groups When you click on the Access Groups field, a button
appears in the field. Click on the button to view the Access Group
Rights dialog box (shown in Figure 5-14). Select the groups that have
access by clicking on the group boxes. Click on OK. The dialog box
disappears, and the selected groups are displayed in the Access Groups
field. (Refer to Section 4.3 for more information.)

Access Group Rights

CancelOK

Select access group rights for the current configuration.

Group #0

Group #1

Group #2

Group #3 Group #7

Group #6

Group #5

Group #4
Note:  Access to a variable is
only possible when at least one
group number is selected to
match the setting on the partner.

Figure 5-14 FMS Access Group Rights Dialog Box

Services Supported When you click on the Services Supported field, a
button appears in the field. Click on the button to view the Services
Supported dialog box (shown in Figure 5-15). Select the services by
clicking on the boxes, and then select OK. The dialog box disappears,
and the selected services are displayed in the corresponding field.

FMS Services Supported

Read:
Requester:

Write:

Select the services supported by this FMS connection:

Information Report:

Get Object Dictionary:

CancelOK

Responder:

Note: Access using
variable names is only
possible when the Get
Object Dictionary
service is selected.

Requester:  specify services
you expect from the partner.
Responder:  specify services
you provide for the partner.

Figure 5-15 FMS Services Supported Dialog Box
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5.7 Defining FDL Connections

The FMS CP module supports up to 32 FDL connections, as shown in
Figure 5-16. FDL connections are used for Send-Receive jobs.

✂
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Links to other Fieldbus Data Link (FDL) devices
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Maximum FDL Connections:

FDL Connections Used:
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FDL Connections Available: 32

Module Local Configuration

Communication Jobs

FMS Jobs
Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

<no description>

FMS Connections
FDL Connections

Figure 5-16 FDL Connections Available

Maximum FDL Connections This field displays the total number of FDL
connections supported by the FMS CP module.

FDL Connections Used This field displays the number of FDL connections
that have been defined for the FMS CP module.

FDL Connections Available This field displays the total number of unused
FDL connections.

FDL Connections
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Defining FDL Connections (continued)

✂
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S-R fdl_connection_1

Name:

Local LSAP:

Remote Station Address: 0

Remote LSAP: 0

0

fdl_connection_1

Figure 5-17 Defining FDL Connections

To define an FDL connection, follow the steps below:

1. Click on FDL Connections on the configuration tree.

2. Click on the New Item button on the toolbar. An FDL connection
appears in the configuration tree and the input fields change (see
Figure 5-17).

3. Fill in the following fields in the input pane:

Name Enter a unique name for each FDL connection. (If you have
selected Automatically Generate Names from the Options menu, the
COM5434 Configurator enters a name for the connection, but you can
change it if you want.)

Remote Station Address Enter the PROFIBUS network address used
by the remote device.

Defining an FDL
Connection
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Local LSAP Enter a numeric value for the local Link Service Access
Point for the FDL connection on the local module. Choose a value
between 2 and 33. You cannot use the same local LSAP more than once.

Remote LSAP Enter a numeric value for the remote Link Service
Access Point for the FDL connection on the remote device. Choose a
value between 2 and 33. You cannot use the same remote LSAP more
than once per remote address.

If the value you select is assigned to a system function, you are prompted to
select another value.
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5.8 Overview of Communication Jobs

The FMS CP module supports a maximum of 48 communication jobs, as
shown in Figure 5-18. When you click on Communication Jobs on the
configuration tree, the COM5434 Configurator displays the number of each
type of communication job you have used, and the number of available
communication jobs remaining.
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Jobs triggered by setting the configured start bit

Module Local Configuration

FMS Jobs
Send-Receive Jobs

FMS Data Types
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FDL
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Peerlink II Services

FMS Variables
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FMS Connections

Maximum Comm. Jobs:

FMS Jobs Used:
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0

Send-Receive Jobs Used: 0

FDL Connections

Communication Jobs

Comm. Jobs Available: 48

Click here.

Figure 5-18 Communication Jobs

Maximum Communication Jobs This field displays the number of
communication jobs supported by the FMS CP module.

FMS Jobs Used This field displays the number of FMS jobs that have been
defined for the FMS CP module.

Send-Receive Jobs Used This field displays the number of Send-Receive
jobs that have been defined for the FMS CP module.

Communication Jobs Available This field displays the total number of
unused communication jobs.
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5.9 Configuring FMS Jobs

Before you can configure an FMS job, you must have defined an FMS
connection between the local FMS CP module and the remote device (see
Section 5.6). Click on FMS Jobs on the configuration tree to see the number
of communication jobs available, as shown in Figure 5-19.

The FMS CP module supports five types of FMS communication jobs: Read,
Write, Information Report, Status, and Identify. For more detail on these
FMS jobs, see Section 4.3.

✂
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FDL Connections
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Figure 5-19 FMS Jobs Available

Maximum Communication Jobs This field displays the total number of
communication jobs supported by the FMS CP module.

FMS Communication Jobs This field displays the number of FMS jobs that
have been defined for the FMS CP module.

Communication Jobs Available This field displays the total number of
unused communication jobs.

FMS Jobs
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Configuring FMS Jobs (continued)

✂
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Figure 5-20 Configuring FMS Jobs

To define an FMS job, follow the steps below:

1. Click on FMS Jobs on the configuration tree.

2. Click on the New Item button on the toolbar. An FMS job appears in the
configuration tree and the input fields change (see Figure 5-20).

3. Fill in the following fields in the input pane:

Job Name Enter a unique name for each FMS job. (If you have
selected Automatically Generate Names from the Options menu, the
COM5434 Configurator enters a name for the FMS job, but you can
change it if you want.)

Start Bit Each FMS job requires a start bit to trigger the job. The start
bit for each job must be unique. When you select a start bit for the job
from the drop-down menu in the Start Bit field, that bit is no longer
available as a selectable bit for other jobs. (The corresponding “job
active” bit is automatically assigned when you select the start bit.)

Defining an FMS
Job
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Job Type Select Read, Write, Information Report, Status, or Identify
from the drop-down list. (See Section 4.3 for descriptions of the FMS job
types.)

Connection Select an FMS connection that you have previously
defined in the FMS Connections branch of the configuration tree. The
COM5434 Configurator automatically lists your connection choices in a
drop-down menu.

Status Word V The status word is a memory location in V-memory
which is updated each time a job completes. This allows you to check
the status of each job you configure. If you specify a value of zero in this
field, job status is not reported to a status word. (You can examine the
status of job communications by selecting the menu command
Diagnostics → Job Status.)

Local Address Enter the location where the FMS CP module retrieves
the data it is transmitting or stores the data it receives during the job.
The local address consists of the programmable controller memory type
(V, K, X, Y, etc.), the starting address, and the number of locations (the
configurator automatically calculates them as a bit, byte, or word,
based on the memory type selection). When you click on the Local
Address field, a button appears. Click on the button, and the dialog box
shown in Figure 5-21 appears. Fill in the fields in the dialog box to
complete the local address. Then select OK. (You can also enter an
address manually; for example, V1, 1.)

PLC Memory Type Editor

CancelOK

Select PLC Memory Type, enter address offset, and then enter size of memory
for the specified type.

PLC Memory Types:

PLC Memory Address:

# of Locations:

Enter a memory
type or select from
the drop-down list.

1

1

Maximum variable size:
237 bytes or 118 words

Figure 5-21 PLC Memory Type Editor Dialog Box

Variable Name or <Index> Enter the variable name or variable index
where the remote device stores the data that is transmitted during the
job. You can also specify a subindex by using a colon (:) followed by the
element number of the variable (user data type or array); for example,
<100:2> indicates the second element of variable 100.
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5.10 Configuring Send-Receive Jobs

Before you can configure a Send-Receive job, you must have defined an FDL
connection between the local FMS CP module and the remote device (see
Section 5.7). The FMS CP module supports 48 communication jobs, which
may be a combination of FMS and Send-Receive jobs. Click on Send-Receive
Jobs on the configuration tree to see the number of communication jobs
available, as shown in Figure 5-22.

For more detail on these jobs, see Section 4.4.
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Figure 5-22 Send-Receive Jobs

Maximum Communication Jobs This field displays the total number of
communication jobs supported by the FMS CP module.

Send-Receive Jobs This field displays the number of Send-Receive jobs that
have been defined for the FMS CP module.

Communication Jobs Available This field displays the total number of
unused communication jobs.

Send-Receive Jobs
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Figure 5-23 Configuring Send-Receive Jobs

To define a Send-Receive job, follow the steps below:

1. Click on Send-Receive Jobs on the configuration tree.

2. Click on the New Item button on the toolbar. A Send-Receive job
appears in the configuration tree and the input fields change (see
Figure 5-23).

3. Fill in the following fields in the input pane:

Job Name Enter a unique name for each Send-Receive job. (If you
have selected Automatically Generate Names from the Options menu,
the COM5434 Configurator enters a name for the job, but you can
change it if you want.)

Start Bit Each Send-Receive job requires a start bit to trigger the job.
The start bit for each job must be unique. When you select a start bit
for the job from the drop-down menu, that bit is no longer available as
a selectable bit for other jobs. (The corresponding “job active” bit is
automatically assigned when you select the start bit.)

Defining a
Send-Receive Job



Using the COM5434 Configurator5-32 SIMATIC 505 PROFIBUS-FMS CP User Manual

Configuring Send-Receive Jobs (continued)

Job Type Select Send or Receive from the drop-down list.

FDL Connection Select an FDL connection that you have previously
defined. The COM5434 Configurator automatically lists your
connection choices.

Status Word V The Status Word is a memory location in V memory
which is updated each time a job completes. This allows you to check
the status of each job you configure. If you specify a value of zero in this
field, job status is not reported to a status word. (You can examine the
status of job communications by selecting the menu command
Diagnostics → Job Status.)

Local Address #n Enter the address for each location where the
FMS CP module retrieves the data it is transmitting or stores the data
it receives during the job. Each local address consists of the
programmable controller memory type (V, K, X, Y, etc.), the starting
address, and the number of locations (the configurator automatically
calculates them as a bit, byte, or word, based on the memory type
selection). The total number of bytes of all the memory locations added
together cannot exceed 240 bytes.

When you click on one of the Local Address fields, a button appears.
Click on the button, and the dialog box shown in Figure 5-24 appears.
Fill in the fields in the dialog box to complete the local address. Then
select OK. (You can also enter an address manually; for example, V1, 1.)

PLC Memory Type Editor

CancelOK

Select PLC Memory Type, enter address offset, and then enter size of memory
for the specified type.

PLC Memory Types:

PLC Memory Address:

# of Locations:

Enter a memory
type or select from
the drop-down list.

1

1

Note:  Maximum data size:
240 bytes (120 words) total
for all addresses combined.

Figure 5-24 PLC Memory Type Editor Dialog Box
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5.11 Creating FMS Data Types

The FMS CP module supports up to 85 FMS data types. You can construct a
user data type to hold a combination of information types, and then define a
variable that uses that special data type.

Click on FMS Data Types on the configuration tree to see the number of
user data types available, as shown in Figure 5-25.
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Figure 5-25 FMS Data Types Available

Maximum User Data Types This field displays the total number of FMS user
data types that are supported by the FMS CP module.

User Data Types Used This field displays the number of user data types that
have been created.

User Data Types Available This field displays the number of user data types
that can be constructed.

FMS Data Types
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Creating FMS Data Types (continued)
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Figure 5-26 Creating a User Data Type

To create a User Data Type, follow the steps below:

1. Click on FMS Data Types on the configuration tree.

2. Click on the New Item button on the toolbar. A User Data Type appears
in the configuration tree and the input fields change (see Figure 5-26).

3. Fill in the following fields in the input pane:

Name Enter a unique name for each user data type. (If you have
selected Automatically Generate Names from the Options menu, the
COM5434 Configurator enters a name for the data type, but you can
change it if you want.)

Length (bytes) The length of the data type you create is determined by
the combination of pre-defined types you select. The COM5434
Configurator automatically calculates this information for you after you
define the user data type.

Creating a User
Data Type
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Definition When you click on the Definition field, a button appears.
Click on the button to bring up the User Data Type Editor dialog box
(shown in Figure 5-27). Use the drop-down list of available data types
together with the insert or delete buttons to build your data type
definition. Then click on OK in the dialog box to complete the User
Data Type. (Refer to Section A.3 for more details on data types.)

Cancel

Data Type Definition:

OK

Insert Delete

User Data Types are defined by inserting
components from existing system data
types to create a new data type.

Available Data Types:

User Data Type Editor

}

{
BOOLEAN;

After inserting two or
more data types, you
can use the arrow
buttons to move a
selected data type up
or down in the list. Use “Insert” button

to add each
selected data type
to the definition.

BOOLEAN

System Data T ypes:

BOOLEAN
INTEGER16
INTEGER32
UNSIGNED8
UNSIGNED16
UNSIGNED32
FLOAT
OCTET STRING
BIT STRING

Figure 5-27 User Data Type Editor Dialog Box



Using the COM5434 Configurator5-36 SIMATIC 505 PROFIBUS-FMS CP User Manual

5.12 Creating FMS Variables

The FMS CP module supports up to 100 FMS variables.

Click on FMS Variables on the configuration tree to see the number of
variables available, as shown in Figure 5-28.

✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

Memory assignments to system and user variable data types

Module Local Configuration

FMS Connections
FDL Connections

Communication Jobs

FMS Jobs
Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

<no description>

Peerlink II Services

FMS Variables

Maximum FMS Variables:

FMS Variables Used:

FMS Variables Available:

100

0

100

Click here to select
FMS Variables.

Figure 5-28 FMS Variables Available

Maximum FMS Variables This field displays the total number of FMS
variables that are supported by the FMS CP module.

FMS Variables Used This field displays the number of FMS variables that
have been created.

FMS Variables Available This field displays the number of FMS variables
that can be constructed.

FMS Variables
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✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

Reference name of this variable Edit

Module Local Configuration

FMS Connections
FDL Connections

Communication Jobs

FMS Jobs

Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

Name:<no description>

100 - variable_1

PLC Memory:

Access Rights:

Access Groups:

RD=..a WR=..aClick the New Item
button, or, with FMS
Variables selected,
click the right
mouse button and
select New Item.

variable_1

0,1,2,3,4,5,6,7

Password: 0

Data Type: BOOLEAN

Variable Array: No

Data Type Length (bytes): 1

Array Elements: 0

Index number can be
used instead of name.

Info. Report Receiver?: Yes

Connection: fms_connection_1

Use Index?: No

Index: 100

Sub Index: 0

Figure 5-29 Defining FMS Variables

To define an FMS variable, follow the steps below:

1. Click on FMS Variables on the configuration tree.

2. Click on the New Item button on the toolbar. An FMS Variable appears
in the configuration tree and the input fields change (see Figure 5-29).

3. Fill in the following fields in the input pane:

Name Enter a unique name for each FMS variable. (If you have
selected Automatically Generate Names from the Options menu, the
COM5434 Configurator enters a name for the variable, but you can
change it if you want.) This name is added to the Object Dictionary
generated by the software.

Index This field displays the index number (from 15 to 65535) that is
automatically assigned to each FMS variable, but you can change it if
you want. This index number is added to the Object Dictionary
generated by the software.

Defining an FMS
Variable
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Creating FMS Variables (continued)

PLC Memory When you click on the PLC Memory field, a button
appears in the field. Click on the button to view the PLC Memory Type
Editor dialog box (shown in Figure 5-30). Select a PLC memory type
from the top drop-down menu, enter a PLC memory address in the
bottom field, and then select OK. The dialog box disappears, and the
PLC memory address is displayed in the PLC Memory field.

PLC Memory Type Editor

CancelOK

Select PLC Memory Type, and then enter address offset.

Enter a memory
type or select from
the drop-down list.

PLC Memory Types:

PLC Memory Address: 1

Figure 5-30 PLC Memory Editor Dialog Box

Access Rights When you click on this field, a button appears in the
field. Click on the button to view the Variable Access Rights dialog box
(shown in Figure 5-31). Click on the boxes to configure access privileges
for this variable, and then select OK. The dialog box disappears, and
the selected privileges are displayed in the Access Rights field. (Refer
also to Table A-9 for more information about access rights.)

Variable Access Rights

Cancel

OK

Access by Password:

Access by Groups:

Access by All:

Read

Write

Read

Write

Read

Write

Select access rights
for this variable.

Figure 5-31 FMS Variable Access Rights Dialog Box
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Access Groups When you click on the Access Groups field, a button
appears in the field. Click on the button to view the Variable Access
Groups dialog box (shown in Figure 5-32). Define which groups can
have access to the variable by clicking on the group boxes, and then
select OK. The dialog box disappears, and the selected groups are
displayed in the Access Groups field. (Refer to Section 4.3 for more
information about access groups.)

Variable Access Groups

CancelOK

Select all groups that will have access to this variable.

Group #0

Group #1

Group #2

Group #3 Group #7

Group #6

Group #5

Group #4
Note:  Access groups, if any are
disabled (deselected), allow
access only by remote partners
which have been assigned to
the matching groups.

Figure 5-32 FMS Variable Access Groups Dialog Box

Password Enter a numeric value as the password required to access
the FMS variable. This password, if used, limits access to a remote
partner specifying the same password. (Refer to Section 4.3 for more
information about passwords.)

Data Type Select a data type for the variable from the drop-down
menu. (FMS data types that you create appear in the list along with
the standard FMS data types.) Refer to Section A.3 for more details on
data types.

Data Type Length (bytes) The length of the FMS variable you create is
automatically entered into this field by the COM5434 Configurator. If
the data type is a string type (octet or bit), enter a value here.

Variable Array Select whether the data type is an array of the selected
type or a simple data type by selecting Yes or No.

Array Elements If the data type is an array, this field shows the
number of elements contained in the array.

Info. Report Receiver? Select Yes to specify that the variable can be
used to receive Information Reports.

Connection Specify which connection is allowed to send Information
Reports to this variable.
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Creating FMS Variables (continued)

Use Index? Select Yes to specify that the Information Report is to be
stored as an index, or select No to store it by name.

Sub Index You can specify an element number if the variable is an
array or a structure (if the structure is not an array). For example, if
your variable consists of an array of 10 elements of data type
INTEGER16, a subindex value of 4 specifies the fourth 16-bit integer in
the variable array.
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5.13 Saving and Downloading the Configuration

You can save your configuration to a file before you download the file to the
FMS CP module. To save a configuration, follow these steps:

1. To ensure that all configuration parameters are valid before saving,
select the menu command Transfer → Validate Configuration Now or
click on the Validate button: 

Correct any invalid parameters as described by each error message.

2. Select the menu command File → Save As... or click on the Save
button: 

3. Use the drop-down list box at the top of the Save As dialog to select a
directory to store the saved file.

4. Enter a file name, as shown in Figure 5-33.

5. Click on Save.

Save As

Cancel

Save

Save as type:

File name:

Save in:

COM5434 Configuration Files (*.fms)

File_A.fms

Name Size Type Modified

Configsw

File_ABC.fms 41KB COM5434 Configuration File 9/15/97 11:28 AM

Enter name here.

Testfile1.fms 127KB COM5434 Configuration File 10/31/97 11:59 PM

Click here for
file details.

Figure 5-33 Saving Your Configuration to a File

NOTE:  Be sure to save your configuration for each module in a safe place,
according to your company’s requirements. In case a module ever fails, you
will need your archived configuration file to configure the replacement
module exactly as the original module.

Validating
and Saving the
Configuration to
a File
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Saving and Downloading the Configuration (continued)

It is always a good practice to produce and archive accurate documentation
for each configuration. A printed record of your configuration is one way to
do this. To print the complete configuration or selected parts of it, follow
these steps:

1. Validate and save the configuration, as described on page 5-41.

2. Select the menu command File → Print... or click on the button.

3. The Print dialog allows you to select all (the default) or part of the
configuration for printing. Select the sections you want to print.

4. Click on OK.

After validating and saving your configuration file, you can download it to
the FMS CP module.

! WARNING
Downloading  a configuration to an FMS CP module on line in a network will
cause interruption of network communications with that module only . If the
download is successful, network communications will resume after the module
returns to RUN mode.

Any interruption to network communications could cause unpredictable
machine or process operation, possibly resulting in death or serious injury to
personnel, and/or damage to equipment.

To avoid problems resulting from interruption of network communications,
design your installation to tolerate interruptions in network communications,
and/or stop your process in a safe state before you download configurations to
any network FMS CP module.

! WARNING
If you download new Module Local Configuration parameters (such as station
address and network baud rate) to a module in an active network, and the new
parameters are not compatible with the network configuration already in use,
the download operation may be unsuccessful and could cause a disruption in
the network communications.

Disrupting network communications could cause unpredictable machine or
process operation, possibly resulting in death or serious injury to personnel,
and/or damage to equipment.

To avoid a download failure and a disruption in network communications, stop
your process in a safe state and disconnect the PROFIBUS cable from the
FMS CP module before downloading new module configuration parameters.
Reconnect the module to the network and ensure proper network operation
before reactivating your process.

Printing the
Configuration

Downloading the
Configuration to
the FMS CP Module
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To download a configuration to the FMS CP module, follow these steps:

1. Make sure that the programming cable is connected between the serial
port on your PC and the RS-232 port on the FMS CP module, and that
the baud rate setting in the software matches the jumper-selected baud
rate on the module, (see Section 2.2 and Figure 5-3).

2. Select the menu command Transfer → Download to the CP5434, or
click on the Download button: 

3. If the module is currently configured, select Yes on the information
message to overwrite the existing configuration with the new one.

4. Click on OK.
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6.1 Overview

This chapter describes how to define connections and jobs for the FMS CP
module using the COM5434 Configurator. Several configuration examples
are provided. The configuration examples are based on the example network
shown in Figure 6-1.

545
CPU

FMS
 CP

FMS
 CP

Station 1

Station 2

Station 3

Station 4Station 5

575
CPU

RBC

545
CPU

FMS
 CP

P/S

P/S P/S

P/S

PC with
CP5412 card

Station 6

S7-400

S7-400

CP

CP

PC with COM5434
software

Figure 6-1 Example Network
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Figure 6-2 shows the configuration tasks you must complete to configure the
FMS CP module using the COM5434 Configurator.

Configure the local FMS CP module using the COM5434 Configurator.

Create and name the configuration file.

Define the Module Local Configuration.

Define an FDL
connection.

Configure an
FMS job.

Define an FMS
connection.

Configure a Send
or Receive job.

Save and download
the configuration file.

Save and download
the configuration file.

Configure the remote
(FDL) device using its
programming tool, or...

Configure the remote  FMS CP module
using the COM5434 Configurator.

Create and name the configuration file.

Define the Module Local Configuration.

Define an FMS
connection.

Configure the remote  FMS CP module
using the COM5434 Configurator.

Create and name the configuration file.

Define the Module Local Configuration.

Define an FDL
connection.

Save and download
the configuration file.

Define a Peerlink II
Service.

Configure a Receive
or Send Job.

Save and download
the configuration file.

Save and download
the configuration file.

Configure variable
and data type.

...if the remote device is using an FMS CP module, then...

...if the remote device is using an FMS CP module, then...

Figure 6-2 Configuration Tasks
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6.2 Example of an FMS Read Job

Figure 6-3 shows the flow of data during an FMS Read job configured
between Station 1 (FMS CP) and Station 2 (FMS CP) on the example
network. Station 1 is the client and initiates the request for data.  Station 2
is the server, responding to the request with a transfer of data from the
FMS variable specified by Station 1.

Station 2
Read (FMS variable)

Read response (data)

Data Flow

Station 1

F
M

S
 C

P

F
M

S
 C

P

Data to memory Data from memory

Data Flow

C
P

U

C
P

U

Figure 6-3 Data Flow for FMS Read Example

Using the COM5434 Configurator, configure the FMS Read job between
Station 1 and Station 2 by completing the following tasks:

Create and name the configuration file for Station 1.

Define the Module Local Configuration for Station 1.

Define an FMS connection for Station 1.

Configure an FMS Read job for Station 1.

Save and download the configuration file to the FMS CP module at
Station 1.

THEN...

Create and name the configuration file for Station 2.

Define the Module Local Configuration for Station 2.

Define an FMS connection for Station 2 using the same addressing as
the connection created for Station 1.

Define an FMS variable.

Save and download the configuration file to the FMS CP module at
Station 2.

These tasks are described in detail on the following pages.

Configuration Tasks
for an FMS Read
Job



 
Configuration Examples 6-5SIMATIC 505 PROFIBUS-FMS CP User Manual

The first step in the process is to create the configuration file. Click on the
top icon of the configuration tree, which says <no description>. Then enter a
description for this file in the Description field, as shown below and in
Figure 6-4.

Description: File_A

✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

Current configuration file specification

Module Local Configuration

FMS Connections
FDL Connections

Communication Jobs

FMS Jobs
Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

Description:

File Name:

Directory:

UNTITLED

Click here.

Modified?: NO

File_AFile_A

Enter description
here.

Edit

Last Saved File:

Last Saved Directory:

Figure 6-4 Creating a Configuration File

Creating the
Configuration File
for Station 1
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Example of an FMS Read Job (continued)

Next, you must define the Module Local Configuration of the FMS CP
module for Station 1.

1. Click on the Module Local Configuration icon.

2. Complete the fields listed below (and shown in Figure 6-5) to define the
Module Local Configuration:

Local Station Address: 1

Highest Station Address: 15

Bus Parameter Profile: FMS-DP Universal

Baud Rate: 1.5 MBaud

# of Masters (holds token): 6

# of Slaves (no token): 0

✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

This module’s FMS PROFIBUS communication parameters

FMS Connections
FDL Connections

Communication Jobs

FMS Jobs
Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

File_A

Module Local Configuration
Local Station Address:

Slot Time (Tslot):

Max. Sta. Delay (Max_Tsdr):

3000

980

1

Highest Station Address: 15

Bus Parameter Profile: FMS-DP Universal

Baud Rate: 1.5 MBaud

# of Masters (holds token): 6

# of Slaves (no token): 0

Min. Sta. Delay (Min_Tsdr):

Setup Time (Tset):

150

240

Quiet Time (Tqui):

Gap Factor:

0

50

Retry Limit:

Token Rotation (Ttr):

1

45000

Click here.

Enter parameters
here.

Edit

Figure 6-5 Module Local Configuration Example

Defining the
Module Local
Configuration for
Station 1
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Continue configuring the FMS Read job by defining the FMS connection for
the FMS CP module at Station 1.

1. Click on the FMS Connections icon of the configuration tree.

2. Click on the New Item button on the toolbar.

3. Complete the fields listed below (and shown in Figure 6-6) to define the
FMS connection for Station 1:

Name: pumpconnect

Local LSAP: 3

Remote Station Address: 2

Remote LSAP: 5

Leave the remaining fields at their default values.

✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

Links to other Fieldbus Message Specification (FMS) devices.

Click the
New Item
button.

Module Local Configuration

FMS Connections

FDL Connections

Communication Jobs

FMS Jobs
Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

File_A

FMS
pumpconnect

Name:

Local LSAP:

Data Transfer Type:

Remote Station Address:

3

Master-Master, acyclic

Remote LSAP:

Max PDU Size TX high: 0

5

Max PDU Size TX low:

Max PDU Size RX high:

Max PDU Size RX low: 241

0

Max Cnfmd. Svc. To:

Max Cnfmd. Svc. From:

Max UnCnfmd. Svc. To:

1

1

Max UnCnfmd. Svc. From:

Control Interval: 3000

0

Multiplier:

2

241

0

1

Password: 0

Access Groups: 0,1,2,3,4,5,6,7

pumpconnect

Enter parameters in the first
four fields; leave the additional
fields at their default values.

Services Supported: Requester= rw, Respond

Edit

Figure 6-6 Defining an FMS Connection Example

Defining an FMS
Connection for
Station 1
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Example of an FMS Read Job (continued)

Once you have defined the Module Local Configuration and the FMS
connection, you can configure the FMS Read job for Station 1.

1. Click on the FMS Jobs icon on the configuration tree.

2. Click on the New Item button on the toolbar.

3. Complete the fields listed below (and shown in Figure 6-7) to configure
the FMS Read job.

Job Name: pump_1

Start Bit: WY5.2

Job Type: Read

Connection: pumpconnect

Status Word V: 1

Local Address: V100,10

Variable Name or <Index>: <100>

✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

Reference name given to this job (must be unique) Edit

Module Local Configuration

FMS Connections
FDL Connections

Communication Jobs

FMS Jobs

Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

Job Name:File_A

pump_1

Start Bit:

Job Type:

Connection:

WY5.2

Read

FMS

pump_1

pumpconnect

Status Word V: 1

Local Address: V100, 10

Variable Name or <Index>: <100>

Click the
New Item
button.

With the cursor in the Local Address field,
click the button that appears on the right to
access the memory address editor dialog.Enter parameters

here.

...

Figure 6-7 FMS Read Job Example

Configuring the
FMS Read Job for
Station 1
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Save your file to disk before attempting to transfer the file to the FMS CP
module. Follow these steps:

1. Select the menu command File → Save As... or click on the Save
button: 

2. Select a directory to store the saved file.

3. Enter a file name, as shown in Figure 6-8.

4. Click on Save.

Save As

Cancel

Save

Save as type:

File name:

Save in:

COM5434 Configuration Files (*.fms)

File_A.fms

Name Size Type Modified

Configsw

File_ABC.fms 41KB COM5434 Configuration File 9/15/97 11:28 AM

Enter name here.

Testfile1.fms 127KB COM5434 Configuration File 10/31/97 11:59 PM

Click here for
file details.

Figure 6-8 Save As Dialog

After saving your configuration file, download it to the FMS CP module at
Station 1 by following these steps:

1. Select the menu command Transfer → Download to the CP5434, or
click on the Download button: 

2. Click on OK.

Saving the
Configuration File
to Disk

Transferring the
Configuration to
the FMS CP Module
at Station 1
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Example of an FMS Read Job (continued)

After you configure the FMS Read job for Station 1, you need to create a
configuration file for Station 2 by following these steps:

1. Select the menu command File → New to create an empty
configuration file.

2. Enter a description for this file in the Description field, as shown below:

Description: File_AB

Next, you must define the Module Local Configuration of the FMS CP
module at Station 2.

1. Click on the Module Local Configuration icon.

2. Complete the fields listed below to define the Module Local
Configuration for Station 2.

Local Station Address: 2

Highest Station Address: 15

Bus Parameter Profile: FMS-DP Universal

Baud Rate: 1.5 MBaud

# of Masters (holds token): 6

# of Slaves (no token): 0

Continue configuring the FMS Read job by defining the FMS connection for
the FMS CP module at Station 2.

1. Click on the FMS Connections icon of the configuration tree.

2. Click on the New Item button on the toolbar.

3. Complete the fields listed below to define the FMS connection for
Station 2:

Name: Pump

Local LSAP: 5

Remote Station Address: 1

Remote LSAP: 3

Leave the remaining fields at their default values.

Creating the
Configuration File
for Station 2

Setting the Module
Local
Configuration for
Station 2

Defining an FMS
Connection for
Station 2
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Continue configuring the FMS Read job by defining an FMS variable for the
FMS CP module at Station 2.

1. Click on the FMS Variables icon of the configuration tree.

2. Click on the New Item button on the toolbar.

3. Complete the fields listed below (and shown in Figure 6-9) to define the
FMS variable for Station 2:

Name: PumpControl

PLC Memory: V200

Data Type: UNSIGNED16

Variable Array: Yes

Array Elements: 10

Leave the remaining fields at their default values.

✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

Reference name of this variable Edit

Module Local Configuration

FMS Connections
FDL Connections

Communication Jobs

FMS Jobs

Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

Name:File_AB

100 - PumpControl

PLC Memory:

Access Rights:

Access Groups:

V200

RD=..a WR=..a

Click the New Item
button, or, with FMS
Variables selected,
click the right
mouse button and
select New Item.

PumpControl

0,1,2,3,4,5,6,7

Password: 0

Data Type: UNSIGNED16

Variable Array: Yes

Data Type Length (bytes): 2

Array Elements: 10

Index number is assigned
automatically by the software.

Info. Report Receiver?: No

Connection: Pump

Use Index?: No

0Sub Index:

Figure 6-9 Defining an FMS Variable

Defining an FMS
Variable for
Station 2
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Example of an FMS Read Job (continued)

Save your file to disk before attempting to transfer the file to the FMS CP
module. Follow these steps:

1. Select the menu command File → Save As... or click on the Save
button: 

2. Select a directory to store the saved file.

3. Enter a file name.

4. Click on Save.

After saving your configuration file, download it to the FMS CP module at
Station 2 by following these steps:

1. Disconnect the programming cable from the FMS CP module at
Station 1, and reconnect the cable to the RS-232 port on the FMS CP
module at Station 2.

2. Select the menu command Transfer → Download to the CP5434, or
click on the Download button: 

3. Click on OK.

The Relay Ladder Logic example in Figure 6-10 demonstrates a typical
scenario for using the FMS Read service of the FMS CP module. This
section assumes that you are familiar with Series 505 programmable logic
controller language.

NOTE:  If the Read job is to be executed only one time, you must take
appropriate action to disable Xn after the data transfer has been made.

NOTE:  This relay ladder logic assumes good transactions, and does not
contain status word checking. Error recovery must be implemented in
ladder logic appropriate to your application. The WX and WY locations used
in this RLL example correspond to module I/O addresses that have been
configured in programmable logic controller memory using the Configure
I/O function in TISOFT.

Saving the
Configuration File
to Disk

Transferring the
Configuration to
the FMS CP Module
at Station 2

Example RLL Code
for FMS Read Job
at Station 1
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C99

BITP1

A: WX1
N=2

C99 C100

C99

BITP1 And BITP2 verify that no previous jobs are in progress prior to
setting the Read Job Start Bit.

C21
BITP2

A: WY5
N=2

BITC1

A: WY5
N=2

C22

BITS1

A: WY5
N=2

C23

C100 C21

After the Read Job Start Bit is set, BITP1 and BITP2 verify that the
Read Job is active prior to resetting the Job Start Bit in BITP1.

Communication Reset: clears the Read Job Start Bit, as
defined by bit 2 of word output WY5.

C21C100 Beginning Communication Rung: Sets the Read Job Start Bit,
as defined by bit 2 of word output WY5.

END

C25

C100C25

C24

C21 C24

C23

Enable TMR1 with BITS1 and hold with BITP2 until the
FMS CP sets WX Job Active Bit or TMR1 expires.

TMR1 and BITC2 act as a WY Start Bit reset
in cases where the FMS CP powers up with
WY Start Bit high (see note on page 4-5).

A: WY5
N=2

BITC2

Xn

Enabling Rung (user logic)

TMR1

P= 30.0

Figure 6-10 FMS Read Job Relay Ladder Logic for Station 1
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6.3 Example of a Send-Receive Job

Figure 6-11 shows the flow of data during Send-Receive jobs configured
between Station 1 (FMS CP) and Station 5 (FMS CP) on the example
network. Station 1 sends the data.  Station 5 receives the data from
Station 1.

Station 1 Station 5

Data from memory

Send (data only)

Acknowledge

Job: Receive

Data to memory

Data Flow

Note:  Both programmable logic controllers must have RLL code to allow data to be transferred.

F
M

S
 C

P

F
M

S
 C

P
C

P
U

C
P

U

Figure 6-11 Send-Receive Job Data Flow Example

Using the COM5434 Configurator, configure the Send and Receive jobs
between Station 1 and Station 5 by completing the following tasks:

Create and name the configuration file for Station 1.

Define the Module Local Configuration for Station 1.

Define an FDL connection for Station 1.

Configure the Send job for Station 1.

Save and download the configuration file to the FMS CP module at
Station 1.

THEN...

Create and name the configuration file for Station 5.

Define the Module Local Configuration for Station 5.

Define an FDL connection for Station 5 using the same addressing as
the connection created for Station 1.

Configure the Receive job for Station 5.

Save and download the configuration file to the FMS CP module at
Station 5.

These tasks are described in detail on the following pages.

Configuration Tasks
for a Send-Receive
Job
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The first step in the process is to create the configuration file.

1. Select the menu command File → New to create an empty
configuration file.

2. Enter a description for this file in the Description field, as shown below
(and in Figure 6-12):

Description: File_B

✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

Current configuration file specification

Module Local Configuration

FMS Connections
FDL Connections

Communication Jobs

FMS Jobs
Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

Description:

File Name:

Directory:

UNTITLED

Click here.

Modified?: NO

File_BFile_B

Enter description
here.

Edit

Last Saved File:

Last Saved Directory:

Figure 6-12 Creating a Configuration File

Creating the
Configuration File
for Station 1
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Example of a Send-Receive Job (continued)

Next, you must define the Module Local Configuration of the FMS CP
module for Station 1.

1. Click on the Module Local Configuration icon.

2. Complete the fields listed below (and shown in Figure 6-13) to define
the Module Local Configuration:

Local Station Address: 1

Highest Station Address: 15

Bus Parameter Profile: FMS-DP Universal

Baud Rate: 1.5 MBaud

# of Masters (holds token): 6

# of Slaves (no token): 0

✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

This module’s FMS PROFIBUS communication parameters

FMS Connections
FDL Connections

Communication Jobs

FMS Jobs
Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

File_A

Module Local Configuration
Local Station Address:

Slot Time (Tslot):

Max. Sta. Delay (Max_Tsdr):

3000

980

1

Highest Station Address: 15

Bus Parameter Profile: FMS-DP Universal

Baud Rate: 1.5 MBaud

# of Masters (holds token): 6

# of Slaves (no token): 0

Min. Sta. Delay (Min_Tsdr):

Setup Time (Tset):

150

240

Quiet Time (Tqui):

Gap Factor:

0

50

Retry Limit:

Token Rotation (Ttr):

1

45000

Click here.

Enter parameters
here.

Edit

Figure 6-13 Module Local Configuration Example

Setting the Module
Local
Configuration for
Station 1
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Continue configuring the Send job for Station 1 by defining the FDL
connection for the FMS CP module at Station 1.

1. Click on the FDL Connections icon of the configuration tree.

2. Click on the New Item button on the toolbar.

3. Complete the fields listed below (and shown in Figure 6-14) to define
the FDL connection for Station 1.

Name: Motor

Remote Station Address: 5

Local LSAP: 4

Remote LSAP: 5

✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

Links to other Fieldbus Data Link (FDL) devices

Click the
New Item
button.

Module Local Configuration

Communication Jobs

FMS Jobs
Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

File_B

FMS Connections
FDL Connections
S-R Motor

Name:

Local LSAP:

Remote Station Address: 5

Remote LSAP: 5

4

Motor

Edit

Enter parameters
here.

Figure 6-14 FDL Connection for Station 1

Defining an FDL
Connection for
Station 1
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Example of a Send-Receive Job (continued)

Once you have defined the Module Local Configuration and the FDL
connection, you can configure a Send job for Station 1.

1. Click on the Send-Receive Jobs icon of the configuration tree.

2. Click on the New Item button on the toolbar.

3. Complete the fields listed below (and shown in Figure 6-15) to
configure the Send job for Station 1.

Job Name: Motorsend

Start Bit: WY5.3

Job Type: Send

FDL Connection: Motor

Status Word V: 6

Local Address #1: V101,2

✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

Reference name given to this job (must be unique) Edit

Module Local Configuration

FMS Connections
FDL Connections

Communication Jobs

FMS Jobs

Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

Job Name:File_B

Motorsend

Start Bit:

Job Type:

FDL Connection:

WY5.3

Send

Click the New Item
button, or, with
Send-Receive Jobs
selected, click the
right mouse button
and select New Item.

Motorsend

Motor

Status Word V: 6

Local Address #1: V101, 2

Local Address #2:

S-R

Local Address #3:

Local Address #4:

Local Address #5:

Local Address #6:

Local Address #7:

Local Address #8:

Enter parameters
here.

Figure 6-15 Send Job for Station 1

Configuring the
Send Job for
Station 1
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You should save your file to disk before attempting to transfer the file to the
FMS CP module. To save the file to disk, follow these steps:

1. Select the menu command File → Save As... or click on the Save
button: 

2. Select a directory to store the saved file.

3. Enter a file name.

4. Click on Save.

After saving your configuration file, download it to the FMS CP module at
Station 1 by following these steps:

1. Select the menu command Transfer → Download to the CP5434, or
click on the Download button: 

2. Click on OK.

Saving the
Configuration File
to Disk

Transferring the
Configuration to
the FMS CP Module
at Station 1
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Example of a Send-Receive Job (continued)

After you create a Send job for Station 1, you need to create a configuration
file for Station 5.

1. Select the menu command File → New to create an empty
configuration file.

2. Enter a description for this file in the Description field as shown below:

Description: File_BA

Next, you must define the Module Local Configuration of the FMS CP
module at Station 5.

1. Click on the Module Local Configuration icon.

2. Complete the fields listed below to define the Module Local
Configuration for Station 5:

Local Station Address: 5

Highest Station Address: 15

Bus Parameter Profile: FMS-DP Universal

Baud Rate: 1.5 MBaud

# of Masters (holds token): 6

# of Slaves (no token): 0

Continue configuring the Receive job for Station 5 by defining the FDL
connection for the FMS CP module at Station 5.

1. Click on the FDL Connections icon of the configuration tree.

2. Click on the New Item button on the toolbar.

3. Complete the fields listed below to define the FDL connection for
Station 5:

Name: Motor

Remote Station Address: 1

Local LSAP: 5

Remote LSAP: 4

Creating the
Configuration File
for Station 5

Setting the Module
Local
Configuration for
Station 5

Defining an FDL
Connection for
Station 5
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Once you have defined the Module Local Configuration and the FDL
connection, you can configure a Receive job for Station 5.

1. Click on the Send-Receive Jobs icon of the configuration tree.

2. Click on the New Item button on the toolbar.

3. Complete the fields listed below to configure the Receive job for
Station 5:

Job Name: Motorrec

Start Bit: WY7.3

Job Type: Receive

Connection: Motor

Status Word V: 5

Local Address #1: V101,2

You should save your file to disk before attempting to transfer the file to the
FMS CP module. To save the file to disk, follow these steps:

1. Select the menu command File → Save As... or click on the Save
button: 

2. Select a directory to store the saved file.

3. Enter a file name.

4. Click on Save.

After saving your configuration file, download it to the FMS CP module at
Station 5 by following these steps:

1. Disconnect the programming cable from the FMS CP module at
Station 1, and reconnect the cable to the RS-232 port on the FMS CP
module at Station 5.

2. Select the menu command Transfer → Download to the CP5434, or
click on the Download button: 

3. Click on OK.

Configuring the
Receive Job for
Station 5

Saving the
Configuration File
to Disk

Transferring the
Configuration to
the FMS CP Module
at Station 5
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Example of a Send-Receive Job (continued)

After you successfully load the configuration files to both programmable
logic controller stations, you must add RLL coding to the RLL programs of
both programmable logic controllers to activate the transfer of data. Refer to
Figure 6-16 for an example of RLL code to activate the Send request and to
Figure 6-17 for an example of RLL code to activate the Receive request.

The Relay Ladder Logic example in Figure 6-16 demonstrates a typical
scenario for enabling a Send request. This section assumes that you are
familiar with Series 505 programmable logic controller language. The WX
and WY locations used in this RLL example correspond to module I/O
addresses that have been configured in programmable logic controller
memory using the Configure I/O function in TISOFT.

The logic shown in Figure 6-16 performs as described in Table 6-1:

Table 6-1 Description of Send Logic

C98 Enables condition logic, defined by the application (Xn), which
must remain active until job completion.

MOVW1 Sets status word V300 to a positive value (1) prior to each
transaction. This positive value is used for job completion check in
CMP1.

BITP3/BITP4 Ensures that no pending jobs exist prior to starting a Send job.
(defined for Bit 1 of FMS CP module, located at I/O address WY5).

BITC3 Clears the FMS CP job defined for Bit 3 of the FMS CP module
located at WY5 after the Job Active bit WX1 is set.

BITS2 Sets the Start Bit defined for Bit 3 of the FMS CP module located
at WY5 to invoke a data transfer function.

CMP1 Tests the completion status of the data transfer by the same FMS
CP, placed in V300, against a zero constant stored at location V15.
When the Send job has completed, the value of status word V300
is zero—good transaction—or a non-zero value—bad transaction
(see Table B-1 and Table B-4). You must take appropriate action
in the USER ERROR CONTROL LOGIC ladder rung at this time.
If the job is to be executed only one time, you must take action to
disable Xn after the Status word changes value from its preset
condition.

C41/C43 The parallel net of C41 and C43 act together to start and hold
TMR2 on until either the FMS CP recognizes that the Job Start
bit WY5.3 has been set and responds by setting the Job Active bit
WX1.3 or else TMR2 time expires.

TMR2
BITC4

TMR2 and BITC4 are used to clear an unrecognized Job Start bit
WY5.3. Either a reset of the FMS CP or a power cycle of the
entire base may cause the programmable logic controller ladder to
set a WY Job Start bit prior to FMS CP recovery. When this
condition occurs, the FMS CP module does not execute the job
(see note on page 4-5).

Example RLL Code
for Send Job at
Station 1
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C98Xn

MOVW1

A: 1
B:V300
N=1

Enabling Rung (User Logic)

C43 C30

C98
A: WY5
N=1

C101BITP3

A: WX1
N=3

BITP4

A: WY5
N=3

C41

C35

C98

C27C28

C101 C41C98

BITC3

A: WY5
N=3

C42C101 C41

BITS2
A: WY5
N=3

C43C101 C41 C30

CMP1

A: V15
B:V300

LT:C26
GT:C27

C98 C28C27

C26

Communication Interlock

Communication Reset

Beginning Communication Rung

Communication Complete

User Error Control Logic

Existing Job Active Check

Existing Job Active Check

END

TMR2

P= 30.0

C29

C101C29

BITC4

A: WY5
N=3

C44

C41 C44

C43

Enable TMR2 with BITS2 and hold with BITP4 until the
FMS CP sets WX Job Active Bit or TMR2 expires.

TMR2 and BITC4 act as a WY Start Bit reset in cases where the
FMS CP powers up with WY Start Bit high (see note on page 4-5).

Figure 6-16 Send Relay Ladder Logic for Station 1



Configuration Examples6-24 SIMATIC 505 PROFIBUS-FMS CP User Manual

Example of a Send-Receive Job (continued)

The Relay Ladder Logic example in Figure 6-17 demonstrates a typical
scenario for enabling a Receive acknowledgement. This section assumes
that you are familiar with Series 505 programmable logic controller
language. The WX and WY locations used in this RLL example correspond
to module I/O addresses that have been configured in programmable logic
controller memory using the Configure I/O function.

The logic shown in Figure 6-17 performs as described in Table 6-2:

Table 6-2 Description of Receive Logic

C49 Enables condition logic, defined by the application (Xn), which
must remain active until job completion.

MOVW1 Sets status word V302 to a positive value (1) prior to each
transaction. This positive value is used for job completion check in
CMP1.

BITP1/BITP2 Ensures that no pending jobs exist prior to starting a Receive job
defined for Bit 3 of FMS CP module, located at I/O address WY7.

BITC1 Clears the job defined for Bit 3 of the FMS CP module located at
WY7 after the Job Active bit WX3 is set.

BITS1 Sets the Job Start Bit defined for Bit 3 of the FMS CP module
located at WY7 to invoke a data transfer function.

CMP1 Tests the completion status of the data transfer by the same FMS
CP module, placed in V302, against a zero constant stored at
location V25. When the Peer job has completed, the value of
status word V302 is zero—good transaction—or a non-zero
value—the corresponding SEND job has not executed or some
other error has occurred (see Table B-1 and Table B-4). You must
take appropriate action in the USER ERROR CONTROL LOGIC
ladder rung at this time. If the job is to be executed only one time,
you take must take action to disable Xn after the Status word
changes value from its preset condition.

C31/C33 The parallel net of C31 and C33 act together to start and hold
TMR1 on until either the FMS CP recognizes that the Job Start
bit WY7.3 has been set and responds by setting the Job Active bit
WX3.3 or else TMR1 time expires.

TMR1
BITC2

TMR1 and BITC2 are used to clear an unrecognized Job Start bit
WY7.3. Either a reset of the CP or a power cycle of the entire
base may cause the programmable logic controller ladder to set a
WY Job Start bit prior to FMS CP recovery. When this condition
occurs, the FMS CP module does not execute the job (see the note
on page 4-5).

Example RLL Code
for Receive Job at
Station 5
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C49

MOVW1

A: 1
B:V302
N=3

C33 C40

C49 C50BITP1

A: WX3
N=3

BITP2

A: WY7
N=3

C31

C45

C49

C37C38

C50 C31C49

BITC1

A: WY7
N=3

C32C50 C31

BITS1

A: WY7
N=3

C33C50 C31 C40

CMP1

A: V25
B:V302

LT:C36
GT:C37

C49 C38C37

C36

Communication Interlock

Communication Reset

Beginning Communication Rung

Communication Complete

User Error Control Logic

Xn
Enabling Rung (User Logic)

Existing Job Active Check

Existing Job Active Check

END

TMR1

P= 30.0

C46

C50C46

BITC2

A: WY7
N=3

C34

C31 C34

C33

Enable TMR1 with BITS1 and hold with BITP2 until the
FMS CP sets WX Job Active Bit or TRM1 expires.

TMR1 and BITC2 act as a WY Start Bit reset in cases where the
FMS CP powers up with WY Start Bit high (see note on page 4-5).

Figure 6-17 Receive Relay Ladder Logic for Station 5
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Example of a Send-Receive Job (continued)

Figure 6-18 shows the sequence of events for a successful FDL transaction.

WY5.3
t0 t2

WX1.3
t1 t3

t4

SEND

RECEIVE

t6

t5
WX3.3

t8

WY7.3

t7

Figure 6-18 Successful Timing Example

The list below explains the sequence of events.

t0 Send Job RLL requests that data transfer be invoked.

t1 Send Job Active bit is set by the FMS CP. Data transfer begins.

t2 Send Job Start Bit is reset to inactive by Send job RLL in response to
Job Active bit going high.

t3 Send job completes the data transfer. Send job resets Job Active bit.
Send job is complete.

t4 Receive job RLL requests that received data be processed and stored.

t5 Receive Job Active bit is set by the FMS CP module. FMS CP begins
storage of received data.

t6 Receive Job Start Bit is reset to inactive by Receive job RLL in response
to Job Active bit going high.

t7 Receive job has stored received data in programmable logic controller
memory. Receive job resets Job Active bit. Receive job is complete and
stores job status of 0 (successful transaction).

t8 Send job re-enables the data transfer for another data transfer if
required.

Successful Timing
Example
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Figure 6-19 shows the sequence of events for an unsuccessful FDL
transaction.

WY5.3

WX1.3

t2 t4

SEND

RECEIVE

WY7.3

t3
WX3.3

t1t0

t5

a

Figure 6-19 Unsuccessful Timing Example

The list below explains the sequence of events.

t0 Send job RLL requests that a data transfer be invoked.

t1 Programmable logic controller sets WY5.3 low before seeing WX1.3 go
high. (RLL code prematurely resets WY5.3 to zero.)

a WX1.3 never goes high; that is, the job never starts and no data is sent.

t2 Receive job RLL requests that received data be processed and stored.

t3 Receive Job Active bit is set active by the FMS CP. However, no data
was sent.

t4 Receive job Start Bit is reset to inactive by Receive job RLL in response
to FMS CP Job Active bit.

t5 Receive job has completed but no data was received. Receive job resets
Job Active bit and stores job status E0E0 instead of 0.

Unsuccessful
Timing Example
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6.4 Example of a Peerlink II Transmit and Receive Service

Figure 6-20 shows Transmit and Receive services between two stations.
Using the COM5434 Configurator, configure these Peerlink II Services by
completing the following tasks:

Create and name the configuration file for Station 1.

Define the Module Local Configuration for Station 1.

Set the peer transmit interval and peer priority factor.

Configure a Transmit service.

Configure a Receive service.

Save and download the configuration file to the FMS CP module at
Station 1.

Repeat the steps above for Station 5.

Station 5
Transmit (blue box count)

Receive (red box count)

Station 1

F
M

S
 C

P

F
M

S
 C

PData from memory Data to memory

C
P

U

C
P

U

Data to memory Data from memory

Station 5

Receive (blue box count)

Transmit (red box count)
Station 1

F
M

S
 C

P

F
M

S
 C

PData to memory Data from memory
C

P
U

C
P

U

Data from memory Data to memory

Red Box PLCBlue Box PLC

Figure 6-20 Peerlink Data Block Transfer Services

These tasks are described in detail on the following pages.

Configuration Tasks
for a Peerlink II
Service
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The first step in the process is to create the configuration file for Station 1.

1. Select the menu command File → New to create an empty
configuration file.

2. Enter a description for this file in the Description field, as shown below
(and in Figure 6-21):

Description: Blue Box CPU

✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

Current configuration file specification

Module Local Configuration

FMS Connections
FDL Connections

Communication Jobs

FMS Jobs
Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

Description:

File Name:

Directory:

UNTITLED

Modified?: NO

Blue Box CPUBlue Box CPU

Enter description
here.

Edit

Last Saved File:

Last Saved Directory:

Figure 6-21 Creating a Configuration File Example

Creating the
Configuration File
for Station 1
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Example of a Peerlink II Transmit and Receive Service (continued)

Next, you must define the Module Local Configuration of the FMS CP
module for Station 1.

1. Click on the Module Local Configuration icon.

2. Complete the fields listed below (and shown in Figure 6-22) to define
the Module Local Configuration:

Local Station Address: 1

Highest Station Address: 15

Bus Parameter Profile: FMS-DP Universal

Baud Rate: 1.5 MBaud

# of Masters (holds token): 6

# of Slaves (no token): 0

✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

This module’s FMS PROFIBUS communication parameters

FMS Connections
FDL Connections

Communication Jobs

FMS Jobs
Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

Blue Box CPU

Module Local Configuration
Local Station Address:

Slot Time (Tslot):

Max. Sta. Delay (Max_Tsdr):

3000

980

1

Highest Station Address: 15

Bus Parameter Profile: FMS-DP Universal

Baud Rate: 1.5 MBaud

# of Masters (holds token): 6

# of Slaves (no token): 0

Min. Sta. Delay (Min_Tsdr):

Setup Time (Tset):

150

240

Quiet Time (Tqui):

Gap Factor:

0

50

Retry Limit:

Token Rotation (Ttr):

1

45000

Click here.

Enter parameters
here.

Edit

Figure 6-22 Module Local Configuration Example

Setting the Module
Local
Configuration for
Station 1
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Once you have defined the Module Local Configuration, you can configure
the peer transmit interval and priority factor, (as shown in Figure 6-23).

1. Click on the Peerlink II Services icon of the configuration tree.

2. Enter the parameters listed below:

Peer Transmit Interval: 10

Peer Priority Factor: 8
✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

Configured cyclic data blocks sent/received to/from other 505-CP5434-FMS modules

FMS Connections
FDL Connections

Communication Jobs

FMS Jobs
Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

FMS Variables

Blue Box CPU

Module Local Configuration

Peerlink II Services

10

Peer Receive Blocks Available: 31

Peer Priority Factor: 8

Maximum Peer Blocks:

Peer Transmit Blocks Available:

32

1

Peer Transmit Interval:

Click here.

Enter parameters
here. (These are
the default values.)

Edit

Figure 6-23 Peerlink Service Configuration Example

Configuring the
Peerlink II Transmit
Service
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Example of a Peerlink II Transmit and Receive Service (continued)

3. Click on the New Item button on the toolbar.

4. Complete the fields listed below (and shown in Figure 6-24) to
configure the Peerlink II Transmit service:

Peer Job Name: Blue Box Count

Descriptor ID: 1

Peer Job Type: Transmit

Local Address: V200, 50
✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

Configured cyclic data blocks sent/received to/from other 505-CP5434-FMS modules

Module Local Configuration

FMS Connections
FDL Connections

Communication Jobs

FMS Jobs
Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

Blue Box CPU

P-P Blue Box Count

Peer Block Name:

Descriptor ID:

Peer Block Type:

Local Address:

1

Transmit

Blue Box Count

Click the
New Item
button.

Edit

V200, 50

Enter parameters
here.

Figure 6-24 Peerlink II Services Example
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Continue by configuring the parameters for a Receive service.

1. Click on the New Item button on the toolbar.

2. Complete the fields listed below to configure the Receive service:

Peer Job Name: Red Box Count

Descriptor ID: 2

Peer Job Type: Receive

Local Address: V300, 50

Next, save your file to disk before attempting to transfer the file to the
FMS CP module. To save the file to disk, follow these steps:

1. Select the menu command File → Save As... or click on the Save
button: 

2. Select a directory to store the saved file.

3. Enter a file name.

4. Click on Save.

After saving your configuration file, download it to the FMS CP module at
Station 1 by following these steps:

1. Select the menu command Transfer → Download to the CP5434, or
click on the Download button: 

2. Click on OK.

Configuring the
Peerlink II Receive
Service

Saving the
Configuration File
to Disk

Transferring the
Configuration to
the FMS CP Module
at Station 1
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Example of a Peerlink II Transmit and Receive Service (continued)

The second step in the process is to create the configuration file for
Station 5.

1. Select the menu command File → New to create an empty
configuration file.

2. Enter a description for this file in the Description field, as shown below
(and in Figure 6-25):

Description: Red Box CPU
✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

Current configuration file specification

Module Local Configuration

FMS Connections
FDL Connections

Communication Jobs

FMS Jobs
Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

Description:

File Name:

Directory:

UNTITLED

Modified?: NO

Red Box CPURed Box CPU

Enter description
here.

Edit

Last Saved File:

Last Saved Directory:

Figure 6-25 Creating a Configuration File for Station 5 Example

Creating the
Configuration File
for Station 5
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Next, you must define the Module Local Configuration of the FMS CP
module for Station 5.

1. Click on the Module Local Configuration icon.

2. Complete the fields listed below (and shown in Figure 6-26) to define
the Module Local Configuration:

Local Station Address: 5

Highest Station Address: 15

Bus Parameter Profile: FMS-DP Universal

Baud Rate: 1.5 MBaud

# of Masters (holds token): 6

# of Slaves (no token): 0

✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

This module’s FMS PROFIBUS communication parameters

FMS Connections
FDL Connections

Communication Jobs

FMS Jobs
Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

Red Box CPU

Module Local Configuration
Local Station Address:

Slot Time (Tslot):

Max. Sta. Delay (Max_Tsdr):

3000

980

1

Highest Station Address: 15

Bus Parameter Profile: FMS-DP Universal

Baud Rate: 1.5 MBaud

# of Masters (holds token): 6

# of Slaves (no token): 0

Min. Sta. Delay (Min_Tsdr):

Setup Time (Tset):

150

240

Quiet Time (Tqui):

Gap Factor:

0

50

Retry Limit:

Token Rotation (Ttr):

1

45000

Click here.

Enter parameters
here.

Edit

Figure 6-26 Module Local Configuration Example

Setting the Module
Local
Configuration for
Station 5
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Example of a Peerlink II Transmit and Receive Service (continued)

Once you have defined the Module Local Configuration, you can configure
the peer transmit interval and priority factor, (as shown in Figure 6-27).

1. Click on the Peerlink II Services icon of the configuration tree.

2. Enter the parameters listed below:

Peer Transmit Interval: 10

Peer Priority Factor: 8
✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

Configured cyclic data blocks sent/received to/from other 505-CP5434-FMS modules

FMS Connections
FDL Connections

Communication Jobs

FMS Jobs
Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

FMS Variables

Red Box CPU

Module Local Configuration

Peerlink II Services

10

Peer Receive Blocks Available: 31

Peer Priority Factor: 8

Maximum Peer Blocks:

Peer Transmit Blocks Available:

32

1

Peer Transmit Interval:

Click here.

Enter parameters
here. (These are
the default values.)

Edit

Figure 6-27 Peerlink Service Configuration Example

Configuring the
Peerlink II Transmit
Service
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3. Click on the New Item button on the toolbar.

4. Complete the fields listed below (and shown in Figure 6-28) to
configure the Peerlink II Transmit service:

Peer Job Name: Red Box Count

Descriptor ID: 2

Peer Job Type: Transmit

Local Address: V200, 50
✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

Configured cyclic data blocks sent/received to/from other 505-CP5434-FMS modules

Module Local Configuration

FMS Connections
FDL Connections

Communication Jobs

FMS Jobs
Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

Red Box CPU

P-P Red Box Count

Peer Block Name:

Descriptor ID:

Peer Block Type:

Local Address:

2

Transmit

Red Box Count

Click the
New Item
button.

Edit

V200, 50

Enter parameters
here.

Figure 6-28 Peerlink II Transmit Service Example
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Example of a Peerlink II Transmit and Receive Service (continued)

Continue by configuring the parameters for a Receive service.

1. Click on the New Item button on the toolbar.

2. Complete the fields listed below (and shown in Figure 6-29) to
configure the Receive service:

Peer Job Name: Blue Box Count

Descriptor ID: 1

Peer Job Type: Receive

Local Address: V300, 50

✂

File Edit Transfer Options Diagnostics Help

Untitled – COM5434

Configured cyclic data blocks sent/received to/from other 505-CP5434-FMS modules

Module Local Configuration

FMS Connections
FDL Connections

Communication Jobs

FMS Jobs
Send-Receive Jobs

FMS Data Types

FMS

FDL

�

FMS

P–P

S–R

DTs

Peerlink II Services

FMS Variables

Red Box CPU

P-P

Red Box Count

Peer Block Name:

Descriptor ID:

Peer Block Type:

Local Address:

1

Receive

Blue Box Count

Click the
New Item
button.

Edit

V300, 50

Enter parameters
here.

P-P

Blue Box Count

Second service is
displayed alphabetically
at the top of the list.

Figure 6-29 Peerlink II Services Example

Configuring the
Peerlink II Receive
Service
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Next, save your file to disk before attempting to transfer the file to the
FMS CP module. To save the file to disk, follow these steps:

1. Select the menu command File → Save As... or click on the Save
button: 

2. Select a directory to store the saved file.

3. Enter a file name, as shown in Figure 6-30.

4. Click on Save.

Save As

Cancel

Save

Save as type:

File name:

Save in:

COM5434 Configuration Files (*.fms)

Red_CPU.fms

Name Size Type Modified

Configsw

Blue_CPU.fms 41KB COM5434 Configuration File 9/15/97 11:28 AM

File_A.fms 41KB COM5434 Configuration File 10/31/97 11:59 PM

File_AB.fms 41KB COM5434 Configuration File 11/3/97 9:59 AM

File_B.fms 41KB COM5434 Configuration File 11/3/97 10:05 AM

File_BA.fms COM5434 Configuration File 11/4/97 10:15 AMEnter name here.

Click here for
file details.

Figure 6-30 Save As Dialog

After saving your configuration file, download it to the FMS CP module at
Station 1 by following these steps:

1. Select the menu command Transfer → Download to the CP5434, or
click on the Download button: 

2. Click on OK.

 

Saving the
Configuration File
to Disk

Transferring the
Configuration to
the FMS CP Module
at Station 1
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Diagnostics
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7.1 CP Status

The Read CP Status dialog provides useful information on the operating
status of the module. To view this information, select the menu command
Diagnostics → CP Status. The Read CP Status dialog appears, as shown
in Figure 7-1.

UpdateOK

Read CP Status

Cont. Update Help

Reset CP Start CP Stop CP

CP Type:

Firmware Version:

Release Date:

Current Mode:

In-Profibus Ring?:

RAM Used:

RAM Available:

505-CP5434-FMS

1.0

12-97

RUN - Configuration Good

Yes

476352

366736 Bytes (43%)

Continuous Update Rate (sec):

0 1 2 3 4 5

Figure 7-1 Read CP Status Dialog Box

The default diagnostic mode is a single (current) reading of the operating
status of the module. You can set the mode to provide a continuous update
of the operating status by clicking on the “Cont. Update” button. Then drag
the slider control to adjust the update rate within a range of 0 to 5 seconds.
(When you select continuous update, the button changes to “Stop Update,”
which you can click to return to the current status in noncontinuous mode.)

The CP Status dialog also provides buttons that allow you to use the
software to put the FMS CP module in STOP mode or RUN mode, or to
initiate a module reset (equivalent to the Reset button in the module
faceplate).

• Click on the “Stop CP” button to switch the module to STOP mode.

• Click on the “Start CP” button to switch the module to RUN mode.

• Click on the “Reset CP” button to initiate a module reset.

Viewing the Status
of the FMS CP
Module

Setting the Status
Update Rate

Controlling CP
Operation Modes
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7.2 Active Stations

The List of Active Stations dialog lists all stations on the bus and the
current status of each. To view this information, select the menu command
Diagnostics → Active Stations. The List of Active Stations dialog
appears, as shown in Figure 7-2.

UpdateOK

List of Active Stations

Cont. Update Help

Continuous Update Rate (sec):

0 1 2 3 4 5

The list contains all stations present on the bus, and the current status of each
station.

Active Station in ring
Active Station in ring

2
4

Current StatusStation#

Figure 7-2 List of Active Stations Dialog Box

Viewing the List of
Active Stations on
the Bus
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7.3 PROFIBUS Statistics

The PROFIBUS Statistics dialog provides statistical information about the
status of the PROFIBUS communications. To view this information, select
the menu command Diagnostics → PROFIBUS Statistics. The
PROFIBUS dialog appears, as shown in Figure 7-3.

UpdateOK

PROFIBUS Statistics

Cont. Update Help

Continuous Update Rate (sec):

0 1 2 3 4 5

Receive Frame Errors: Interface Statistics LAYER 2:

Bus Statistics:

Bus Timeouts:

Bus Collisions:

0

0

Electrical Faults:

HSA Exceeded:

0

0

Problem creating LAS: 0

Incorrect Responses: 0

SPC Overflows: 0

Requests:

Confirmed Requests:

271437

271437

Indications: 183281

Reset Counts

Figure 7-3 PROFIBUS Statistics Dialog Box

Some of the possible PROFIBUS errors are the following:

• The bus statistic “HSA Exceeded” refers to Highest Station Address.

• The bus statistic “Problem creating LAS” refers to List of Active
Stations.

• “SPC Overflows” indicates how many times the memory buffer in the
Siemens PROFIBUS Controller chip has been exceeded.

Viewing the
PROFIBUS Statistics

PROFIBUS Errors
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7.4 FMS Connection Status

The List of FMS Connections dialog lists the existing configured FMS
connections and the current status of each. To view this information, select
the menu command Diagnostics → FMS Connection Status. The List of
Configured FMS Connections dialog appears, as shown in Figure 7-4.

UpdateOK

List of Configured FMS Connections - Local Station = 1

Cont. Update Help

Continuous Update Rate (sec):

0 1 2 3 4 5

The list contains all configured FMS connections and their current status.

Establishing connection
Establishing connection

Status

2
4

Reset Counts

3/5
5/7

fms_connection_1
fms_connection_2

Sends (pos):

Sends (neg):

0

0

Connection Type: MMAC

Receives (pos):

Receives (neg):

0

0

Ready for data transfer54/8fms_connection_3

AddrLSAP (Loc/Rem)Name

Figure 7-4 List of Configured FMS Connections Dialog Box

According to which row in the list is highlighted, the “Connection Type” field
below the list displays one of the following connection types:

MMAC – Master-master on acyclic connection

MSAC – Master-slave on acyclic connection

MSAC_SI – Master-slave on acyclic connection with slave initiative

MSCY – Master-slave on cyclic connection

For more information on these connection types, see Section A.5.

Viewing the Status
of FMS
Connections

FMS Connection
Types
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7.5 FDL Connection Status

The List of FDL Connections dialog lists the existing configured FDL
connections and the current status of each. To view this information, select
the menu command Diagnostics → FDL Connection Status. The List of
Configured FDL Connections dialog appears, as shown in Figure 7-5.

UpdateOK

List of Configured FDL Connections - Local Station = 1

Cont. Update Help

Continuous Update Rate (sec):

0 1 2 3 4 5

The list contains all configured FDL connections and their current status.

Waiting for user data
Waiting for user data

Receive Status

2
4

Reset Counts

3/5
5/7

fdl_connection_1
fdl_connection_2

Sends (pos):
Sends (neg):

0
0

Waiting for user data54/8fdl_connection_3

AddrLSAP (Loc/Rem)Name

Ready for data transfer
Ready for data transfer

Send Status

Ready for data transfer

Receives: 0

Figure 7-5 List of Configured FDL Connections Dialog Box

Viewing the Status
of FDL Connections
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7.6 Job Status

The List of FMS/Send-Receive Jobs dialog lists the existing FMS jobs and
Send-Receive jobs and the status of each. To view this information, select
the menu command Diagnostics → Job Status. The List of Configured
FMS/Send-Receive Jobs dialog appears, as shown in Figure 7-6.

UpdateOK

List of Configured FMS/Send-Receive Jobs

Cont. Update Help

Continuous Update Rate (sec):

0 1 2 3 4 5

OK
OK

Status

Wait start bit activation
Wait start bit activation

Reset Counts

WY5.1
WY5.2

fms_job_1
sr_job_1

Job Type: FMS Read

OKWait start bit activationWY5.3sr_job_2

StateStart BitJob Name

The list contains all FMS and Send-Receive Jobs and their last reported status.

Figure 7-6 List of Configured FMS/Send-Receive Jobs Dialog Box

According to which row in the list is highlighted, the “Job Type” field below
the list displays one of the following job types: Read, Write, Information
Report, Status, or Identify for FMS jobs; Send or Receive.

Viewing the Status
of FMS and
Send-Receive Jobs

Job Types
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7.7 Peer Block Status

The List of Configured Peer Blocks dialog lists the existing configured Peer
Blocks and the current status of each. To view this information, select the
menu command Diagnostics → Peer Block Status. The List of
Configured Peer Blocks dialog appears, as shown in Figure 7-7.

UpdateOK

List of Configured Peer Blocks

Cont. Update Help

Continuous Update Rate (sec):

0 1 2 3 4 5

The list contains all configured Peer Blocks and their current status.

–
62448

Receives

10
–

Reset Counts

1
5

peer_block_1
peer_block_2

5–25peer_block_3

Tx IntervalDescriptorName

OK
OK

Status

OK

Block Type: Transmit

Figure 7-7 List of Configured Peer Block Dialog Box

NOTE:  The “Tx Interval” value shown is the actual peer transmit interval.
This may differ from the configured transmit interval if the FMS CP module
is too heavily loaded to keep up with the configured interval.

Viewing the Status
of Peer Blocks
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A.1 Data Element List

Table A-1 shows the allowed data types (elements) for local or remote
SIMATIC 505 PLCs. It also shows the SIMATIC S7 data type to use when
accessing a Series 505 PLC from an S7 PLC.

Table A-1 Data Element List

Data Element Description Notes Name PLC
TT Access PLC

Representation
S7 Area
(DB=84H)

S7 Subarea
Hex (Dec)

Variable Memory V 01 read/write integer DB 100–2FF
(256–767)

Constant K 02 r/w integer DB 300–4FF
(768–1279)

Discrete Input X 03 r/w Boolean DB 03 (3)

Discrete Output Y 04 r/w Boolean DB 04 (4)

Control Register C 05 r/w Boolean DB 05 (5)

Discrete Input Packed XP 06 r/w packed I (81H) not used

Discrete Output Packed YP 07 r/w packed Q (82H) not used

Control Register Packed CP 08 r/w packed M (83H) not used

Word Input WX 09 r/w integer DB 09 (9)

Word Output WY 0A r/w integer DB 0A (10)

Timer/Counter Preset TCP 0E r/w integer DB 0E (14)

Timer/Counter Current TCC 0F r/w integer DB 0F (15)

Drum Step Preset DSP 10 r/w integer DB 10 (16)

Drum Step Current DSC 11 r/w integer DB 11 (17)

Drum Count Preset 1 DCP 12 r/w integer DB 12 (18)

System Status Words STW 1A r/w 16-bit DB 1A (26)

Drum Current Count DCC 1B read 32-bit DB 1B (27)

Loop Status LS 1E read 16-bit DB 1E (30)

Loop Mode LM 1F r/w 16-bit DB 1F (31)

Loop Gain LKC 20 r/w real DB 20 (32)

Loop Reset time (minutes) LTI 21 r/w real DB 21 (33)

Loop Rate time (minutes) LTD 22 r/w real DB 22 (34)

Loop High Alarm Limit LHA 23 r/w real DB 23 (35)

Loop Low Alarm Limit LLA 24 r/w real DB 24 (36)

Loop Process Variable LPV 25 r/w real DB 25 (37)

Loop PV High Limit LPVH 26 r/w real DB 26 (38)

Loop PV Low Limit LPVL 27 r/w real DB 27 (39)

Loop Orange Deviation Alarm Limit LODA 28 r/w real DB 28 (40)

Loop Yellow Deviation Alarm Limit LYDA 29 r/w real DB 29 (41)

Loop Sample rate (seconds) LTS 2A r/w real DB 2A (42)

Loop Setpoint LSP 2B r/w real DB 2B (43)

Loop Output (percent) LMN 2C r/w real DB 2C (44)

Loop V-flags 2 LVF 2D r/w 16-bit DB 2D (45)

SIMATIC 505
Data Types and
S7 Addressing
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Table A-1 Data Element List (continued)

Data Element Description Notes Name PLC
TT Access PLC

Representation
S7 Area
(DB=84H)

S7 Subarea
Hex (Dec)

Loop C-flags LCF 2E r/w 32-bit DB 2E (46)

Loop Ramp/Soak Status Flags 2 LRSF 2F r/w 16-bit DB 2F (47)

Loop Error LERR 30 read real DB 30 (48)

Loop Bias LMX 31 r/w real DB 31 (49)

Loop High-High Alarm Limit LHHA 32 r/w real DB 32 (50)

Loop Low-Low Alarm Limit LLLA 33 r/w real DB 33 (51)

Loop Rate-of-Change Alarm Limit LRCA 34 r/w real DB 34 (52)

Loop Setpoint High Limit LSPH 35 r/w real DB 35 (53)

Loop Setpoint Low Limit LSPL 36 r/w real DB 36 (54)

Loop Alarm Deadband LADB 37 r/w real DB 37 (55)

Loop Raw High Alarm Limit LHAR 38 r/w integer DB 38 (56)

Loop Raw Low Alarm Limit LLAR 39 r/w integer DB 39 (57)

Loop Raw Process Variable LPVR 3A r/w integer DB 3A (58)

Loop Raw Orange Deviation Alarm Limit LODAR 3B r/w integer DB 3B (59)

Loop Raw Yellow Deviation Alarm Limit LYDAR 3C r/w integer DB 3C (60)

Loop Raw Output LMNR 3D r/w integer DB 3D (61)

Loop Raw Setpoint LSPR 3E r/w integer DB 3E (62)

Loop Raw Error LERRR 3F read integer DB 3F (63)

Loop Raw High/High Alarm Limit LHHAR 40 r/w integer DB 40 (64)

Loop Raw Low/Low Alarm Limit LLLAR 41 r/w integer DB 41 (65)

Loop Raw Alarm Deadband LADBR 42 r/w integer DB 42 (66)

Loop Raw Bias LMXR 48 r/w integer DB 48 (72)

Loop Raw Setpoint Low Limit LSPLR 49 r/w integer DB 49 (73)

Loop Raw Setpoint High Limit LSPHR 4A r/w integer DB 4A (74)

Loop Most-significant word loop C-flags LCFH 4B r/w integer DB 4B (75)

Loop Least-significant word loop C-flags LCFL 4C r/w integer DB 4C (76)

Loop Derivative Gain Limiting Coefficient LKD 4D r/w real DB 4D (77)

Loop Ramp/Soak Step Number LRSN 4E r/w integer DB 4E (78)

Loop Alarm Acknowledge Flags LACK 4F r/w integer DB 4F (79)

High Alarm Limit 3 AHA 50 r/w real DB 50 (80)

Low Alarm Limit 3 ALA 51 r/w real DB 51 (81)

Process Variable 3 APV 52 r/w real DB 52 (82)

PV High Limit 3 APVH 53 r/w real DB 53 (83)

PV Low Limit 3 APVL 54 r/w real DB 54 (84)

Orange Deviation Alarm Limit 3 AODA 55 r/w real DB 55 (85)

Yellow Deviation Alarm Limit 3 AYDA 56 r/w real DB 56 (86)

Sample rate in seconds 3 ATS 57 r/w real DB 57 (87)

Alarm Setpoint 3 ASP 58 r/w real DB 58 (88)
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Data Element List (continued)

Table A-1 Data Element List (continued)

Data Element Description Notes Name PLC
TT Access PLC

Representation
S7 Area
(DB=84H)

S7 Subarea
Hex (Dec)

Alarm V-flags 2, 3 AVF 59 r/w 16-bit DB 59 (89)

Alarm C-flags 3 ACF 5A r/w 32-bit DB 5A (90)

Alarm Error 3 AERR 5B read real DB 5B (91)

High-High Alarm Limit 3 AHHA 5C r/w real DB 5C (92)

Low-Low Alarm Limit 3 ALLA 5D r/w real DB 5D (93)

Rate-of-change Alarm Limit 3 ARCA 5E r/w real DB 5E (94)

Setpoint High Limit 3 ASPH 5F r/w real DB 5F (95)

Setpoint Low Limit 3 ASPL 60 r/w real DB 60 (96)

Alarm Deadband 3 AADB 61 r/w real DB 61 (97)

Raw High Alarm Limit 3 AHAR 62 r/w integer DB 62 (98)

Raw Low Alarm Limit 3 ALAR 63 r/w integer DB 63 (99)

Raw Process Variable 3 APVR 64 r/w integer DB 64 (100)

Raw Orange Deviation Alarm Limit 3 AODAR 65 r/w integer DB 65 (101)

Raw Yellow Deviation Alarm Limit 3 AYDAR 66 r/w integer DB 66 (102)

Alarm Raw Setpoint 3 ASPR 67 r/w integer DB 67 (103)

Raw Alarm Deadband 3 AADBR 68 r/w integer DB 68 (104)

Alarm Raw Error 3 AERRR 69 read integer DB 69 (105)

Raw High-High Alarm Limit 3 AHHAR 6A r/w integer DB 6A (106)

Raw Low-Low Alarm Limit 3 ALLAR 6B r/w integer DB 6B (107)

Raw Setpoint Low Limit 3 ASPLR 6F r/w integer DB 6F (111)

Raw Setpoint High Limit 3 ASPHR 70 r/w integer DB 70 (112)

Most-significant word Alarm C-flags 3 ACFH 71 r/w integer DB 71 (113)

Least-significant word Alarm C-flags 3 ACFL 72 r/w integer DB 72 (114)

Alarm Acknowledge Flags 3 AACK 73 r/w integer DB 73 (115)

VME (575 only) A24 Space 4 VMM D3 r/w integer DB 500–6FF
(1280–1791)

VME (575 only) A16 Space 4 VMS D4 r/w integer DB D4 (212)

GZ (Application Z global Variables) 5 GZ D5 r/w integer DB D5 (213)

GY (Application Y global Variables) 5 GY D6 r/w integer DB D6 (214)

GX (Application X global Variables) 5 GZ D7 r/w integer DB D7 (215)

GW (Application W global Variables) 5 GW D8 r/w integer DB D8 (216)

GV (Application V global Variables) 5 GV D9 r/w integer DB D9 (217)

GU (Application U global Variables) 5 GU DA r/w integer DB DA (218)

GT (Application T global Variables) 5 GT DB r/w integer DB DB (219)

GS (Application S global Variables) 5 GS DC r/w integer DB DC (220)

GR (Application R global Variables) 5 GR DD r/w integer DB DD (221)

GQ (Application Q global Variables) 5 GQ DE r/w integer DB DE (222)

GP (Application P global Variables) 5 GP DF r/w integer DB DF (223)
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Table A-1 Data Element List (continued)

Data Element Description Notes Name PLC
TT Access PLC

Representation
S7 Area
(DB=84H)

S7 Subarea
Hex (Dec)

GO (Application O global Variables) 5 GO E0 r/w integer DB E0 (224)

GN (Application N global Variables) 5 GN E1 r/w integer DB E1 (225)

GM (Application M global Variables) 5 GM E2 r/w integer DB E2 (226)

GL (Application L global Variables) 5 GL E3 r/w integer DB E3 (227)

GK (Application K global Variables) 5 GK E4 r/w integer DB E4 (228)

GJ (Application J global Variables) 5 GJ E5 r/w integer DB E5 (229)

GI (Application I global Variables) 5 GI E6 r/w integer DB E6 (230)

GH (Application H global Variables) 5 GH E7 r/w integer DB E7 (231)

GG (Application G global Variables) 5 GG E8 r/w integer DB E8 (232)

GF (Application F global Variables) 5 GF E9 r/w integer DB E9 (233)

GE (Application E global Variables) 5 GE EA r/w integer DB EA (234)

GD (Application D global Variables) 5 GD EB r/w integer DB EB (235)

GC (Application C global Variables) 5 GC EC r/w integer DB EC (236)

GB (Application B global Variables) 5 GB ED r/w integer DB ED (237)

GA (Application A global Variables) 5 GA EE r/w integer DB EE (238)

G (Local Application Global Variables) 6 G EF r/w integer DB EF (239)

Note 1. The DCP address is a three-byte address containing a drum number in the
most significant 20 bits and a step number in the least significant 4 bits.

Note 2. These flags have a “control” part and a “status” part. When written, only
the control part is written. When read, the status part is returned with the control
part set to zero.

Note 3. This data element is an Analog Alarm type.

Note 4. VMS corresponds to VME address modifier 29 (short non-privileged access).
VMM corresponds to VME address modifier 39 (standard non-privileged data
access.) The access size is always 16 bits. The offset field contains the relative word
of the specified address space.

Note 5. Each PLC in a 575 system may contain one or more application process.
These applications are identified by a single letter ranging from Application A
through Application Z. Associated with each application is a G Memory partition.
Access to the G memory partitions (in the 575 PLC) associated with a PLC
application is provided through plcTT D5 through EE (hex). Addressing (plcTT
offset) of these partitions is 24-bit zero relative.

Note 6. The G memory partitions (in the 575 PLC) are global memories accessible
by the local PLC as well as by other bus masters. Access to the G memory partition
associated with the local PLC is provided through plcTT EF (hex). The addressing of
this partition is 24-bit zero relative; (that is, the first element of G memory is G1,
which has an offset of 0).
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A.2 Data Access between SIMATIC S7 and SIMATIC 505 Systems

Variables in the SIMATIC 505 system are addressed sequentially starting
from 1 regardless of the data size, and the quantity of data is measured in
multiples of the variable size. For example, V1, 1 represents 16 bits of data
and LSP1, 1 represents 32 bits of data.

In the SIMATIC S7 system, variables are numbered from 0 and use
“byte.bit” addressing, and the quantity of data is measured in multiples of a
specified data type. For example, DB1 DBX0.0 WORD 1 represents 16 bits
of data and DB1 DBX0.0 DWORD 1 represents 32 bits of data.

Packed bits (XP, YP, CP) can only be accessed in multiples of 8 bits using S7
addresses. Use the S7 data type BYTE to access packed bits.

Each unpacked bit (X, Y, C) in the SIMATIC 505 is represented by eight
bits, which correspond to the S7 BOOL data type. However, S7 addressing
restricts BOOL data to single items. To access multiple unpacked bits, use
the BYTE data type.

Table A-2 shows examples of the equivalent addressing formats between a
SIMATIC 505 programmable controller system and a SIMATIC S7 system.
These examples show how to use S7 protocol read and write requests to
access data in the SIMATIC 505 system.

Table A-2 Equivalent Address Formats for SIMATIC 505 and S7 Systems

505 Addressing Format S7 Addressing Format

V1, 1
V2, 1
V3, 1
V4, 1
V1, 2

DB256 DBX0.0 WORD 1
DB256 DBX2.0 WORD 1
DB256 DBX4.0 WORD 1
DB256 DBX6.0 WORD 1
DB256 DBX0.0 WORD 2

V32768, 1
V32769, 1
V32770, 1

DB256 DBX65534.0 WORD 1
DB257 DBX0.0 WORD 1
DB257 DBX2.0 WORD 1

X1, 1
Y2, 1

DB3 DBX0.0 BOOL 1
DB4 DBX1.0 BOOL 1

XP1, 8
YP1, 8
CP1, 8

I 0.0 BYTE 1*
Q 0.0 BYTE 1*
M 0.0 BYTE 1

WX1, 1
TCC1, 1
LSP1, 1
LSP2, 1

DB9 DBX0.0 WORD 1
DB15 DBX0.0 WORD 1

DB43 DBX0.0 DWORD 1
DB43 DBX4.0 DWORD 1

DCP6 S4, 2 DB18 DBX10.3 WORD 2

*I 0.0 and Q 0.0 are the mnemonics used in the International Mnemonic set. The equivalent
mnemonics in the SIMATIC set are E 0.0 and A 0.0, respectively.

SIMATIC 505
Addressing

SIMATIC S7
Addressing

Special
Considerations

Addressing
Examples
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To derive the SIMATIC S7 address for a SIMATIC 505 variable, use the
following steps:

1. Subtract 1 from the 505 address; (for example, V2, 1 becomes V1, 1).

2. Multiply the 505 address by the number of bytes in the 505 variable;
(V1, 1 becomes V2, 1).

3. Convert to “byte.bit” address; (V2, 1 becomes V2.0, 1).

4. Substitute the 505 memory type for the corresponding S7 type; 
(V2.0, 1 becomes DB256 DBX2.0, 1).

5. Replace the 505 quantity with the S7 data type; 
(DB256 DBX2.0, 1 becomes DB256 DBX2.0 WORD 1).

Figure A-1 shows a few additional examples of how to derive S7 addressing
to access 505 variables.

Step 3.

Step 4.

Step 5.

Step 1.

Step 2.

X4, 1

DB3 DBX3.0 BOOL 1

X3, 1

X3.0, 1

DB3 DBX3.0, 1

X3, 1

LSP4, 2

DB43 DBX12.0 DWORD 2

LSP3, 2

LSP12.0, 2

DB43 DBX12.0, 2

LSP12, 2

YP4, 8

Q 0.3 BYTE 1

YP3, 8

YP0.3, 8

Q 0.3, 8

YP3, 8

S7 Address

505 Variable

S7 Address

505 Variable

S7 Address

505 Variable

Figure A-1 SIMATIC 505 to S7 Addressing Examples

Using
S7 Addressing
to Specify
505 Variables
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A.3 Mapping of FMS Variables onto 505 Memory

Figure A-2 shows examples of how simple variables are mapped in
SIMATIC 505 V-memory.

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

* * * * * * * X *

Boolean
A Boolean is rounded up to an even byte length, but the extra bits are not transferred.

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

X

Integer16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

X

Integer32

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

X *

Unsigned8
An Unsigned8 is rounded up to an even length, but the extra byte is not transferred.

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

X

Unsigned16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

X

Unsigned32

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

X

Octet String5
An odd-length Octet String is treated as the next larger even-length Octet String.

X

X X

X X

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

X

Bit String3
An odd-length Bit String is treated as the next larger even-length Bit String.

X

X X

Note:  * represents bits or bytes skipped for alignment purposes. When the variable is read,
this data is not transmitted; when the variable is written, this data is written to the value 0.
X represents data values.

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

X

Floating Point

Figure A-2 Mapping of Simple Variables in 505 Memory

Simple Variables
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1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

X

Time Difference 1

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

05

Visible String5 1

A Visible String is preceded by two bytes which record the length of the string. The first byte is
the maximum length of the string, and the second is the actual length. When read from the 505,
the string transmitted is always of the maximum length with any unused characters sent as
spaces. All characters of the string must be printable ASCII characters. An odd-length Visible
String is rounded up to an even length, but the extra byte is not transferred.

05

X X

X X

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

Year

Date1

Date values are stored as BCD numbers. The ranges are as follows:
Year 00 – 99
Month 01 – 12
Day 01 – 31
Hour 00 – 23
Minute 00 – 59
Second 00 – 59
Millisecond 000 – 999
Weekday 1 – 7

Month

Day Hour

Note:  * represents bits or bytes skipped for alignment purposes. When the variable is read,
this data is not transmitted; when the variable is written, this data is written to the value 0.
X represents data values.

X *

Time Difference is stored as a 32-bit number.
Minimum: –24 Days 20 Hours 31 Minutes 23 Seconds 648 Milliseconds 8000 0000
Maximum: 24 Days 20 Hours 31 Minutes 23 Seconds 647 Milliseconds 7FFF FFFF

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

X

Time-of-day 1

Time-of-day is stored as a 32-bit number.
Minimum: 00:00:00.000 0000 0000
Maximum: 23:59:59.999 0526 5BFF

Minute Second

Millisecond Weekday

1The FMS CP does not allow the use of this data type in the definition of a local variable; however,
data of this type can be transferred to and from a remote station if that station uses this data type.

Figure A-2 Mapping of Simple Variables in 505 Memory (continued)
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Mapping of FMS Variables onto 505 Memory (continued)

Figure A-3 shows how variable arrays are mapped in SIMATIC 505 memory.

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

* * * * * *X1

Array[10]  of Boolean
An array of Boolean is rounded up to an even byte length, but the extra bits are not transferred.

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

X1

Array[2]  of Integer16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

X1

Array[3] of Unsigned8
An odd-length array of Unsigned8 is rounded up to an even length, but the extra byte is not
transferred.

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

X1

Array[2] of Octet String5
An odd-length Octet String is treated as the next larger even-length Octet String.

X1

X1 X1

X1 X1

Note:  * represents bits or bytes skipped for alignment purposes. When the variable array is
read, this data is not transmitted; when the array is written, this data is written to the value 0.
X represents data values.

X2X3X4X5X6X7X8 X9X10

X2

X3 *

X2

X2 X2

X2 X2

X2 X2

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

05 05

X1 X1

X1 X1

X1 *

Array[2] of V isible String5 1

1The FMS CP does not allow the use of this data type in the definition of a local variable; however,
data of this type can be transferred to and from a remote station if that station uses this data type.

05 05

X2 X2

X2 X2

X2 *

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

* * * * * *X1

Array[4]  of Boolean
A Boolean array of 4 requires two bytes (one word), but the extra bits are not transferred.

X2X3X4* * * * * *

Figure A-3 Mapping of Variable Arrays in 505 Memory

Variable Arrays
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Figure A-4 shows how an example structure of data types is mapped in
SIMATIC 505 memory.

STRUCT
{

(A) Boolean
(B) Boolean
(C) Unsigned8
(D) Unsigned8
(E) Boolean
(F) Integer16
(G) Integer16
(H) Integer32
(I) Unsigned8
(J) Unsigned16
(K) Unsigned32
(L) Floating Point
(M) Octet String[6]

}

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

* * * * * * A

F

H

I *

G

K

M M

M M

M M

Note:  * represents bits or bytes skipped for alignment purposes. When the structure is read,
this data is not transmitted; when the structure is written, this data is written to the value 0.
X represents data values.
Octet String[5] and Octet String[6] behave identically. Both transfer 6 bytes on both read and
write.

B C

****** ED *

J

L

Structure

Figure A-4 Mapping of a Structure in 505 Memory

Structures
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Mapping of FMS Variables onto 505 Memory (continued)

The FMS Status request function allows status information to be requested
from the communications partner on the specified FMS connection. The
following information is available in the response:

• Logical status of the device (whether communication is possible)

• Physical status of the device (device is operational, or maintenance is
required)

• Local detail (vendor-specific information)

Figure A-5 shows how an FMS Status response is mapped in SIMATIC 505
memory.

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

Local Detail [0] Local Detail [1]

Local Detail [2]

Logical Status Physical Status

Note:  * represents bytes skipped for alignment purposes.

Length of Local Detail

FMS Status Response

*

Figure A-5 Mapping of FMS Status Response

Table A-3 provides information about the codes that the partner device can
supply as a response to an FMS Status request.

Table A-3 FMS Status Response Codes

Logical Status Physical Status Local Detail

00H – Ready for communication 10H – Operational Vendor-specific

02H – Limited services 11H – Partly operational —

— 12H – Not operational —

— 13H – Maintenance required —

Mapping of FMS
Status Response in
505 Memory
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The FMS Identify request function allows the following information to be
obtained from the partner device:

• Name of the device vendor (vendor name)

• Name or model number of the device

• Revision (or version) of the device

Figure A-6 shows how an FMS Identify response is mapped in SIMATIC 505
memory. Each byte contains the Hex code that represents an ASCII
character, spelling out the vendor name and other device information.

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

Vendor Name [0] Vendor Name [1]

Vendor Name [n]

Note:  * represents bytes skipped for alignment purposes.

Length of Vendor Name

FMS Identify Response

*

Vendor Name [2] Vendor Name [3]

. . .

Model Number [0] Model Number [1]

Model Number [n]

Length of Model Number

*

Model Number [2] Model Number [3]

. . .

Revision [0] Revision [1]

Revision [n]

Length of Revision

*

Revision [2] Revision [3]

. . .

Figure A-6 Mapping of FMS Identify Response

Mapping of FMS
Identify Response
in 505 Memory
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A.4 Protocol Implementation Conformance Statements (PICS)

The Protocol Implementation Conformance Statements (PICS) provide
further information about the implementation of FMS (range and
complexity) on the FMS CP module.

This information is required for connections to systems of other
manufacturers.

Table A-4 PICS Part 1: Implementation in the System

System Parameters Detail

Implementation vendor name Siemens E & A

Implementation model name Model number of the CPU

Implementation revision identifier —

Vendor name of FMS Siemens Energy & Automation

Controller type of FMS ASPC2

Hardware release of FMS A_._

Software release of FMS V_._

Profile number 0

Calling FMS user (enter YES or NO) YES

Called FMS user (enter YES or NO) YES

Table A-5 PICS Part 2: Supported Services

Service Primitive

Initiate req, con, ind, rsp

Abort req, ind

Reject ind

Status req, con

Unsolicited Status Not supported

Identify req, con

Read req, con

Write req, con

Information Report ind

Get Object Dictionary (short version) req, con

Get Object Dictionary (long version) req, con

Read CRL Loc req, con

Definition
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Table A-6 PICS Part 3: FMS Parameters and Options

FMS Parameters and Options Detail

Addressing by name YES

Maximum length for names 32

Access protection supported —

Maximum length for extension 32

Maximum length for extension arguments 0

Table A-7 PICS Part 4: Local Implementation Values

Local Implementation Values Detail

Maximum length of FMS PDU 241

Maximum number of services outstanding
calling (for SAC or SCC)

4

Maximum number of services outstanding
called (for RAC or RCC)

4

Syntax and semantics of the execution
argument

—

Syntax and semantics of extension —
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A.5 FMS Connection Types and Variables

When configuring FMS connections, you must specify the connection type.
Table A-8 shows which job types are available for data transfer with each
connection type.

Table A-8 FMS Connection Types and Jobs Allowed

Connection Type Possible Job Types Client vs. Server

MMAC – Master-master
on acyclic connection

Read, Write, and Report
possible in both
directions.

FMS Master FMS Master

Read

Write

Report

Read

Write

Report

MSAC – Master-slave on
acyclic connection

Read, Write, and Report
possible for the FMS
master.

FMS Master FMS Slave

Read

Write

Report

MSAC_SI – Master-slave
on acyclic connection
with slave initiative

Read, Write, and Report
possible for the FMS
master.

The FMS slave can also
report once the master
has assigned the
appropriate rights.

FMS Master FMS Slave

Read

Write

Report

Report

MSCY – Master-slave on
cyclic connection

Read, Write, and Report
possible for the FMS
master.

FMS Master FMS Slave

Read

Write

Report

Legend: Confirmed service

Unconfirmed service

Client function

Server function

FMS Connection
Types and Possible
Job Types
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You can enable and disable read or write access to each variable in your
configuration. The Access Rights dialog in the FMS Variable input pane
allows you to specify read or write access by password, by groups, or by all.
The effects of these choices with passwords are shown in Table A-9.

Table A-9 Read/Write Access to Variables with Password

Read Access Write Access Password Result

� � 0 Read and write access are
permitted.

� — 0 Only read access is permitted.

— � 0 Only write access is permitted.

� � >0 Read and write access are
permitted with a password.

� — >0 Only read access with password is
permitted.

— � >0 Only write access with password
is permitted.

Configuring
Read/Write Access
to Variables
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A.6 Local LSAP Assignments

Table A-10 lists the available LSAP assignment numbers and any
restrictions that may apply.

Table A-10 Local LSAP Assignments

LSAP Conditions

0, 1 Reserved

2 to 33

2 to 52

Available for FDL connections

Available for FMS connections

53 Cannot be used if Peer Blocks are defined

54 to 57 Available for FMS connections

58 Restricted to FMS slave connections

59 to 62 Available for FMS connections

63 to FF Reserved

NOTE:  Ordinarily, the FMS CP module cannot repeat local LSAP numbers.
Each connection must have a unique local LSAP number. The exception to
this is FMS slave connections. All FMS slave connections must use LSAP
58. LSAP 58 cannot be used for connections to any other type of device.
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Appendix B

Troubleshooting

B.1 Using the RESET Button B-2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

B.2 Job Status Codes B-3. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Job Status Codes B-3. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Locally Detected Errors in FMS Jobs B-3. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Errors Signaled by the FMS Partner B-5. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Send-Receive Job Error Codes B-6. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

B.3 CP-to-Controller Status Codes B-7. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 



TroubleshootingB-2 SIMATIC 505 PROFIBUS-FMS CP User Manual

B.1 Using the RESET Button

First attempt to reset the module using the COM5434 Configurator
software before resetting the module with the RESET button. If resetting
the module using the COM5434 Configurator does not solve the problem,
make sure to check all connections, communication cables, and the
configuration of the FMS CP in the base using TISOFT.

However, if there is a serious hardware error, the module resets due to a
signal from the watchdog timer, encounters the same problem again, and
repeats the reset over and over. If this occurs, call the Siemens Technical
Services Group for technical assistance. You may be advised to return the
module to the factory for repair.
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B.2 Job Status Codes

Table B-1 lists the status codes and their meanings for FMS or
Send-Receive jobs.

Table B-1 FMS or Send-Receive Job Status

Error Description

0000 Job executed successfully; no errors.

D000 Job not yet triggered by WY bit (Note: code appears in Job Status
screen only, not in V memory status word.)

D001 More data received than expected, data written to PLC.

D002 Less data received than expected, data written to PLC.

Table B-2 lists the error code numbers and their meanings for FMS jobs.

Table B-2 Local FMS Job Status Codes

Error Description

0001 Communications problem.

0002 Function cannot be executed: either negative acknowledgment by
the CP or error in the sequence.

0003 The connection is not configured (invalid ID specified). If the
connection is configured, the error indicates that the permitted
parallel job processing limit has been exceeded. For example, SAC=0
is configured and a Report job is sent.

0004 The receive data area is too short or the data types do not match.

0005 A reset request has been received from the CP.

0006 The corresponding job execution on the CP is in the Disabled state,
or a reset request has been received from the CP; the transfer is
therefore incomplete.

0007 The corresponding job execution on the CP is in the wrong state.

With Report: error is specified in greater detail in diagnostic buffer.

0008 Job execution on the CP signals an error accessing the user memory.

000A Access to the local user memory is not possible (for example, the DB
has been deleted).

000B Warning: the job is already active.

0014 Not enough work or load memory available.

0200 Unspecified application reference error.

0201 The configured connection cannot be established at present; for
example, the LAN connection is not established.

0300 Unspecified definition error.

0301 Object with requested index/name is not defined.

0302 Object attributes are inconsistent.

Job Status Codes

Locally Detected
Errors in FMS Jobs
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Job Status Codes (continued)

Table B-2 Local FMS Job Status Codes (continued)

Error Description

0303 Name already exists.

0400 Unspecified resource error.

0401 No memory available.

0500 Unspecified service error.

0501 Conflict due to object status.

0502 Configured PDU size exceeded.

0503 Conflict due to object restrictions.

0504 Inconsistent parameters.

0505 Illegal parameters.

0600 Unspecified access error.

0601 Invalid object; cable off; bad bus parameter; or partner CP in reset.

0602 Hardware error.

0603 Object access was denied.

0604 Invalid address.

0605 Inconsistent object attributes.

0606 Object access not supported.

0607 Variable read or written does not exist on server.

0608 Type conflict (source data too large or too small for variable).

0609 Access using names not supported.

0700 Unspecified object dictionary error.

0701 Permitted name length exceeded.

0702 Overflow of the object dictionary.

0703 Object dictionary is write-protected.

0704 Overflow of the extension length.

0705 Overflow of the object description length.

0706 Processing problem.

0100 Unspecified VFD status error.

0102 Bad FMS–PDU.

0105 PDU length error: variable is too long; see Table C-1.

0106 Service not supported.

0108 RCC/SAC/RAC error.

0800 Unspecified error.

EF02 You have attempted to run more than one FMS job simultaneously
on a single FMS connection. This means not enough resources are
available. You can correct the problem by setting the parameter
“Max Cnfmd Svc To” for the client and “Max Cnfmd Svc From” for
the server to the number of jobs sharing the connection. If the jobs
are not run simultaneously, then the default value of 1 is acceptable.
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Table B-3 lists FMS job error codes signaled by the communication partner.

Table B-3 Errors Signaled by the FMS Partner

Error Description

8200 Unspecified application reference error.

8201 Application (for example, user program) not obtainable.

8300 Unspecified definition error.

8301 Object with requested index/name is not defined.

8302 Object attributes are inconsistent.

8303 Name exists already.

8400 Unspecified resource error.

8401 No memory available.

8402 Not allowed in current state; check Maximum Confirmed Service To
and Maximum Confirmed Service From parameters.

8500 Unspecified service error.

8501 Conflict due to object status.

8502 Configured PDU size exceeded.

8503 Conflict due to object restrictions.

8504 Inconsistent parameters.

8505 Illegal parameters.

8600 Unspecified access error.

8601 Invalid object.

8602 Hardware error.

8603 Object access was denied.

8604 Invalid address.

8605 Inconsistent object attributes.

8606 Object access is not supported.

8607 Object does not exist.

8608 Type conflict.

8609 Access using names is not supported.

8700 Unspecified object dictionary (OD) error.

8701 Permitted name length exceeded.

8702 Overflow of the object dictionary.

8703 Object dictionary is write-protected.

8704 Overflow of the extension length.

8705 Overflow of the object description length.

8706 Processing problem.

8100 Unspecified VFD status error.

8104 Too much data transferred on Write.

8000 Unspecified error detected by partner.

Errors Signaled by
the FMS Partner
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Job Status Codes (continued)

Table B-4 lists the error codes and their meanings for Send-Receive jobs.

Table B-4 Send-Receive Job Error Codes

Error Description

E0E0 Receive Job: no data available. This error occurs when a Receive job
is executed but no corresponding Send job has occurred.

E0E1 Connection is not configured by CP.

E0E2 No LAN connection to remote.

E0E3 Invalid request.

E0E4 S7–Read/Write buffer too small.

E0E5 DS–Number out of range 1..64, 1..32.

E0E6 S7–Prot–error

E0E8 L2: remote LSAP is not active.

E0E9 Send Job: no remote receive resources. This error occurs when 2 or
more Send jobs are executed but no corresponding Receive jobs have
occurred.

E0EA L2: service on remote LSAP rejected.

E0EB L2: remote address not available.

E0EC L2: bus fault.

Send-Receive Job
Error Codes
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B.3 CP-to-Controller Status Codes

Table B-5 CP-to-Attached Controller Error Codes for FMS and Send-Receive Jobs

Status
Code (Hex) Description

80xx xx is task code error response from attached PLC; see PLC documentation. These errors
usually indicate a problem in accessing data in the attached PLC caused by a firmware error in
the CP rather than a user error.

9000 Invalid request to PLC; a firmware error in the CP rather than a user error.

9001 Memory type request from PLC is not defined for any 505 PLC. The Configurator guards
against the use of undefined data types when configuring communications between 505 PLCs,
so this should not occur. If the accessed plcTT type is unsupported or not configured in the
attached PLC, error code 9003 occurs (see below).

9002 Reserved for invalid request for PLC mode. Currently, CP does not produce this error.

9003 Memory type requested from PLC is not supported or not configured. For example, the 560
does not support loop data types. It also occurs if the requested data type is not configured in
the PLC (e.g., unconfigured analog alarm data types). Access of data types undefined for any
505 PLC results in error 9001.

9004 Starting memory address accessed in PLC is invalid. This occurs if memory type is defined,
supported, and configured, but the starting address is out of range for the data type. For
example, if the starting address is V27000 and only 52K bytes of V-memory are configured
(allowing a maximum V-address of 26624), then this error occurs. If you reconfigured the PLC
memory after installing and initializing the CP module, reset the CP module so that it can read
the new memory configuration in the PLC.

9005 Memory type cannot be written since it is read-only.

9006 PLC communication time-out. Due to extremely heavy load on the PLC or CP, the data access
to the PLC took longer than expected. This error may also occur if the CP resides in a remote
base and the I/O cable becomes disconnected. If this error occurs, retry the job.

9007 Starting memory address OK, but the number of items requested is causing invalid memory
access. For example, this error ocuurs if 2000 words of V-memory starting at V26000 are
requested but only 52K bytes of V-memory are configured (V26624 is highest configured
address). If you reconfigured PLC memory after installing and initializing the CP module, reset
the CP module so that it can read the new memory configuration in the PLC.

9008 Slot into which CP module is placed is not configured. This error does not explicitly appear for
any job. It may be indicated on the job diagnostic display by the message “Waiting for WY bit to
trigger Job”, with a job status D000, even when the PLC is setting the WY bit. If the base is not
configured, the module is unable to detect the WY Job Start Bits required for the jobs.
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Appendix C

Specifications

Table C-1 Communication Capacities

Communication Type Maximum Number or Size

FMS Connections 32

FDL Connections 32

S7 Connections 48

Total number of connections 59 (or 60 if Peerlink service is not used)

FMS variable size Maximum PDU size = 241 bytes

237 bytes for Read jobs (241 – 4 bytes)

≤234 bytes for Write and Information Report jobs,
depending on name length, index or subindex (see
Table C-2)

Send-Receive data size 240 bytes

Peerlink data transfer size 234 bytes

Table C-2 provides a formula for calculating the maximum size of an FMS
variable that can be transmitted. The maximum PDU size for an FMS job is
241 bytes. For Write and Information Report jobs, the PDU includes the
addressing information, which must then be subtracted from 241 bytes to
determine the maximum amount of data that can be specified in the
variable.

Table C-2 Calculating Variable Length

Access Using... Write or Information Report

Index 8 bytes

Subindex 10 bytes

Name x + name length (number of characters)

x = 7 for name length ≥ 15
x = 6 for name length < 15

Example: For a variable named “PumpControl” (name length = 11), which
is less than 15 characters, add 6 to the name length and subtract from 241,
as shown below:

241 – (x + name length)
241 – (6 + 11)
241 – 17 = 224 bytes of user data
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Table C-3 Specifications

Operating temperature
(Based on the immediate surrounding
air at the device.)

0 to 60°C (32 to 140°F)

Storage temperature –40 to +70°C (–40 to 158°F)

Shock IEC 68-2-27; Test Ea; half sine, 15 g, 11 ms

Pollution degree 2, IEC 664, 664A

Noise immunity, conducted IEC 801, Part 4, Level 3
MIL STD 461B, Part 4 CS01, CS02, CS06
IEC 255-4, Appendix E
NEMA DC33
NEMA ICS 2–230.45
IEC 255

Noise immunity, radiated IEC 801 Part 3, Level 3
MIL STD 461B, Part 4 RS01, RS02

Electrostatic discharge IEC 801, Part 2, Level 4, (15 kV)

Minimum torque for bezel screws 2.6 in-lb (0.3 N-m)

Maximum torque for bezel screws 4.12 in-lb (0.6 N-m)

Module power required from base 5.0 W of +5 V
0.2 W of –5 V

Relative humidity 5% to 95% noncondensing

Vibration Sinusoidal
IEC 68-2-6, Test Fc
0.15 mm peak-to-peak, 10–57 Hz;
1.0 g, 57–150 Hz

Random
IEC 68-2-34, Test Fdc, 
equivalent to NAVMAT P–9492
0.04 g2/Hz, 80–350 Hz

Corrosion protection All parts of corrosion-resistant material or plated or painted as corrosion
protection

Agency approvals Underwriters Laboratories: UL Listed (Industrial Control Equipment)

Canadian Standards Association: CSA Certified (Process Control Equipment)

Factory Mutual Approved; Class I, Div. 2 Hazardous Locations

Verband Deutscher Elektrotechniker (VDE) 0160 Electrical Equipment
(self-compliance)

EN61131-2 (1995) Programmable Controllers Equipment requirements and test

EMC Directive 89/336/EEC

Low Voltage Directive 73/23/EEC
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Index

A
Access groups, 5-22, 5-39

Access rights, 5-38

Active stations status, 7-3

Addressing, network, 4-7

Agency approvals, xiv, C-2

Arrays
examples, A-10
number of elements, 5-39

Assistance, technical, xiv

B
Base, powering up, 2-8–2-9

Baud rate
selecting for local module, 5-14
setting RS-232 port, 2-4

Bezel, features, 1-4–1-5

Bus connectors, installing, 3-12–3-14

Bus parameter profile, 5-14

C
Cable

programming, 2-6
routing, 3-5–3-6

Capacities, communication, C-1

COM5434 configurator software
features and functions, 5-6–5-11
installing, 5-2
starting, 5-3

Communication, between PLC and FMS CP,
4-4–4-6

Communication services, 4-2–4-6

Configuration tasks, 6-3

Configuring I/O address, in PLC, 2-10–2-11

Connection types, A-16

CP status, 7-2

D
Data element list, A-2–A-5

Data types, creating, 5-33–5-35

Description, for configuration, 5-12

Descriptor ID, peer block, 5-17

Diagnostics, 7-2–7-8

Downloading
configuration, 5-42–5-43
FMS Read configuration example, 6-9
FMS Variable configuration example, 6-12
Peerlink configuration example, 6-39
Receive configuration example, 6-21
Send configuration example, 6-19

Drag-and-drop operations, 5-9

E
Electrostatic discharge, handling requirements,

2-3

Error codes
CP to controller status, B-7
FMS and Send-Receive jobs, B-3–B-6
Send-Receive jobs, B-6

Examples
FMS Read job, 6-4–6-13
ladder logic for FMS read job, 6-13
ladder logic for Receive job, 6-25
ladder logic for Send job, 6-23
Peerlink services, 6-28–6-39
Send-Receive job, 6-14–6-27
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F
FDL connection, status, 7-6

FDL services
configuring Send-Receive jobs, 5-30–5-32
defining connections, 5-23–5-25
definition, 4-2

Features
bezel, 1-4–1-5
functional, 1-2

FMS connection, status, 7-5

FMS connection types, A-16

FMS data types, creating, 5-33–5-35

FMS Read job example, 6-4–6-13

FMS services
configuring jobs, 5-27–5-29
defining connections, 5-19–5-22
definition, 4-2
overview, 4-8–4-10

FMS variables
creating, 5-36–5-40
mapping in 505 memory, A-8–A-13

FMS-DP Universal, bus profile, 5-14

G
Gap factor, 5-15

Group numbers
definition, 4-10
selecting, 5-22, 5-39

H
Hardware overview, 1-4–1-5

Highest station address (HSA), 5-14

I
I/O address configuration, 2-10–2-11

Identify
FMS job type, 4-8–4-10
response, A-13
selecting FMS job type, 5-29

Index, specifying, 5-29, 5-37

Indicators, status LEDs, 1-4, 2-8–2-9

Information report
FMS job type, 4-8–4-10
selecting FMS job type, 5-29

Installation overview, 2-2–2-3

Installing
COM5434 configurator software, 5-2
FMS CP module, 2-5

J
Job start/job active bits, 4-4–4-6

Job status, 7-7

Job types
definition, 4-8–4-10
selecting FMS, 5-29
selecting send-receive, 5-32

Jumper, setting baud rate, 2-4

L
Ladder logic

for FMS read example, 6-13
for Receive example, 6-25
for Send example, 6-23

LEDs, status, 1-4, 2-8–2-9

Link Service Access Point (LSAP), 4-7

Local LSAP assignments, A-18

Local station address, 5-13

Logical view of a network, 1-10

M
Manuals, related, xiii

Masters and slaves, 1-7

Memory type and address, 5-18, 5-29, 5-32, 5-38

Menu commands, 5-8–5-10

Module local configuration, defining, 5-13–5-15
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N
Network addressing, 4-7

Networking overview, 1-6–1-10

O
Object dictionary

definition, 4-8
selecting, 5-22

OSI 7 layer model, 1-7

P
Password

definition, 4-10
for FMS connection, 5-21
for FMS variable, 5-39

PC-to-FMS CP communications, configuring
port setup, 5-3–5-6

Peer block status, 7-8

Peerlink II services
defining, 5-16–5-18
definition, 4-2
overview, 4-12

Peerlink services example, 6-28–6-39

Port
PC serial port setup, 5-3–5-5
PROFIBUS card setup, 5-4–5-5

Powering up base, 2-8–2-9

Printing. 5-42

Priority factor, peer block, 5-16

PROFIBUS
bus connector schematics, 3-11
bus connectors, 3-3

installing, 3-12–3-14
cable, 3-2, 3-8
card communications setup, 5-4–5-5
cards, 1-2
installing cables, 3-7–3-13
repeater, 3-4
standards, 1-2, 1-6
statistics/status, 7-4
user organization, xiv

PROFIBUS-FMS port
connecting, 2-7
description, 1-5

Programming cable, 2-6

Programming device, connecting, 2-6

Protocol Implementation Conformance
Statements (PICS), A-14–A-15

R
Read

FMS job type, 4-8–4-10
selecting FMS job type, 5-29

Receive, peer blocks, 4-12, 5-16–5-18

Related manuals, xiii

Relay ladder logic
for FMS read example, 6-13
for Receive example, 6-25
for Send example, 6-23

Remote station address, 5-21

Requester, FMS services, 5-22

Reset button, 1-5, B-2

Responder, FMS services, 5-22

Right mouse button menus, 5-11

RS-232 port
description, 1-5
setting baud rate, 2-4

Run/Stop switch, 1-5

S
S7 services supported, 4-13

S7/505 data types, A-2–A-5

Saving
configuration, 5-41
FMS Read configuration example, 6-9
FMS Variable configuration example, 6-12
Peerlink configuration example, 6-33, 6-39
Receive configuration example, 6-21
Send configuration example, 6-19

Screen features, 5-7
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Send-Receive, configuring jobs, 5-30–5-32

Send-Receive job example, 6-14–6-27

Send-Receive services, overview, 4-11

Serial port setup, 5-3–5-5

SIMATIC 505 addressing, A-6–A-7

SIMATIC S7 addressing, A-6–A-7

Specifications, FMS CP module, C-2

Standard, bus profile, 5-14

Standard-Mixed, bus profile, 5-14

Start bit, 5-28, 5-31

Starting, the COM5434 software, 5-3

Status
FMS job type, 4-8–4-10
response, A-12
selecting FMS job type, 5-29

Status LEDs, 1-4, 2-8–2-9

Status word, assigning, 5-29, 5-32

Structures, A-11

Subindex, specifying, 5-29, 5-40

T
Technical assistance, xiv

Termination and bias, 3-10

Timing, for Send and Receive jobs, 6-26, 6-27

TISOFT, using for I/O address configuration,
2-10–2-11

Title of configuration, entering, 5-12

Token
passing, 1-8
ring, 1-8
rotation, 5-15

Toolbar buttons, 5-10

Transmit, peer blocks, 4-12, 5-16–5-18

Transmit interval, peer block, 5-16

Troubleshooting, B-2–B-7

U
User data types, creating, 5-33–5-35

V
Validating the configuration, 5-41

Variable arrays
examples, A-10
selecting data type, 5-39

Variables, creating, 5-36–5-40

Virtual Field Device (VFD), 5-5

W
Write

FMS job type, 4-8–4-10
selecting FMS job type, 5-29
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No. Thanks anyway.

Your Name:

Title:

Telephone Number: ( )

Company Name:

Company Address:

Manual  Name: PROFIBUS-FMS Communications Processor User Manual Edition: Original

Text Assembly Number: 2807479-0001 Date: 12/97

Order Number: PPX:505–8129–1



BUSINESS REPLY MAIL
FIRST CLASS PERMIT NO.3 JOHNSON CITY, TN

FOLD

FOLD

POSTAGE WILL BE PAID BY ADDRESSEE

NO POSTAGE
NECESSARY
IF MAILED

IN THE
UNITED STATES

ATTN TECHNICAL COMMUNICATIONS M/S 519
SIEMENS ENERGY & AUTOMATION INC 
PO BOX 1255
JOHNSON CITY TN 37605–1255

SIEMENS ENERGY & AUTOMATION INC 
3000 BILL GARLAND ROAD
PO BOX 1255
JOHNSON CITY TN 37605–1255


	Title
	Contents
	Preface
	About This Manual
	Related Manuals
	Conventions
	Agency Approvals
	PROFIBUS User Organization
	Technical Assistance

	1 Overview
	1.1 The SIMATIC 505 PROFIBUS-FMS Communications Processor Module
	Features
	Communication Services Supported
	Compatibility
	System Layout

	1.2 Hardware Overview
	Bezel Features
	Status LED Indicators
	RUN/STOP Switch
	RESET Button
	RS-232 Port
	PROFIBUS-FMS Port

	1.3 Network Overview
	The PROFIBUS Standard
	OSI 7 Layer Model
	Masters and Slaves
	Token Passing on a PROFIBUS Network
	Network Communication


	2 Installing the Module
	2.1 Overview of Installation
	Flow of Tasks
	Handling the Module
	Visual Inspection

	2.2 Setting the Baud Rate for the RS-232 Port
	Setting the Jumper on Header E1
	Header E2

	2.3 Inserting the FMS CP Module
	Inserting the FMS CP Module

	2.4 Connecting a Programming Device to the FMS CP Module
	Connecting to the RS-232 Port
	Connecting the Serial Cable

	2.5 Connecting the FMS CP Module to the Network
	PROFIBUS-FMS Port Pinout
	Connecting to the Network

	2.6 Powering Up the Base
	Supplying Power to the Base
	LED Status after Power-up
	LED Status in Operating Modes

	2.7 Configuring the I/O Address in the Programmable Logic Controller
	2.8 PROFIBUS Network Card and Software Packages

	3 Connecting the Network
	3.1 Cables and Connectors
	PROFIBUS Cable
	PROFIBUS Bus Connectors
	PROFIBUS Repeater

	3.2 Cable Routing
	Guidelines
	Cable Routing Methods
	Under-Floor Routing
	In-Ceiling Routing
	Surface Duct Routing

	3.3 Installing PROFIBUS Cables
	Media Options
	System Layout
	PROFIBUS Cable Specifications
	PROFIBUS Line Length Limits
	Installing PROFIBUS Cable
	Termination and Bias
	Using a Termination Selection Switch
	PROFIBUS Connector Schematics
	Installing a PROFIBUS Connector


	4 Communication Services
	4.1 Overview
	Communication Services
	Functional Modes of Communication
	Connections
	Communication Jobs
	Peerlink II Services
	Server Functions
	Communication between the PLC and the FMS CP Module

	4.2 Addressing on Your Network
	Multiplexed Addressing
	Station Address
	LSAPs

	4.3 FMS Services
	FMS Connections
	FMS Communication Job Types
	FMS Server Functions
	FMS Jobs
	Specifying Access Rights to Variables in FMS Connections

	4.4 Send-Receive Services
	FDL Connections
	Send-Receive Jobs

	4.5 Peerlink II Services
	Transmitting and Receiving Peer Blocks
	Transmission Intervals

	4.6 S7 Services
	S7 Services Supported


	5 Using the COM5434 Configurator
	5.1 Installing the Software for the FMS CP Module
	Software Package
	Operating System Requirements
	Installing the COM5434 Configurator Software
	Starting the COM5434 Configurator Software
	Configuring PC-to-FMS CP Module Communications
	Configuring PROFIBUS Card Communications

	5.2 Features and Functions of the COM5434 Configurator Software
	Getting Started
	Main Screen Features
	Drag-and-Drop Operations
	Toolbar Commands
	Right Mouse Button Editor

	5.3 Describing the Configuration File
	Entering a Title for Your Configuration File

	5.4 Defining the Module Local Configuration
	What Is the Module Local Configuration?
	Defining the Module Local Configuration

	5.5 Defining Peerlink II Services
	Peerlink II Services
	Defining a Peer Block

	5.6 Defining FMS Connections
	FMS Connections
	Defining an FMS Connection

	5.7 Defining FDL Connections
	FDL Connections
	Defining an FDL Connection

	5.8 Overview of Communication Jobs
	5.9 Configuring FMS Jobs
	FMS Jobs
	Defining an FMS Job

	5.10 Configuring Send-Receive Jobs
	Send-Receive Jobs
	Defining a Send-Receive Job

	5.11 Creating FMS Data Types
	FMS Data Types
	Creating a User Data Type

	5.12 Creating FMS Variables
	FMS Variables
	Defining an FMS Variable

	5.13 Saving and Downloading the Configuration
	Validating and Saving the Configuration to a File
	Printing the Configuration
	Downloading the Configuration to the FMS CP Module


	6 Configuration Examples
	6.1 Overview
	6.2 Example of an FMS Read Job
	Configuration Tasks for an FMS Read Job
	Creating the Configuration File for Station 1
	Defining the Module Local Configuration for Station 1
	Defining an FMS Connection for Station 1
	Configuring the FMS Read Job for Station 1
	Saving the Configuration File to Disk
	Transferring the Configuration to the FMS CP Module at Station 1
	Creating the Configuration File for Station 2
	Setting the Module Local Configuration for Station 2
	Defining an FMS Connection for Station 2
	Defining an FMS Variable for Station 2
	Saving the Configuration File to Disk
	Transferring the Configuration to the FMS CP Module at Station 2
	Example RLL Code for FMS Read Job at Station 1

	6.3 Example of a Send-Receive Job
	Configuration Tasks for a Send-Receive Job
	Creating the Configuration File for Station 1
	Setting the Module Local Configuration for Station 1
	Defining an FDL Connection for Station 1
	Configuring the Send Job for Station 1
	Saving the Configuration File to Disk
	Transferring the Configuration to the FMS CP Module at Station 1
	Creating the Configuration File for Station 5
	Setting the Module Local Configuration for Station 5
	Defining an FDL Connection for Station 5
	Configuring the Receive Job for Station 5
	Saving the Configuration File to Disk
	Transferring the Configuration to the FMS CP Module at Station 5
	Example RLL Code for Send Job at Station 1
	Example RLL Code for Receive Job at Station 5
	Successful Timing Example
	Unsuccessful Timing Example

	6.4 Example of a Peerlink II Transmit and Receive Service
	Configuration Tasks for a Peerlink II Service
	Creating the Configuration File for Station 1
	Setting the Module Local Configuration for Station 1
	Configuring the Peerlink II Transmit Service
	Configuring the Peerlink II Receive Service
	Saving the Configuration File to Disk
	Transferring the Configuration to the FMS CP Module at Station 1
	Creating the Configuration File for Station 5
	Setting the Module Local Configuration for Station 5
	Configuring the Peerlink II Transmit Service
	Configuring the Peerlink II Receive Service
	Saving the Configuration File to Disk
	Transferring the Configuration to the FMS CP Module at Station 1


	7 Diagnostics
	7.1 CP Status
	Viewing the Status of the FMS CP Module
	Setting the Status Update Rate
	Controlling CP Operation Modes

	7.2 Active Stations
	Viewing the List of Active Stations on the Bus

	7.3 PROFIBUS Statistics
	Viewing the PROFIBUS Statistics
	PROFIBUS Errors

	7.4 FMS Connection Status
	Viewing the Status of FMS Connections
	FMS Connection Types

	7.5 FDL Connection Status
	Viewing the Status of FDL Connections

	7.6 Job Status
	Viewing the Status of FMS and Send- Receive Jobs
	Job Types

	7.7 Peer Block Status
	Viewing the Status of Peer Blocks


	A Reference Data
	A.1 Data Element List
	SIMATIC 505 Data Types and S7 Addressing

	A.2 Data Access between SIMATIC S7 and SIMATIC 505 Systems
	SIMATIC 505 Addressing
	SIMATIC S7 Addressing
	Special Considerations
	Addressing Examples
	Using S7 Addressing to Specify 505 Variables

	A.3 Mapping of FMS Variables onto 505 Memory
	Simple Variables
	Variable Arrays
	Structures
	Mapping of FMS Status Response in 505 Memory
	Mapping of FMS Identify Response in 505 Memory

	A.4 Protocol Implementation Conformance Statements (PICS)
	Definition

	A.5 FMS Connection Types and Variables
	FMS Connection Types and Possible Job Types
	Configuring Read/ Write Access to Variables

	A.6 Local LSAP Assignments

	B Troubleshooting
	B.1 Using the RESET Button
	B.2 Job Status Codes
	Job Status Codes
	Locally Detected Errors in FMS Jobs
	Errors Signaled by the FMS Partner
	Send-Receive Job Error Codes

	B.3 CP-to-Controller Status Codes

	C Specifications
	Index

